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The National Anthem of Sri Lanka

 Sri Lanka Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
 Sundara siri barinee, surendi athi sobamana Lanka
 Dhanya dhanaya neka mal palaturu piri jaya bhoomiya ramya 
 Apa hata sepa siri setha sadana jeewanaye matha
 Piliganu mena apa bhakthi pooja Namo Namo Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
 Oba we apa vidya
 Obamaya apa sathya
 Oba we apa shakthi
  Apa hada thula bhakthi
 Oba apa aloke 
  Apage anuprane
 Oba apa jeevana we 
 Apa mukthiya oba we
 Nava jeevana demine, nithina apa pubudukaran matha
 Gnana veerya vadawamina regena yanu mana jaya bhoomi kara
 Eka mavakage daru kela bevina
 Yamu yamu vee nopama
 Prema vada sema bheda durerada
 Namo, Namo Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
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Being innovative, changing with right knowledge
Be a light to the country as well as to the world.

Message from the Hon. Minister of Education

	 The	past	two	decades	have	been	significant	in	the	world	history	due	to	changes	
that took place in technology. The present students face a lot of new challenges along 
with the rapid development of Information Technology, communication and other 
related	fields.	The	manner	of	career	opportunities	are	liable	to	change	specifically	in	
the near future. In such an environment, with a new technological and intellectual 
society, thousands of innovative career opportunities would be created. To win those 
challenges, it is the responsibility of Sri Lankan Government and myself, as the Minister 
of Education, to empower you all. 

This book is a product of free education. Your aim must be to use this book 
properly and acquire the necessary knowledge out of it. The government in turn is able 
to provide free textbooks to you, as a result of the commitment and labour of your 
parents and elders.

Since we have understood that the education is crucial in deciding the future 
of a country, the government has taken steps to change curriculum to suit the rapid 
changes of the technological world. Hence, you have to dedicate yourselves to become 
productive	citizens.	I	believe	that	the	knowledge	this	book	provides	will	suffice	your	
aim. 

It is your duty to give a proper value to the money spent by the government 
on your education. Also you should understand that education determines your future. 
Make sure that you reach the optimum social stratum through education.

	 I	 congratulate	 you	 to	 enjoy	 the	 benefits	 of	 free	 education	 and	 bloom	 as	 an	
honoured citizen who takes the name of Sri Lanka to the world.  

Akila Viraj Kariyawasam
 Minister of Education
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Foreword 

The educational objectives of the contemporary world are becoming more 
complex along with the economic, social, cultural and technological development. 
The learning and teaching process too is changing in relation to human experiences, 
technological differences, research and new indices. Therefore, it is required to 
produce the textbook by including subject related information according to the 
objectives in the syllabus in order to maintain the teaching process by organizing 
learning experiences that suit to the learner needs. The textbook is not merely 
a learning tool for the learner. It is a blessing that contributes to obtain a higher 
education along with a development of conduct and attitudes, to develop values and 
to obtain learning experiences.

The government in its realization of the concept of free education has offered 
you all the textbooks from grades 1-11. I would like to remind you that you should 
make the maximum use of these textbooks and protect them well. I sincerely hope 
that this textbook would assist you to obtain the expertise to become a virtuous 
citizen with a complete personality who would be a valuable asset to the country.

I would like to bestow my sincere thanks on the members of the editorial 
and writer boards as well as on the staff of the Educational Publications Department 
who have strived to offer this textbook to you. 

W. M. Jayantha Wickramanayaka,
Commissioner General of Educational Publications,
Educational Publications Department,
Isurupaya,
Battaramulla.
2019.04.10    
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In this chapter you will learn:

²   how to identify data and information
²   what a system is
²   the systems we come across in our day to day activities
²   characteristics of quality information
²   Information and Communication Technology
²   applications of Information and Communication Technology
²   evolution of the computer

 1.1   Data and Information
 
 The numbers, words, images and symbols which do not bear a meaning, 
when standing alone are called data.While we can arrive at meaningful information 
by arranging and processing data, we can use them to make decisions also.

Example 1
	 It	will	be	difficult	to	get	an	idea	about	the	subjects	and	marks	if	names	and	
marks are written separatly on term test results.

Ravi 78, 90, 79, 67, 76, 98   Rizwan 87, 70, 80, 75, 80, 80   Krishan 76, 78, 67, 80, 79, 76

But these names and marks can be tabulated as follows:

Name Language Mathematics Science History Health English
Ravi 78 90 79 67 76 78

Saman 76 78 67 80 79 76
Rizwan 87 70 80 75 80 80

 
 This table shows some information about the marks of students. However, 
in	order	to	arrive	at	some	meaningful	conclusion,	this	may	not	be	sufficient:

1
Information and Communication 

Technology
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	 Marks	that	were	tabulated	can	be	subjected	to	calculation.
Name Language Maths Science History Health English Total Average Rank

Ravi 78 90 79 67 76 78 468 78 2

Saman 76 78 67 80 79 76 456 76 3

Rizwan 87 70 80 75 80 80 472 78.66 1

	 In	this	table,	name	and	subjects	such	as	language,	maths	are	data	and	total,	
average and rank are information. 

You can see that the teacher is able to get the required information using 
this table (i.e. the total score of each student, their average scores, individual skill 
of each student, the rank etc). The information gathered in this manner is useful for 
the teacher to take important decisions.
Example 2
To identify the difference between data and information, let us consider the 
following Figures;

When we take each 
image separately, 
it does not convey 
a meaning. But 
when properly 
arranged as on the 
right hand side, 
one can understand 
that these are the 
members of one 
family.

Figure		1.1	-	Human	figures

Figure 1.2 - A family
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7 4  2 7 7 1 2 3 7 V
The year of 

birth	by	first	two	
numbers

  Number 0-4 denotes that the person is a male
  Number 5-9 denotes that the person is a female
  

Example  3 
Analyzing NIC number
Take	a	look	at	the	numbers	in	a	National	Identity	Card.	At	once	it	looks	as	if	it	is	just	
a number. But when you analyze it, you can obtain some meaningful information.
When	the	NIC	number	is	given	one	could	find	the	person's	age	and	gender.

 1.2     Information System

Once, man used to process data using a pen, pencil or other devices. But 
today the computer has become man’s data processor. A system is a combination of 
components	that	work	together	to	fulfil	a	task. 

Submitting data for processing is called “Input” and the result we get after 
processing is called “Output.” We can call the collection of all these components 
above a “Information System.” 

Storing data is an important task in information system. In some occasions, 
both input and stored data are used to obtain information.

Hence the purpose of a system is to receive data, process and store them and 
provide the results when required.
	 According	to	 the	figure	1.3 a computer processes the data that we input, 
according to the commands and provide us with the required information in the 
desired form. Therefore, we call the computer an ‘ Information System’.

 Activity 

Provide	five	other	examples	for	data	and	information.

National Identity Card 
Number 

Processing Date of birth/
Gender
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Figure 1.3 - Function of an Information System

We use many such systems in our day today activities. Let us consider some 
of	the	examples:

Example 1 -  ATM  Automatic Teller Machine
When the bank  ATM card is inserted to ATM machine, data is processed 

and information regarding the account is given.

Account Balance

 ATM card and key board     Bank computer system

Figure 1.4 - Automatic Teller Machine in banks

 දත්ත Data  සකස් කිරීම Processing Information Output

Example 2 - Finger print reader to record the attendance of an organization

 දත්ත Data  සකස් කිරීම Processing

 ² Time of arrival
 ² Time of 

departure

Figure 1.5 - Finger Print Reader

Information Output
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Example 3 -  QR Code used to find information

After scanning the QR code by a smart phone and connecting to the internet, 
further information can be obtained from the website of the relevant item. QR code 
is used in newspapers, magazines and selling items. 

Example 4 - Processing business information         

Processing InformationData

  Figure 1.6 - Obtaining information by QR code

-

conducting 
promotion 

programmes to 
low income areas

 Data 

 Processing  Information 
 

 Decision Making 

 

Purchases, 
Sales,

100,000
Year,

Income, 2013,
2014,	Profit,	
2000, 50.000

Number, 
Expenses,	Loss

  

Figure 1.7 - Processing business information

 Monthly income 
of	branch	offices	
comparative to 
previous year
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A computer or computerized equipment is used to process the data and we 
make decisions based on the information we get as output.

We understand that we can get information by processing data and this 
information can be used to arrive at decisions. However, not all information is 
suitable for making decisions. Information obtained should be of good quality. 
There are many characteristics of quality information. A few of them are given 
below:
Quality of information Example
a) Relevancy                 It is not needed to submit all the academic information 

from Grade 1 onwards, when the requirement is to submit 
only	the	highest	educational	qualification.

b) Completeness            Taking information from only a small group of people in 
order to arrive at the PCI (Per Capita Income) of a country 
is	 not	 sufficient.	 Incomplete	 information	 could	 lead	 to	
drawing wrong conclusions.

c) Accuracy                   If a doctor gets wrong information about the patient’s 
health, it could be harmful to the patient. 

d) Timeliness                The information must always be updated. Today’s weather 
report	 may	 not	 be	 suitable	 to	 decide	 on	 tomorrow's	
weather.

e) Cost Effectiveness If	an	organization	spends	money	more	than	the	profits	to	
collect	 some	 information	 in	 order	 to	 increase	 profits,	 it	
would be a business loss to the organization.

 
 

 
 

 
 

 
 

     Activity 

This is an image you could see on the 
items we buy at the market. This is called 
Barcode. This barcode is scanned at the 
cashier by a Barcode Reader. Observe how 
the bar code is used in different occasions.

This image is seen at the back 
page of some books you buy.  This 
is called ISBN Code.

Meet	the	librarian	and	find	out	what	information	you	can	obtain	by	taking	ISBN	number	as	
the input.

Image 2Image 1

Observe  Images 1 and 2 below:

(A) (B)

  Activity
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 Activity 

Write	another	example	each	for	the	above	(a)	-	(e).

 1.3    Information and Communication Technology

We learnt that we can get information by processing data and that 
information can be used to make decisions and arrive at conclusions. When we 
exchange	the	information	among	different	people	or	among	different	systems,	it	is	
called communication of information. 
	 Man	has	been	processing	and	exchanging	information	since	ancient	times.	
But	 he	 had	 to	 face	many	 difficulties	 and	 obstacles	 in	 data	 communication.	But	
today it has become an easy task with the advancement of  technology.

Today, technology is used in various ways to convert data into information 
and	 then	 to	 exchange	 them.	 This	 is	 called	 Information	 and	 Communication	
Technology (ICT).

 1.4   Applications of Information and Communication       
          Technology

Today, you could hardly come across any person or a place that does not 
use information and communication technology in day to day activities. Some 
examples	are	illustrated	below:

  

Figure 1.8 - Applications of Information and Communication Technology

e-Government 

Education

Health

Agriculture

Transport

Entertainment

BusinessesIndustries
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1.4.1  e - Government
When a government communicates with its citizens, companies, Government 

and Non-Government Organizations and with other Governments (of different 
countries) using ICT, it is called e-Government.
	 There	are	numerous	web	sites	such	as	official	web	portal	of	the	government	
of Sri Lanka, Government Information Center, ICTA (Information Communication 
Technology	 Agency)	 etc	 for	 e-Government	 activities.	 The	 difficulties	 in	
communicating with the Government and obtaining Government information have 
been overcome by these.

E-Government Services (http://www.gov.lk/)

  Figure  1.9 - e-Government Services
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1. Visit	 the	 Government	 web	 sites	 such	 as	 the	 official	 web	 portal	 
of Government of Sri Lanka, Government Information Center, ICTA 
(Information Communication Technology Agency) etc. Make a list of 
five	valuable	information	and	the	services	you	could	obtain	yourself	
of as a citizen of Sri Lanka.

     Activity

2. Make a list of e-government services that are provided by other 
countries mentioned below. 

            Eg - Malaysia, Singapore, England

1.4.2  Applications in the field of education
                      

    Years ago                                             Today                

Days are gone when we were stuck among piles of books in order to collect 
the	required	 information.	Today	you	have	 the	 luxury	 to	see	and	gain	knowledge	
about the entire world at your own convenience, due to all the advancements of 
ICT.

There are many ways as to how ICT helps you in your education. Let us 
look at some of them: 

Figure 1.10 - ICT in Education
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a) In the classroom
There are many ways the computer and the internet are used for education 

in the classroom:
²  For presentations
²   Videos	on	experiments
²   Creation of images and video
²  Desktop publishing of magazines, letters and 
     documents
²   Educational games (Edutainment)
²   Learning using the CD-ROM media
² Gathering educational information on the  
     internet

b) Education - any where anytime 
    If you have a computer with internet connection, you can study while at 
home or any other convenient place. For this, you can use the following educational 
websites to do self study and improve your knowledge within your pace.

²  www.schoolnet.lk
²   www.nenasala.lk
²   www.e-thaksalawa.moe.gov.lk
²  www.vidumanpetha.com

You can contact with a teacher/trainer via 
internet. This is called WBT (Web based Training). 
While you can do further studies using WBT, it 
helps	 in	 minimizing	 the	 difficulties	 of	 travelling	
and	 related	 expenses	 also.	 At	 the	 same	 time,	 it	
helps save time and money.

• Visit the Websites mentioned above and list the areas which you 
       can use to support your knowledge.
• List three advantages compared to traditional teaching methods in  
 studying Science, Mathematics and ICT by visiting G.C.E. (O/L)  
 section on BBC Bitsize (www.bbc.co.lk/ education).

    Activity  

       can use to support your knowledge.

Figure 1.11 - Computer 
in the Classroom

Figure 1.12 - Education 
Anywhere any time
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c) Serves as a teaching aid for the teacher
ICT can be used mostly as a teaching aid in  schools.

 ² Using pictures, animations and  
	 audio-visuals	 to	 explain	 subjects	 that	 are	 
	 difficult	to	explain.
 ² To make the lessons interesting using  

      electronic presentations.
 ² To organize lessons using the computer.
 ² To obtain information relevant to the 
	 subjects.	

d) Learning Management System (LMS)
In many countries it has become a common practice to use a Learning 

Management System to manage school system and higher education system. We 
need an internet connection to link with the LMS. A person has to register himself/
herself	on	the	official	website	to	access	LMS	of	a	school	or	any	other	educational	
institution. According to the picture 1.14, teachers and students can get many 
services from LMS.

Figure 1.14 - Learning Management System

Figure 1.13  - ICT as a teaching 
aid
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Some services provided by Learning Management System.

For a Student For school Management
The ability to use the learning units at 
anytime and anywhere at school, at home 
or any other convenient place.

The ability to add quality learning 
materials 

The ability to upload the assignments 
completed at home

Supervision of activities and publishing  
of results 

The ability to submit queries, getting 
replies and submitting comments 
through Forums

The ability to maintain updated 
information of the students, teachers 
and school

Ability to participate in the 
co-curricular activities via video.

Submitting questions, getting replies 
and providing comments through 
Forums

The parents can monitor the progress of 
their children from home.

Sending and receiving necessary 
information by e-mail to parents, school 
development committees and other 
school	officials.

e) Higher education for everyone
With the development of ICT, today a person 

from any country can connect with a university or any 
other learning center of his choice and pursue higher 
education at a considerably low cost. This is called 
Online Distance Learning.

Features of Distance Learning:

• Within	a	flexible	time	frame,	provide	the	facility	to	learn
• Digital	library	facility	on	joining	a	course.	
• Online assignments and quizes. 
• Contact with a teacher online. 
• Easy to obtain teacher consultations.

Figure 1.15 - 

 Distance Learning
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1.4.3  ICT in Health Sector

	 Many	of	the	difficult	processes	in	the	medical	field	have	become	efficient	
with through the use of modern equipment.

Figure 1.16 - Modern Health Equipment

There are surgical 
devices with cameras 
which can record the 
surgical procedures 
while surgery is 
carried out. 

Devices and 
appliances which are 
used in the practical 
training of doctors 
and nurses.

Devices used to 
analyse store and print 
medical records.

There are plenty of areas where ICT is used in the health sector for our 
well- being. Let us consider some of them.

1' Use of ICT in diagnosis
       Today, there are numerous high tech machines which help us in the diagnosis 
and treatment of diseases. Diseases can be diagnosed at the early stages and the 
patients	can	be	given	treatment	accordingly.	Some	examples	of	these	machines	are:

Example 1 - CAT - Computerized Axial Tomography Machine  
Using this machine three dimensional (3D) images of different parts of the 

body can be made. These images are helpful in the diagnosis of diseases.
  

Figure 1.17 - CAT Machine Figure 1.18 - 3D Image
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Example 2 - MRI (Magnetic Resonance Imaging Machine)     
This machine can 

create digitalized images 
of internal organs of the 
body by using strong 
magnetic	fields	and		radio	
waves. These images are 
very helpful in the 
detection and deciding on 
treatment of diseases.

Example 3 - ECG  - Electrocardiogram Machine
          This machine is 
used to monitor the heart 
beat. When the heart 
pumps blood to different 
parts of the body some 
electrical impulses are 
produced. This machine 
records the electrical 
impulses. 

Example 4 - Cardiac Screening Machine
 This machine 

displays the physiology 
of the heart and it 
displays the movements 
inside the heart. Through 
this machine it is possible 
to diagnose problems of 
the heart such as thinning 
of vains and then 
recommend treatment.

Figure 1.19 - MRI Machine Figure 1.20 - Detailed Images

Figure 1.21 - ECG Machine Figure 1.22 - ECG Graph

Figure 1.23 - Cardiac 
Screening Machine

Figure 1.24 - Cardiac 
Screening Display
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Example 5 - EEG (Electro-encephalography)  
This machine is used to record the activities of the brain. The small electrical 

probes attached to the head receive the electrical impulses of the brain and display 
them on a computer screen. This device can retrieve the data in both states where a 
patient is awake or asleep.

Example 6 - Blood Sugar Testing Machine 
This device would 

analyze a sample of blood and 
determine the blood glucose 
level.

Example 7 - Blood Pressure Measuring Machine 
This device which is 

worn as wrist band can measure 
the blood pressure of a person at 
rest and when he/she is involved 
in some physical activity.

Figure 1.25 - EEG Machine Figure 1.26 - EEG Display

Figure 1.27 - Blood Test

Figure 1.28 - Measuring Blood Pressure
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2'  Telemedicine

Figure 1.29 - Telemedicine

Patient’s Home

Emergency 
Telemedicine

Patient 
Examination

ICU (Intensive Care 
Unit)

Hospital 
Information 

System

Head	Quarters	(Hospital's	
Specialists Center) 

Tele Training

Remote clinical 
treatment

Tele Surgery
Airplane/Cruise 

ship

Remote Village 
Hospital

Ambulance

	 The	 use	 of	 Information	 Communication	 Technology	 to	 examine	 and	
or provide healthcare to a patient who is far away from the hospital is called 
Telemedicine. This is made possible by remotely connecting the patient with 
hospital’s specialist unit or specialist doctors. Telemedicine has several advantages 
such as:

Example 1 - Emergency Telemedicine                                                                  

Emergency telemedicine is the process 
of providing emergency care by a trained person 
in consultation with a specialist in a hospital via 
telecommunication network and treating him when 
a	patient	(who	lives	in	a	remote	village	or	flying	in	a	
plane or cruising in a ship) can not reach a hospital.  

Figure 1'30 - Telemedicine

Communication network
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Example 2 - Home health medicine 
Keeping the patient at home and 

monitoring his/her condition using networked 
home monitoring system. The home monitoring 
of the health condition helps to decide when to 
transfer the patient to hospital. 

Example 3 - Telemedicine Consultation 
Seeking medical consultation of a 

specialist at the Emergency Treatment Unit 
(ETU) when he/she is not physically available 
in hospital.                                                                      

Example 4  -  Telesurgery (Remote Surgery)
Remote surgery is the ability of a doctor 

to perform surgery on a patient in consultation 
with a specialist (who is not physically present 
at the same location but in a far away town 
or abroad) by the use of Telecommunication 
Technologies.
      

                                                                        

Example 5 - Medical Teletraining 
Specialists’ consultation and training 

can be used to obtain the services of a medical 
professional at a remote place by the use of 
telecommunication technologies. In training 
hospital staff, specialist consultation and training 
from a resource person in a foreign country or 
town can be attended, using telecommunication 
technologies in a nearby training centre. 

Figure 1.31 - Home Health Medicine

Figure 1.32 - Medical Consultation

Figure 1.33 - Telesurgery

Figure 1.34 - Medical Teletraining
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1.4.4  ICT in Agricultural Industry    

	 ICT	has	created	a	new	revolution	in	the	field	of	agriculture.	Today	ICT	is	
extensively	used	in	agriculture,	animal	husbandry	and	fisheries	industries.

ICT for farming:
A range of automatic machines are available today to ease the work of the 

farmer	who	worked	hard	in	the	field.	These	machines	not	only	ease	the	work	of	a	
farmer but also enables him to produce high quality yields.

Below are some of the machines used for agriculture in developed as well 
as developing countries.

Example 1 - Meteorological Devices
These devices are helpful in assessing 

the weather, climatic changes, rainfall, wind 
direction etc. Such data are useful in deciding  
on the crop cultivation and harvesting times.

Example 2 - Automated Insect Control 
Devices                                     

With the help of this device we can minimize the harmful effects caused by 
insects. It displays on screen the direction and the density of insect population, its 
growth and movement.

Figure 1.35 - Meteorological
Devices

Figure 1.36 - Automated Insect Control Devices



              For free distribution 19

Example 3 - Field conditions measuring devices
 These devices 

help in measuring 
various parameters such 
as fertility and humidity 
levels of soil which aid 
in the determination of 
cultivation activities.

Example 4 - Drip irrigation                                  
 These devices 

control the supply of 
water as per the data fed. 
Wastage of water and 
destruction of crops due 
to lack of water supply 
are minimized by the 
use of these devices.

Example 5 - Automatic Weed remover
This	machine	 runs	 through	 the	 field	

and removes the weeds as per instructions 
provided by identifying crops and weeds 
separately.

Example 6 - Seedlings planter using Robotics
      These robotic 

machines are used in large 
fields	 to	 carry	 seedlings	
across	 the	 field	 and	 to	
plant them in an orderly 
manner.

Figure 1.37 - Field conditions measuring devices

Figure 1.38 -  Automated Water Supply Systems

Figure 1.39 - Automatic Weed Remover

Figure 1.40 - Seedlings planter using Robotics
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Example 7 - Crop harvesting using Robots
Robotic machines are used to 

monitor plant growth levels, record 
them and harvesting in large scale farm 
lands. These machines help us overcome 
difficulties	in	managing large	farm	lands.	

Example 8 - Greenhouse
       The Greenhouse is 
the best solution to protect 
crops from natural disasters 
(too much sun shine, rain, 
heat, cold, pests, epidemics 
etc). ICT is used to control 
light, moisture and air 
inside the greenhouse. 
Hence, farmers are able to 
make high quality products  
of rare crops to the market.

1.4.5  ICT in management of farmhouse   
          

Example 1 - RFID – Radio Frequency Identification Device
    The RFID help in identifying 

and counting the number of animals 
and also in locating the animals in a 
large area.  

Example 2 - Automated milking and examination of cows 
 This automated 

machine is helpful in 
monitoring the health status 
of the cows, milking and the 
quality of milk. 

Figure 1.42 - Greenhouses

Figure 1.43 -	Radio	Frequency	Identification	Device

Figure 1.44 -	Automated	milking	and	examination	of	cows

Figure 1.41 - Crop harvesting using Robots



              For free distribution 21

Example 3 - For Security (Closed Circuit TV CCTV)
CCTV is employed to protect 

farm from the animals and thieves. 
When the cameras are connected by 
Wi-Fi (Wireless Fidelity) the farm 
can be monitored far away from the 
farm. 

Example 4 - Farm Management
Today’s farmer uses various computer applications 

in portable computers such as laptops, tabs, smart phones 
to	keep	track	of	information	on	his	farm;	to	calculate	profits	
and losses, to save employees salary details etc. Using 
this portable device which has internet connectivity, he 
is capable of monitoring the market rates, get updated on 
latest	business	information	and	exchange	information.

1.4.6  In Fishing Industry      

                                        
Sensors are placed 

in different parts of 
the sea. These sensors 
convey	 information	on	fish	
concentration in the sea to 
the	 computers	 in	 fishing	
trawlers via internet.  
                                                       

1.4.7  ICT in Manufacturing Industry and Business  

ICT is used in manufacturing high quality products and reduce the cost 
of production by minimizing the use of human labour in many industries and 
businesses. Since high quality products are manufactured at low cost, people can 
buy good quality products at a relatively low price.  

Figure 1.45 - Closed circuit TV

Figure 1.46 - Computer in 
Managing the Farm

Figure 1.47 - Sensors under 
sea

Figure 1.48 - Transfer of 
information
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Let us see how technology is used in manufacturing;

Figure 1.49 - Use of ICT in industry

TodayIn the past

In the past decades a high level of human labour was needed in the 
manufacturing industry. Today most of the work performed by the human hands 
are performed by robots.

Uses of robots;

24 hour service, Never get tired, Efficiency, Accuracy, Hygiene

Following pictures show how robotic technology is used in production 

             

Figure 1.50 - Computer 
Manufacturing

Figure 1.53 - Car Production

Figure 1.52 - Packaging

Figure 1.55 - Filling bottles

Figure 1.51 - Manufacture of 
Packaging material

Figure 1.54 - Labeling
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Example 1 - Video Conferencing  
This technology has enabled 

different business communities 
who are geographically separated 
to convene face to face meetings 
while in at their own premises. The 
advantages of this technology include 
the following. Convening at a special 
venue is unnecessary and saves time, 
effort and cost spend on travelling. 

Example 2 - Human Resource Management                                                   
The administration of employee 

activities has become an easy task due 
to	finger	print	scanner	(used	to	register	
attendance) and Card Reader (Identity 
Management). These devices help in 
recording the time of employees moving 
in	and	moving	out	of	the	office	premises,	
preparing salaries accordingly, keeping 
records of leave taken etc. Today, 
the above devices are used not only 
in the private sector but also in the 
public sector in Sri Lanka.

Example 3 - e-Banking System
e-Banking has helped both the business 

community and all of us to do convenient banking. 
They are:
• The ability to withdraw cash anytime anywhere at 

ATM (Automatic Teller Machines) points.
• Since banks are connected via internet, inter 

banking or transactional activities are made 
possible even within Sri Lanka or abroad.

• When you are registered in a banking network, 
it gives one the opportunity to pay utility bills,  
inter-banking transactions, checking the account 
balance, using mobile phones.

Figure 1.56 - Video Conferencing

Figure 1.57 - Finger Print 
Scanner

Figure 1.58 - Card 
Reader

Figure 1.59 - e-banking 
System
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Example 4 - Online Shopping
       Online shopping known as electronic 
commerce which allows foreign or local company 
to sell its products or services and the ability for a 
consumer to buy goods and services via internet. 
A buyer can order goods or services of his/her 
choice from a convenient place. The advantages 
of online shopping include:

• One can select any global commercial 
organization which is on the internet.

• Open 24 hours.
• Ability to see things and order at one’s convenient place.
• The ability to pay using the electronic payment methods such as credit cards.
• Home delivery of goods or services, thus saving time, transport cost and 
	 avoid	unnecessary	travel	related	exhaustion.

1.4.8  ICT in Transport  

We	can	quote	some	of	the	systems	which	are	used	to	enhance	the	road	traffic	
by minimizing	traffic	jams.

Example 1 - Closed Circuit TV (CCTV) 
This system which 

uses the CCTV (Closed 
Circuit TV) is helpful in 
monitoring	 the	 road	 traffic,	
accidents, illegal activities 
and take appropriate actions 
accordingly.

Example 2 -Traffic Light Control System
These automated lights are positioned at 

road	junctions.	These	lights	help	in	minimizing	
accidents	 by	 controlling	 the	 vehicle	 traffic	 and	
pedestrians.

Figure 1.60 - Online Shopping

Figure 1.61 - Closed Circuit TV

Figure	1.62	-	Traffic	Lights	Control	
System
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Example 3 - Parking identification placard
This is an entrance pass 

which is stuck on the windshield 
of a vehicle. When the vehicle 
comes close to the gate of the 
parking space, the sensors read 
the placard and only open the 
gates if the vehicle is already 
pre-registered. Due to its 
quick processing ability, this 
automated system also helps to 
avoid	 building	 up	 of	 traffic	 at	
the gate. 

Observe three instances where ICT is used in business and 
manufacturing and write report.

   Activity 

1.4.9  ICT in Entertainment  

Various ICT devices and equipment have been invented to provide  some 
peace of mind to human beings who are spending a busy and restless life today. 
These devices enable us to:

³  listen to music to overcome a monotonous life,
³  watch missed TV programmes or movies of own choice through the internet,
³  exchange	information	between	friends	and	relatives	who	live	abroad	or	whom	

we have lost touch through social media,
³  watch high definition video using technology,
³  surf the internet. This helps children to do learning activities and play games 

during the free time at home,
³   read e-books on internet and
³  take photographs of interesting places and store them in the computer.

Figure	1.63	-	Parking	identification	placard
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 Figure 1.64 - ICT in Entertainment

Social network Listening to music 
and watching video Digital photo 

Video 
Games

 Watching movies

Watching digital technology 
TV programmes

e-news and e-booksDownloading and 
listening to music on 

internet

    Digital 
Photography

Entertainment 
and Relaxation 

In day - to - day life, there are instances where you use computer systems 
by knowing	or	unknowing.	For	example,	a	modern	car	consists	of	a	lot	of	computer	
systems. Moreover, a modern ticketing machine in a bus, washing machine, 
indicating the	distance	that	can	be	travelled	by	the	existing	fuel	in	a	vehicle	can	be	
cited	as	examples.	

 1.5   Demerits of ICT
Not only does ICT help us as enabler to perform our day today activities, it 

has become a close companion also. However, if you associate this companion in 
an undue manner it may bringforth undesirable effects to you as well to the entire 
society. The following are some of them.
• Addiction – A student or any other person who immerses himself/herself in 

the	excessive	use	of	computer	or	who	plays	games	on	internet	without	a	limit,	
may lose the track of education and/or end up with ailments such as sore eyes, 
back pain,  headache etc.

• Building unsuitable friendships through social media.
• When the computer is infected by virus due to improper use of internet, it may 

not function properly or go out of order.
• Mental disorders may affect a person causing harm to himself/herself and to 

society by visiting improper websites.
• Publishing of distorted photographs and videos of individuals affecting their 

personal lives.



              For free distribution 27

• Obesity due to less exercise
• isolation
• violating copyrights

There is an opinion that ICT has negative impacts on human society due 
to issues mentioned above. But we have understood that the systems made by ICT 
make	most	of	man's	usual	work	easy.	Therefore,	it	is	our	responsibility	to	use	ICT
in a responsible manner.

 1.6   Evolution of the Computer

By now you would have understood that computers assist us in converting 
data into information. Even though at present, there are automated computer 
systems, the computer too has undergone a similar evolution process as human 
beings and has reached the advanced stage today.

The computer was born in the attempt to make an adding machine. In order 
to add numbers, a device called Abacus was invented around 5000 years ago.
    

In due course many new inventions were made. The followings are  few of them:
• In 1642, Blaise Pascal invented a machine called 

the Adding Machine. This was the world’s	first	
ever mathematical machine. 

• In 1674, Gottfried Wilhelm Von Leibnitz 
improved the machine invented by Pascal. With 
these improvements the machine was able to 
perform multiplication and division too. 

• A French Scientist named Joseph Jacquard 
invented a mechanical loom using Punch Card System.

• Charles Babbage started to make his Analytical Engine using the Punch Card 
System concept. This machine was based on the concepts input, process, output 
and store. Since this concept helped in the development of the computer, Charles 
Babbage is called the father of computing.

• Madam	Ada	Augusta	Lovelace	is	considered	as	the	first	programmer	since	she	
tried to write programmes for the Analytical Engine.

• In the year 1944, a man named Howard Aiken invented the machine called 
Automatic Sequence Control Calculator at the Harvard University with the 
assistance of his companions and IBM Company. This was named MARK 1.

All the versions of early computers were mechanical in nature. From the 
time when the computers became automated they were categorized into various 
‘Generations’ as below:

Figure 1.65 - The Abacus
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  Summary

 ² Images, words, numbers or symbols which do not convey a meaning when 
standing alone are called data. 

 ² Information is obtained by processing data. Information is used to make 
decisions.

 ² Computer is a system.

 ² Computers and computer based systems are used to process data.

 ² Providing	data	is	called	‘input’	while	extracting	information	is	called	‘output’

 ² Quality of information is important, (relevancy, completeness, accuracy, 
timeliness, low cost)

 ² Data input, processing and data output are components of a system.

 ² Technology	is	used	to	exchange	the	processed	data.	This	is	called	ICT.

 ² Applications	of	ICT	have	made	man's	life	easy.	There	are	many	applications	
such as e-Government, education, health, agriculture, business,transport, 
entertainment etc.

 ² The advent of computing dates back to 5000 years. Computing is categorized 
into many generations from the period of automation. 

Find information on computer history and make a report as a group 
activity.

Activity 
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2
Fundamentals of a computer 

system

After studying this chapter you will be able to understand;

²   features of a computer,
²   classification of computers,
²   functions and devices of a computer system,
²   basic components of a computer,
²   computer ports and,
²   computer network.            
    

2.1    What is a computer?
 

 First chapter described how computer systems can make day-to-day work 
efficient. 
 A computer can be described as an electronic device, which accepts or 
collects data, processes them according to the given instructions and produces the 
desired output.
 Computer has become an essential device in our lives. Some of these 
features of a computer can be described as follows; 

Speed A computer takes only a few seconds to perform calculations. 
It executes more than one million instructions per second. 

Accuracy A computer provides correct output when correct instructions 
and data are given.

Efficiency A computer  never gets tired. It can work round the clock with 
the same level of accuracy.

Versatility A computer can be used to perform many tasks simultaneously. 
This is one of the special features of a computer. 

Storing and 
Retrieving

A computer is used to store large number of data and information 
in a relatively small unit and we can retrieve them easily and 
quickly when needed. 
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2.2    Classification of computers

 As described in the first chapter, a computer can be used to perform various 
tasks such as preparation of documents, control machineries or check your illnesses. 
Hence you may understand that a computer always may not take the same physical 
form.
 The computers that we use can be divided into different types. There are 
various classifications of computers according to the size and the technology used. 
Hence, computers can be classified as follows;

Figure 2.1 - Computer types 

computer classification

Accordi ng t o phys ical s ize                                             According to technology

 

2.2.1 Classification according to physical size

(i)   Super Computers
 These computers have higher 
computing power. Computing power 
means the tasks that can be completed 
within a specific time period. They 
are large in size, expensive and rare.
(Figure 2.2) These are used for scientific 
and engineering functions and to solve 
complex mathematical problems. For 
example, these computers are used 
in institutes like NAZA, large scale 
businesses and for military purposes.     

(ii)    Mainframe Computers
 These have relatively less physical size, computing power and are less 
expensive than the super computers. In mainframe computers, a number of users 
get connected to one computer using a number of terminals sharing, saving and 
retrieving data. (Figure 2.3 and 2.4) These are used in large scale businesses, in 
e-business and with super computer transactions done using internet. This type of 
computers are used even today in some large commercial institutions.

Figure 2.2 - Super Computers
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(iii)  Mini Computers
 These are lower in physical size, less powerful and less expensive than 
Mainframe computers and are also called common purpose computers. These are 
easy to use. A few users get connected to the central computer and through a few 
terminals share data and information. These computers are used in medium scale 
institutions such as banks. (Figure 2.5 and 2.6)

Figure 2.5 – Mini Computer design

 Terminals

Figure 2.7 – Personal Computers

(iv) Micro Computers
This is a small computer meant for 

personal use. This consists of a small memory 
capacity, smaller in size, less speedy and is 
less expensive. Further, this consumes little 
electricity (Figure 2.7). 

Laptop, hand held, smart phones  are 
some examples for this category. 

2.2.2  Classification according to technology 
 

Computers can be classified according to the technology used. These are,
(I)   Analog Computers

These computers use analog 
signals such as environmental parameters 
(speed, pressure, and temperature). 
Speedometers, road lamps with sensors 
and meteorological machines can be 
given as examples. (Figure 2.8)

(II)  Digital Computers
The computers used by us in  

day-to-day life are called digital 
computers. These computers use digital 
signals. (Figure 2.9)

(III)  Hybrid Computers
This is a combination of analog and digital computers. The ECG machine 

used in hospitals to check the function of the heart is an example for hybrid 
computers. This machine identifies the function of the heart beat which is an analog 
signal. Then it is converted to a digital signal and these converted signals are printed 
by this machine.

Figure 2.6 - Mini Computer

The words “Mainframe” 
and “Mini” are distancing 
from usage and those 
are now called as Server 
computers. 

Figure 2.3 – Mainframe Computer Design

Terminals

Figure 2.4 - Mainframe Computer

        Mainframe computer

Terminals
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Figure 2.7 – Personal Computers

(iv) Micro Computers
This is a small computer meant for 

personal use. This consists of a small memory 
capacity, smaller in size, less speedy and is 
less expensive. Further, this consumes little 
electricity (Figure 2.7). 

Laptop, hand held, smart phones  are 
some examples for this category. 

2.2.2  Classification according to technology 
 

Computers can be classified according to the technology used. These are,
(I)   Analog Computers

These computers use analog 
signals such as environmental parameters 
(speed, pressure, and temperature). 
Speedometers, road lamps with sensors 
and meteorological machines can be 
given as examples. (Figure 2.8)

(II)  Digital Computers
The computers used by us in  

day-to-day life are called digital 
computers. These computers use digital 
signals. (Figure 2.9)

(III)  Hybrid Computers
This is a combination of analog and digital computers. The ECG machine 

used in hospitals to check the function of the heart is an example for hybrid 
computers. This machine identifies the function of the heart beat which is an analog 
signal. Then it is converted to a digital signal and these converted signals are printed 
by this machine.

Figure 2.6 - Mini Computer

Figure 2.9 - Digital signals

Figure 2.8 - Analog signals 
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 2.3   Function of a Computer System
 

 The main functions of a computer system is to input data, process and store 
data, and to produce information when needed. Several components are used for 
such functions. The following is the function of a computer system;
 

 
 Data and instructions fed to the computer via an input device first go to the 
Primary Memory. Then those are sent to the CPU for processing.  The processed 
data stored in the Primary Memory as information is sent to the output device. 
The data and information which are to be stored are sent to the Secondary Storage 
Device. The stored information can be sent to an output device through Primary 
Memory. Control Unit sends the control signals to all the devices attached to 
the computer system. Computer memory contains data and instructions. When a 
computer programme works, the relevant data and instructions are sent to CPU.
 The flow of the data and instruction is indicated by a dotted line and the 
control signals are indicated by a solid line in the diagram above. 

Secondary 
Memory

Main
Memory

Registers

Arithmetic and 
Logical Unit 

(ALU)

Control Unit (CU)

Output
Devices

Input
 Devices

Figure 2.10 - A Computer System

Central Processing Unit

Signals

Data / Instructions Flow
Commands / Control
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2.4   Basic Physical Components of a computer system 

 Certain devices are essential for the function of the computer system.

2.4.1  Input Devices 

 Data and instructions are fed to the computer system using input devices. 
There are many input devices. The following are some of them.
(») Keyboard
 This is the most common input device. Though it is designed with the format 
of a conventional type writer, it provides keys for additional functions.
 Normally keyboards come in two sizes. That is from 101/102 keys to 
104/108 keys. The functions of the keys in the keyboard are given below in Figure 
2.11.

(»») Pointing Devices

Example 1 - Mouse
 This is the most popular pointing device used. Mouse provides input via 
buttons. The mouse contains a left button and a right button. Mouse has a wheel to 
roll up and down in the screen. Laptop computers use, a touch pad or a mouse as 
the pointing device. (Figure 2.12)

Figure 2.11 - Keyboard

Typing keys Function keys 

Numeric keys Control keys 

Special 
keys 
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Example 2 - Touch screen
This is the input and 

output device in the modern 
computers and mobile phones. 
Data is fed by touching 
the screen. It also acts as 
a pointing device. (Figure 
2.14)

Example 3 - Joy Stick
This is also a pointing 

device used in computer 
games which can move the 
cursor. (Figure 2.15)

Example 4 - Light pen
Light pen is used 

to select menu items on the 
screen or to draw/write on 
the screen. (Figure 2.16) The 
appearence is similar to a 
normal pen. This is mostly 
used in Computer Aided 
Designs (CAD).

Figure 2.14 - Touch Screen

Figure 2.12 - Mouse

Left 
button

     Wheel

Right 
button

 Touch Pad

Figure 2.13 - Touch Pad

Figure 2.15 - Joy Stick

Figure 2.16 -  Light Pen
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(»»») Imaging and Video Input Devices

Example 1 - Digital Camera
This is the input device used to input 

photographs and videos to the computer. Display 
screen serves as the output device of the camera. 
(Figure 2.17)

Example 2 - Webcam
The webcam is used to view a user 

connected to the computer through internet or 
to capture videos. (Figure 2.18) It is positioned 
on top of the laptop monitor, and for desktop 
computers, can be connected externally.

Example 3 - Closed Circuit TV (CCTV)
The images or videos captured by 

cameras are fed as input to the computers. 
(Figure 2.19) CCTVs are commonly used 
to maintain road safety  and the security of 
premises.

(»¼) Scanners

Example 1 - Flatbed Scanners
This is an input device which functions 

like a photocopying machine. The scanned image 
or document is captured by the laser beams and 
converted to digital data. The scanned picture / 
document can be saved in the computer. (Figure 
2.20)  

Figure 2.17 - Digital Camera

Figure 2.18 - Webcam

 Webcam

Figure 2.19 - CCTV

Figure 2.20 - Flatbed Scanner
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Example 2 - Bar Code Reader
 This device is used to read the 
bar codes. (Figure 2.21) The bar code is 
converted to an alphanumeric value by the 
bar code reader and is fed to the computer 
connected to it.

Example 3 - Magnetic Ink Character Reader - MICR
 This is available in banks. It is used 
to check the accuracy of a cheque. This 
device reads numbers printed at the bottom 
of the cheque, its data such as bank code, 
bank account number and feed them to the 
computer. (Figure 2.22)

Example 4 - Optical Character Recognition - OCR Device
 This is used to capture text in a 
document and to edit that captured text in the  
document. (Figure 2.23) This is commonly 
used in libraries and in government institutes.  

Example 5 - Optical Mark Recognition -  OMR Device 
 This is an input device which 
recognizes marks made using a pencil or 
a pen. It is commonly used to check forms 
filled in pen or pencil, correct MCQs of 
exam papers. It can read the marks and feed 
that data to the computer. (Figure 2.24)

Figure 2.21 - Barcode Reader

Figure 2.22 - MICR 

             Figure 2.23 - OCR

Figure 2.24 - Optical Mark Recognition
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Example 6 -  Automated Teller Machine - ATM
 ATMs have made bank transactions 
convenient for customers. (Figure 2.25) ATM 
machine reads the numbers in the debit or credit 
cards inserted into the machine and connect to the 
computer. Once the bank account number is read 
through the ATM, one system connects with the 
bank's computer for processing the transaction. 

(v)  Microphone
 Microphone is used to feed sound to a 
computer. (Figure 2.26)

  2.4.2  Output Devices

 
 There are several methods of producing the processed information by a 
computer system. Some of  them are,
 (i)   Soft copy

 (ii)  Hard copy
 (iii) Sound

(i)  Soft Copy
  The output on the screen is called a soft copy. The soft copy output can be 
provided on the following devices.

² Monitor/ Screen
 This is also called Visual Display Unit (VDU).  There are several types of 
monitors available today. 

   A  - Cathode Ray Tube (CRT)  Monitor
 This type of monitor, is large in size and 
consumes more electricity. (Figure 2.27) 

Figure 2.25 - Automated Teller 
Machine (ATM)

Figure 2.26 - Microphone

Figure 2.27 - Cathode Ray 
Tube with screen

Cathode Ray Tube
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B  - Liquid Crystal Display - LCD
 This is a flat screen type 
technology. LCD displays utilize two 
sheets of polarizing material with a 
liquid crystal solution between them. 
(Figure 2.28) LED consumes less 
electricity.

C  -  Light Emitting Diode - LED  
LED screens are designed using light 
emitting diodes. (Figure 2.29) LED 
displays have better brightness and 
they are used for symbols, billboards 
and name boards in common places 
and roads. This has become a 
popular medium today due to its low 
electricity consumption.  

² Multimedia Projector
 This is the device used to get 
information output to a wide screen so 
that several people can view it at the 
same time. This can be used as a visual 
aid by a teacher to display presentations, 
to conduct business meetings or to 
watch videos for entertainment.  (Figure 
2.30)

Figure 2.28  - Liquid Crystal Display

Figure 2.30  - Multimedia Projector   

Figure 2.29 - Light Emitting Diode
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Figure 2.28  - Liquid Crystal Display

Figure 2.30  - Multimedia Projector   

(ii)  Hard Copy
 Hard copies are tangible computer outputs. The following are devices which 
provide hard copy output.
 Printers
There are two main types of printers. These are,

1'  Impact Printers
 Impact printers are a primary level device in the printing technology. Impact 
printer refers to a class of printers that have a head or needle which strike against 
an ink ribbon to make a mark on the paper. Its function it is noisy. However, since 
the ink ribbon used is not expensive, this is used in banks and shops for printing 
receipts etc. The following are some of the impact printers.

Example 1 - Dot Matrix Printer
 Letters are printed on the 
paper as small dots here when 
the printer’s head strikes on the 
inked ribbon with needle like tips.  
(Figure 2.31)

Example 2 - Line Printer
 This is a fast printer which prints one 
row at a time. This can print about 3000 lines per 
minute. (Figure 2.32)

Non Impact Printers

 Dot Matrix Printer
 Line Printer

Printers

Impact Printers

 Laser Printer
 Bubble Printer/Ink Jet Printer
 Thermal Printer

Figure 2.31 - Dot Matrix Printer

Figure 2.32 - Line Printer
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2' Non Impact Printers
Non impact printers does not operate by striking a head against a ribbon. 

Hence, it is not noisy. The printouts are better quickly. Running cost of these printers 
are more expensive than impact printers.  The following are some of the non impact 
printers.

Example 1 -- Laser Printers
In a laser printer, the toner (dried ink) in a cartridge is applied on the paper 

to produce the printout. (Figure 2.33 and 2.34)  
Both black and white, as well as colour laser printers are available. The 

laser printer produces clear and quality printouts.

Figure 2.33 - Laser printer Figure 2.34 - Cartridge

Example 2 -- Bubble/Ink Jet Printer 
Liquid ink stored in tanks is kept in the cartridge 

and ink is deposited on paper through small nozzles and 
produce the print. (Figure 2.35) 

Example 3 -- Thermal printers
Heat is used to print the document. It is 

commonly used in businesses to print receipts in 
devices such as like ATM, and in printing labels 
(Figure 2.36).

Figure 2.36 - Thermal printers

Figure 2.35- Ink Jet Printer
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Example 4 - Plotter
 This is commonly used 
in computer based planning 
(architectural designs, town 
planning, designing sailing boats 
etc). A plan is drawn by moving a 
pen on the paper.

(iii)  Sounds
  The device which gives 
a sound output is called speaker. 
Speaker devices are designed for 
personal and common purpose. 

2.4.3  Central Processing Unit - CPU
 
 This is the main component of a computer system. It is also called the brain 
of the computer as well as it functions according to the given commands. CPU 
manages the operating system and application software. CPU consists of three main 
components. The functions of those are as follows;

1. Arithmetic and Logical Unit (ALU) Perform all mathematical and logical 
functions.

2. Control Unit (CU) Controls all devices of a computer 
system.

3. Memory Registers Temporarily stores data needed for the 
function of ALU and the information 
produced by ALU.

   Main Components of Central Processing Unit

Computer Speed
 The unit used to measure clock speed of a computer is Hertz (Hz) and the 
units used to measure computer speed are Megahertz (MHz) and Gigahertz (GHz).  

Figure 2.37- Plotter 

Figure 2.38 -  Speaker and head phones
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2.4.4  Computer Memory

 Several computer memory or storage devices are used to store data and 
information and the functions of each are different. Computer memory can be 
classified as follows. 

  

  Random Access Memory (RAM) is often referred as Main Memory.
(») Primary Memory
 The memory that can be directly accessed by the Central Processing Unit is 
called primary memory/storage. There are three types of Primary Memory.
∗   Random Access Memory (RAM)
 This memory temporarily stores data. 
(Figure 2.40) The data stored in RAM will be 
deleted when the computer is switched off. 
Therefore this is also called volatile memory.  
Data coming from input devices as well as data 
sent to output devices are held in RAM. When 
comparing to ROM, which is discussed after this, 
RAM has both read-write facility. 

∗ Read Only Memory (ROM)
 The data in Read Only Memory is not erased 
when the computer is switched off. Therefore it is a 
Non-volatile Memory. The commands required for 
booting up a computer are stored in ROM.
 These commands are called BIOS (Basic 
Input Output System). Computer Manufacturing 
companies store these commands in a ROM with 
a smaller capasity and is connected to the mother 
boars (Figure 2.41).

Computer Memory

Main Memory Secondary Memory

Random Access Memory 
(RAM)

Read Only Memory (ROM)

Figure 2.39 – Computer Networks

Figure 2.40 - Random Access 
Memory

Figure 2.41 - Read Only Memory
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∗   Cache Memory
 Though this is smaller in capasity than other memory, it is faster. This is also 
called CPU Memory. This acts as the mediator between CPU (Central Processing 
Unit) and Primary Memory. The data frequently used by are stored here. (Figure 
2.42)
 The Central Processing Unit checks cache memory first to see whether 
the required data is available for processing. However, if the required data is not 
available then the data is fetched to cache memory from RAM for processing. 

(»»)  Secondary Memory
 Secondary Memory or the Secondary Storage is the device which stores 
data and information permanently. This is also called External Storage. There are 
internal storage devices as well as external portable secondary storage devices. 
Secondary memory is called non-volatile memory since it does not erase when 
electricity is not available. (Figure 2.43) These can be classified as follows. 

    Figure 2.42 - Cache Memory

3. Checks Primary  
Memory for data

4. Fetch data to Cache 
Memory from the Primary 
Memory and then sends 
these to the CPU.

1. Checks Cache 
Memory to see whether 
there is required data.

2. If there data exists in, 
fetch from cache.

Primary memory

Cache Memory

CPU

Secondary 
Storage

Magnetic media 
devices

•  Hard Disk
•  Floppy Disk
•  Magnetic Tape

•  CD
•  DVD
•  Blu-ray

• USB flash drive
•  Memory c ard

Optical media 
devices

Solid state 
devices

Figure 2.43 - Secondary Memory
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1' Magnetic Media Devices
 Data is stored here by using magnetic field. 

Example 1 - Hard disk Drive
 The Hard Disk Drive (HDD), which is commonly used to store data and 
information, is located inside the computer. However, there are external hard disks 
as well. Today there are hard disks with large capacity due to the development of 
the technology. The user can read and write the data stored in HDD. Therefore, 
this medium is called Read / Write Memory. The capacity of a hard disk ranges 
from 250 GB to 4 TB. The maximum capasity will increase with technological 
development.

Hard Disk is made of several components. 

1. Platter – This is a metallic, aluminum 
or ceramic disk and data can stored 
on both sides using magnetic media. 
There can be several platters in a hard 
disk.

2. Spindle – Holds the platter and rotates 
it.

3. Head – Reads the magnetic data in the 
platter and writes on the platter. There 
are two heads for a platter; one on top 
and one on bottom.

4. Actuator arm – Moves the head. 
Enables reading and writing  data 
anywhere in the platter.

5. Power connector – Connects the Hard 
Disk to power which is needed for 

 its function.

6. IDE connector – Transmits data to the 
platter

7. Actuator – An electronic device which moves the arm connected to it. This is 
operated by a motor.

                 Figure 2.44 - Hard Disk

A hard disk with 
several platters

External 
hard disk

1
2 3 4

5

67
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Example 2 - Magnetic Tape
 Used mostly in sever computers for 
back up due to its larger storage capasity. But 
tape is not used in day today life as it is slow 
in reading and writing (Figure 2.45). 

Example 3 - Optical media
 Since data stored digitally on a disk is read and written by laser beam, it is 
called optical media. Optical media is commonly used to carry data and information 
and there are several types. The followings are some of them;

Device Type Size  Image
CD-ROM 
^Compact Disc - 
Read Only Memory&

Used only to read, written data and 
instructions

650 - 900 
MB
 

4.7 - 9.4 
GB

 

25 - 128 
GB

CD-R 
^Compact Disc 
-Write once&

Can be used to write data and 
information once until the capacity 
is filled. 

CD-RW (Compact 
Disc  
Re-Writable)

Data which is written on the disk can 
be erased and re-written. 

DVD-ROM Digital 
Versatile Disc - Read 
Only Memory

Used only to read, written data and          
instructions

DVD-R 
(Digital Versatile 
Disc - Write Once)

Can be used to write data and 
information once until the capacity 
is filled. 

DVD – RW 
(Digital Versatile 
Disc - Rewritable)

Data which is written on the disk can 
be erased and re-written.

Blue ray Disc (BD) R 
(Recordable)

Can be used to write data and 
information once until the capacity 
is filled. 

Blue-ray RE
(Recordable 
Erasable)

More data can be re-written many 
times until the capacity is filled.

Blue - ray 3D Used to record video.

Figure 2.45 - Magnetic Tape
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3.  Solid State Devices
 Since these devices contain solid parts and does not contain moving parts 
they are called Solid State Devices. They are used to read and write data and 
information.

Example 1 - USB Flash Drive
 This has become a very 
popular secondary storage device due 
to its easy portability and the ability 
to read and write data fast. 

Example 2 - Memory Card
 This has the same function 
of USB flash drive. However, 
the method of connecting to the 
computer is different and it is smaller 
in physical size. This is used in 
digital cameras, mobile phones and 
computer gaming devices.
 
E.g. - SD Card (Secure Digital Card)

Figure 2.46 - USB Flash Drive

           Figure 2.47 - Memory Card

  

 Activity 

1. Write advantages and disadvantages of Magnatic media, Optical 
adia and Solid state media. 

2. Find a discarded hard disk, open it with the help of your teacher 
and observe the parts inside. 
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2.5  Computer Ports
 

 The interfaces which connect computer with its devices or with other 
computers are called ports. (Figure 2.48) Ports are positioned in the front or back of 
the computer. There are symbols to identify posts. All the ports are connected to the 
motherboard. 

1. PS/2 Port  
  Used to connect the keyboard and the 

mouse to the computer system. The purple 
port is for the keyboard and the green port 
is for the mouse. (Figure 2.50) However, 
USB port is mostly used today to connect 
the keyboard and the mouse to the computer 
system.

2. Parallel Port
  Used to connect the printer to the 

computer system. This consists of 25 holes. 
(Figure 2.51)  However, USB port is mostly 
used today to connect printers to computer 
systems.

Figure 2.48 - Ports

1. PS/2 ports 5. Audio ports 
2. Parallel port 6. USB port
3. HDMI port 7. Video port
4. RJ 45 port 8. Serial ports 

Figure 2.49 - How ports are connected to the 
Motherboard

Figure 2.50 -PS/2 Ports

Figure 2.51- Parallel Port
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3. HDMI (High - Definition Multimedia 
Interface) port

  This port can be seen especially in 
laptops. (Figure 2.52) It connects the monitor, 
multimedia projector, digital TVs, and digital 
speakers to the computer. 

4. RJ 45 Port
  This port connects computer of a computer 

network to the network router, network switch.
 (Figure 2.53)

5. Audio Ports/ Jacks
  This port connects audio media like 

microphones, speakers and head phones to the 
computer system. (Figure 2.54)

 Blue – Line In
 Green – Line Out, Head Phone
 Pink – Microphone

6. USB (Universal Serial Bus Port)
  This port is used to connect many types 

of input and output devices to the computer. 
(Figure 2.55)

7. Video port - VGA (Video Graphics 
Adaptor)

  This is also called the Graphic Port. This 
connects the monitor, or multimedia projector 
to the computer system. (Figure 2.56) The 
port consists of 15 holes.

Figure 2.53 - RJ 45 port

Figure 2.54 - Audio Ports/ Jacks

Figure 2.55 - Universal Serial Bus 
Port

Figure 2.52 - HDMI Port

Figure 2.56 - Video port 
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Figure 2.52 - HDMI Port

8.   Serial port
 This port connects devices such as 
modem to the computer. Today,  USB port is 
used instead of the serial port. (Figure 2.57)

  Observe and identify the ports in the computer in the laboratory.
 Activity

  

 2.5  Data Communication
 

 Transmitting data and information is called data communication. Data 
transmission can be carried out between two or more computers or devices such 
as  printers.Data transmission needs a connection between a sender and a receiver. 
Creating such a connection is called networking.

 2.5.1  Basic components required for data communication 
                      

The following are the basic components that are needed for data communication.  

 

     
     Figure 2.58

• Sender / Source – the person or the object which sends data 
• Medium – medium used to transmit data (telephone wires / wireless)
• Receiver/ destination – the person or the object which  receives data 

Figure 2.57 - Serial Port

Figure 2.56 - Video port 



For free distribution54

 2.5.2  Data Transmission Modes

There are several modes of data transmission between sender and receiver.

 1)  Simplex Mode

 Data is transmitted from the sender to the receiver only. Getting print outs, 
watching television, and listening to radio can be given as examples

Figure 2.59 - Simple mode communication

 
            

 2)  Half- duplex Mode
 Here, data is transmitted to one direction at a time. This means after data is 
transmitted from sender / source to the receiver, the receiver can transmit data back 
to the sender / source. Browsing internet to get information and walkie-talkie used 
by security forces can be given as examples. 

Medium

 Figure 2.60 – Willkie – 
Talkies Half duplex mode 
communication 

 3)  Full Duplex Mode

 Data is transmitted to both sides at the same time is called Full duplex. 
Telephone conversation is an example for full duplex mode communication.

Medium

Figure 2.61 - Full Duplex Mode communication 

 2.5.3  Data Transmission Media
 

 This is another important feature when creating connections among systems. 
There are two types of data transmission medium. Those are called Guided/Wired 
and Unguided/Wireless. The following are some examples. (Figure 2.62)
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There are two types of data transmission medium. Those are called Guided/Wired 
and Unguided/Wireless. The following are some examples. (Figure 2.62)

Figure 2.62 - Data Transmission Medium
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^i&  Guided / Wired
 If the medium used for data transmission is a physical medium, it is called 
guided or wired.
Example 1 - Twisted Pair
 Pairs of twisted copper wire are used for data 
transmission. There are two types.

1.    Unshielded Twisted Pair (UTP)
 The twisted copper wire pairs used for 
telephone connections. These are very flexible and 
low-priced. However, it is difficult to transmit data 
for a long distance through UTP wires.  It is suitable 
for maximum of 100 meters.

2. Shielded Twisted Pair (STP) 
 STP is a better quality and secure data 
transmission medium. However it is expensive. 
(Figure 2.64)

Example 2 -  Coaxial Cable
 This consists of an electronic cable pair. The 
outer cable which is like a braided copper net produces 
electromagnetic field around the central cable. These 
two cables are separated by a plastic shield. These 
cables are expensive and used for TV antenna and 
CCTV. 

Example 3 - Fiber Optics cable
 Fiber Optics cable consists of a pair of an 
cables. There is a plastic jacket to separate the two 
cables. Core is a glass tube and there is glass cladding 
around it. (Figure 2.66). The data transmission is 
carried out  by while reflecting light. These are used 
in modern telephone networks. The cable is relatively 
more expensive. This is the fastest data transmission 
media at present. 

Figure 2.63 - Unshielded Twisted 
Pair

Figure 2.64 - Shielded Twisted 
Pair

Figure 2.65 - Coaxial Cable

 

 Figure 2.66 - Fiber Optics



              For free distribution 57

(ii)  Unguided/Wireless Media
 Data is transmitted as signal through 
the air without using  physical medium is 
called  unguided/wireless media. 

Example 1 - Radio waves
 Data transmission is performed 
using radio waves. Wifi and Bluetooth 
are examples for radio waves based 
communication.

Example 2 - Microwaves 
 Microwaves travel in a linear 
mode. (Figure 2.68) Transmission center is 
positioned facing each other. The distance 
between centers are decided based on 
geographical factor of the area.
 Microwaves are used in Satellite 
communication to transmit data as 
transponders. (Figure 2.69)  Satellite centers, 
which are positioned in the sky above 36000 
km, capture data transmitted as microwaves 
through satellite towers positioned in the 
Earth and then transmit the data back to the 
required tower. Using this method, data can 
be transmitted to any distance. This is also 
used in internet communication. 

Example 3 - Infrared
 Infrared data transmission 
is used in TV remote controllers, 
wireless keyboards and mouse etc. 

Figure 2.67 - Radio waves

Figure 2.68 -  Micro waves

Figure 2.69 - Satellite Communication

Figure 2.70 - Infrared

 Activity
1. Write down advantages and disadvantages of copper wire and 

optical fiber.
2. Considering the factors such as speed, distance and price in data 

transmission, organize a discussion to decide the suitable media in 
different occasions.
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 2.5.4  Computer network devices

 There should be two or more computers to build a computer network. 
Connection devices used to connect computers with each other.

(i)  Network Interface Card (NIC)
 NIC has an RJ45 port and is built into the mother board in modern computers. 
In the port NIC was a separate code to be plugged to the mother board.

Figure 2.71

Figure 2.72 - Network interface card   Figure 2.73  - RJ 45 
connector
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(ii)    Switch/Hub
 Switch/Hub acts as the mediator to build 
a connection between two or more computers. 
(Figure 2.74) A guided/wired transmission 
media is used. One end is connected to port in 
the computer and the other end is connected to 
the port in the Switch / Hub. 

Differences between the switch and hub  
• The main difference is the data transmission speed. Hub sends the transmitted 

data to all computers but switch sends data to the relevant computer only. Here 
hub may create an unnecessary network data congestion.  

• In data transmission, hub uses half duplex mode and the switch uses full duplex 
mode. 

(iii)   Wireless Fidelity - Wi-Fi
 Wi-Fi technology has become the most 
popular media in computer networking. For 
this purpose, Wi-Fi access points are used. 
This allows the users to build a computer 
network easily and internet connections for 
mobile phones and laptop computers using 
radio waves. 

(iv)   Router
 Router is the device used to build a 
connection between two or more computer 
networks. It is also called a Gateway. This 
finds out the most suitable ports for data 
transmission in network communication.

Figure 2.74 - Switch / Hub

Figure 2.75 - Wi – Fi

Figure 2.76 - Router
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(v)   Modem  

 In getting the internet with telephone wires, 
the modem is used to connect the computers of a 
computer network or a personal computer at home 
to the internet. The modem acts as a data translator. 
Digital signals sent from the computer is translated 
to analog signals so that they can be transmitted 
via telephone line and the analog signals coming 
from the telephone line send to the computer from 
the internet is translated to digital signals. This is 
called MOdulation and DEModulation. Hence, 
‘MODEM’ is a combination of these two words. 
There are different types of MODEMs. Those are 
internal, external and wireless modems. Todays 
routers have a modem inbuilt in the device.

(vi)  Firewall
 Firewall is a network security. Instructions to control the data and 
instruction transmission between internet and computer network are built into the 
system. A firewall 
operates as a secured 
barrier between 
internet and network 
in exchanging data 
among computers. 
Firewalls can be 
purchased in both 
forms as  software and 
hardware.

Figure 2.78 – External Modem

Figure 2.77 – Internal Modem

Figure 2.79 – Wireless Modem
Modulation - Demodulation

Internet
Computer network

Data and Information

Figure 2.80 - Firewall

Firewall

  

Activity
  Observe the firewall in a computer operating system with the help of 

your teacher.
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 2.5.5  Client/Server network

 

 A server computer responds to the client computer connected to the server. 
A network operating system is installed to the server. The one who requests data or 
information via internet or from an area network is called a client and the one who 
provides data and information is called the server.

 2.5.6  Types of Computer Network

• Computer Networks
 Computer networks can be classified according to geographical distribution 
of computers in the network. 

Figure 2.81 – Client / Server Network
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(i) Local Area Network (LAN)
A LAN connects computers inside a room or 

several rooms in a building. (Figure 2.83) A computer 
network built in a school, university, a small scale 
business or an office can be given as examples.

(ii) Metropolitan Area Network 
- (MAN)

MAN is a combination 
of several Local Area Networks 
which covers less than 16 
miles Examples include banking 
networks, institutes and universities 
with branches. (Figure 2.84)

(iii)  Wide Area Network - WAN  
    These networks cover a wide area. This can 
be within or outside a country. The best example for 
WAN is the Internet. (Figure 2.85)

Figure 2.83 - LAN

Figure 2.84 - MAN

Figure 2.85 - WAN

Provide two examples for LAN, MAN and WAN.
Activity
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2.5.7  Network Topology

 
 Network topology is the pattern of connection in designing computer  
network. There are different types of network topologies. Those are,

i)  Star Topology    
 This is a commonly used design 
and built by centralizing a switch/hub and 
computers. (Figure 2.86)

ii) Bus Topology
 Here, all the connections are 
established through a main cable. (figure 
2.87) This cable is called the backbone 
because any issue with the network affects 
all the computers in the network. This design 
is easy in networking and fewer cables are 
required. However, a limited number of 
computers can be connected.

ii)  Ring Topology
 Here, computers are positioned in a 
ring/bangle and connected through cables. 
Data or information move in a circular 
manner. The breakdown of one computer 
or cable can lead to the breakdown of the 
entire network.

Figure 2.86 - Star Topology

Figure 2.87- Bus Topology

Figure 2.88 – Ring Topology
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iv)  Tree Topology
 Tree topology has characteristics of both 
bus and star topologies. In this design several star 
topologies are connected to a bus backbone cable. 
(Figure 2.89) One of the advantages of this is the 
ability to control each network individually.

v) Mesh Topology
 All the computers in the network are 
connected with each other. (Figure 2.90) Since 
this is a complex connection pattern, it is costly 
and difficult to control. However, a breakdown of 
one computer does not affect the connections in 
the network. Mesh networking can be found on 
internet.

2.5.8  Benefits of Networkings 

Data and information can be shared 
between computers.

The main advantage of networking is 
sharing data and information between 
computers. Data and information in 
a server, can be accessed by clients 
connected to the server. 

Figure 2.89 - Tree Topology

Figure 2.90 - Mesh Topology
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Less storage space  
This saves space as well because the same 
data is not stored in several computers 
unnecessarily.

Ability to share resources The devices like printer, scanner and 
modem can be connected to network and 
shared by multiple users.

Ability to control central software Software can be installed on a server 
computer and shared by many users 
through client computers.

Ability to connect at any where and at 
any time

By connecting to internet, a user can 
access his / her documents and data at 
any where and any time (24×365).

Security  Only the authorized  clients can access the 
server computer. Data and information in 
a network can be made secure. 

Electronic mail E-mail is a convenient method of sharing 
information between computers.
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2.5.9  Disadvantages of Networking

Possible security issues
One major disadvantage of networking 
is the difficulty in securing data. Server 
can be accessed through any computer 
connected to the network. Hence it is 
difficult to secure it from the hackers 
(people who try to gain access to data 
without permission). 

Breakdown of network
In some topologies, breakdown of a 
computer or a cable can affect the function 
of the other computers of the network.

Virus
If one of the computes in the network gets 
a virus attack, this can spread to other 
computers as well.

Computer break downs
Due to defects or breakdown of the server, 
the other the clients can be affected. 

Training requirements
The need for a person who is specialized 
in network administration.
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  Summary 

• A computer is an electronic device which accepts or collects data, processes 
them according to the instructions given and produces desired output.

• Characteristics of a computer are speed, accuracy, efficiency, versatility and 
storing and retrieving ability.

• Classification of computers
According to size - Super Computers, Mainframe computers, Mini computers, 
Personal Computers / Micro Computers / Mini Computers

According to technology - Analogue Computers, Digital Computers, Hybrid 
Computers

• Basic components of a computer
• Input devices
• Output devices
• Central Processing Unit : Arithmetic and Logical Unit (ALU), Control 

Unit, Memory Registers
• Primary Memory / Main Memory
• Secondary storage

• External devices are connected to a computer through ports.
• Basic components of data transmission are sender/source, media, receiver/

destination.
• Modes of data transmission

• Simplex–mode
• Half–duplex mode
• Full muplex mode
• Data transmission medium

• There are two types – guided and unguided / wireless
• Connectivity devices such as switches, routers, modems are necessary to build 

a network.
• Types of computer networks – LAN, MAN, WAN
• Computer network topology includes 

• Star topology
• Bus topology,
• Ring topology
• Tree topology
• Mesh topology

• There are advantages as well as disadvantages of computer networking. 
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3
Data Representation Methods in 

the Computer system 

3.1   Computer Data Representation

Chanaka : Can you prepare this application using the computer Anjana?

Anjana    : Sure, I’ll do it. You read this. Let us type it. ''Application…"

Chanaka : When “A” on the keyboard is pressed, how does the computer identify 
      it Anjana?

Sameera  :  Let us ask our teacher.

Janitha    : Teacher, how is letter “A” represented in the computer?

Teacher   : look at this picture children. (Figure 3.1)

In this unit you will learn,

²   computer data representation,
²   Decimal, Binary, Octal and Hexadecimal number systems,
²   most and least significant positional value of a number,
²  converting decimal numbers to binary, octal numbers to hexadecimal 

numbers
²   conversion among binary, octal, hexadecimal and decimal numbers,
²   data storage capacity,
²   coding systems in computers.
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    Figure 3.1 – Letter “A” representation on the computer.

Teacher     :     According to the figure above (Figure 3.1), it is clear for you how       
 letter "A" is displayed on the screen.

Sameera/
Janitha       :     Thank you very much, Sir

Step 1
Press “A” on the keyboard.

Step 2
The electronic symbol for letter 

“A” goes to the System Unit 
through the keyboard.

Step 3
Electronic signal of letter “A” goes 

to the video memory via RAM

Step 4

     “A” is displayed on the screen after 
processing.
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3.1.1  Number System   
When typing letters or words using the computer, these words or letters 

are represented by the computer as numbers it can understand. While this group of 
numbers that the computer can understand is called a 'Number System' the limited 
number of numerals in the number system called digits. The value of these numbers 
(numerals) depends on the position they occupy within the number.

While the concept of number system was present in the 'Abacus ' considered 
as the first calculating machine of the world, it has progressed up to the computer of 
today.

The number system used for the representation of data in the computer is as 
follows; 
                Table 3.1 - Numbers and Alphabetic characters used in the Number System

     Number System Base Value Number and Alphabetic character used
1' Binary 2 0, 1
2' Octal 8 0, 1, 2, 3, 4, 5, 6, 7
3' Decimal 10 0, 1, 2, 3, 4, 5, 6, 7, 8, 9
4' Hexa - decimal 16 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F

3.1.2  Use of Binary Numbers in Computer Data Representation

Computer represents data in two signal states. There are two Voltage levels 
for these two symbols. One is named as the high voltage level and the other is 
named as low voltage level. ''0'' and ''1'' digits respectively represent these low and 
high voltage levels in a circuit. Thus, ''1'' and ''0'' status are 
equal to the “On” and “Off” states of an electronic circuit.  
Any data in the world can be represented on the computer 
using these two digits.

According to the Figure 3.3 given below, when data 
stored in Secondary Storage is sent to the Main Memory and 
when it is sent to the Central Processing Unit from there, that 
data are  converted to a binary code.

Figure 3.2 – A switch of an 
electronic circuit 

Figure 3.3 – How data is sent to the Central Processing Unit from the Secondary Storage

Copying data from the 
Secondary Memory to 
Main Memory 

Main Memory
(Random Access Memory)

Sending data to the 
Central Processing Unit 
from Main Memory

Central Processing Unit 
Disk Drive
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Let us consider 
the instance where Binary 
numbers are used for 
computer colours. Any 
colour can be made with 
the combination of different 
degrees of red, green and 
blue.

These can be 
represented as RGB (Red, 
Green, Blue) and the value 
of any colour ranges from 0 
to 255. 

For instance, if you need to use dark purple for the background of a document, 
that colour can be represented in the computer as “135, 31, 120”  (Figure 3.4). 
With these numbers, the colour combination for the above colour is represented in 
decimal numbers.  Binary numbers for 135, 31 and 120 are 1000001112, 111112, 
and 11110002.        
3.2   Decimal, Binary, Octal and Hexa-Decimal Number  

 Systems

 3.2.1  Decimal Number System

Each number system is made of a Unit, Number and Base / Radix. 

Unit
Unit is a single object. For instance, a mango, a Rupee, and a day can be 

considered a unit.

Number
A number is a symbol which represents a unit or quantity.

Base / Radix
A number of symbols used in a number system is called the base/radix. The 

base of any number system is indicated in decimal numbers. 

Figure 3.4 – Colour representation in computer
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From our childhood, we have learnt to perform calculations using decimal 
Number System which consists of digits from 0 to 9.  

Normally, the base value of decimal numbers are not mentioned, but for the 
other numbers the base value has to be mentioned. The digits that are used in the 
decimal number system are as follows;

Table 3.2 – Digits of Decimal Number System

Number System Decimal Number System or base 10 
number system

Base / Radix 10

Digits used 0, 1, 2, 3, 4, 5, 6, 7, 8, 9
  

Let us study how a number included in the decimal number system is formed. 

Example
Let us consider how the number 25 is formed.
25 is formed with the addition of 20 and 5.

25 = 20 +  5
= ^2 « 10&  ¬  ^5 « 1& 

= ^2 « 101& ¬ ^5 « 100&

These positional values such as 100, 101, 102 are called Weighting Factors of 
decimal number system. This number can be shown on a counting frame (abacus). 
(Figure 3.5) 

Thousands

1000
103

Hundreds

100
102

Ones

1
100

Ten 
thousands

10 000
104 

Tens

10
101

Figure 3.5 – Decimal number representation of 25



              For free distribution 73

This can be shown as given below, as well.

   

Example
Next, let us consider how a decimal number is formed.

    3    0    2.    7   5      - decimal number 

3.2.2 Binary Number System

Though we use the decimal number system when we input numbers as data 
or instructions, the computer represents these data as 0 and 1. The number system 
which consists of 0 and 1 is the binary number system.

   

2  5

5 «100  =   5
2 «101  = 20
  25

102 101 100 10-1 10-2  - weighting factor 

  = 300 + 0 + 2 + 0.7 + 0.05
  = 302.75302.75

5 «10-2 = 0.05
7 «10-1 =   0.7
2 «100  = 2
0 « 101 =  0
3 « 102 =   300

302 .75

10
5

100

= (3«102) ¬ (0«101) ¬ (2«100) ¬(7«10-1) ¬ (5« 10-2 )
= 300 + 0 + 2 + 7 + 

    Figure 3.6 – Electronic circuit
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The digits for the binary number system is given below. (Table 3.3)

Table 3.3 – Digits used in the Binary Number System 

Number System Binary Number System
Base 2

Digits used 0,1

For instance, let us consider 111011012.
1 1 1 0 1   1 0 1

2
   - decimal number 

27 26 25 24 23 22 21 20     -  weighting factor

The values such as 20, 21, 22, 23… are called the weighting factors of binary 
number system.    

This number can be indicated in a binary base counting frame as given 
below. (Figure 3. 7)

Sixty 
fours
 

64

26

Thirty 
twos

32

25

Sixteens

16

24

Eights

8

23

Fours

4

22

Twos

2

21

Ones

1

20

Hundred 
twenty 
eights

128

27

Figure 3.7 – Binary number representation.

The Binary number system is very important in computing and it contributes 
in the representation of a bit; the basic measuring unit of the computer.  The smallest 
value and the highest value which can be seen in this number system is 0 or 1 
respectively. This smallest value is called Bit                                               

1 1 0 01 11 1

27 26 25 24 23 22 21 20

B inaryDig it
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3.2.3  Octal Number System

 The number system which uses eight digits: 0, 1, 2, 3, 4, 5, 6, 7  is called the 
octal number system. 
Digits of the octal number system are given below. (Table 3.4)

Table 3.4 – Digits of Octal Number System

Number System Octal Number System
Base 8

Digits used 0" 1" 2" 3" 4" 5" 6" 7

For instance, let us consider 2368.

2 3 6  - octal number
 

82 81 80  - weighting factor
 The values such as 80, 81, 82, 83 … are called the weighting factors of the 
octal number system. This number can be represented as given below in a base 
eight counting frame. (Figure 3.7)

Five 
hundred 
twelves
512

83

Eights

8

81

Sixty 
fours

64

82

Ones

1

80

Four 
thousand 
ninety sixs
4096

84

   Figure 3.8 – Octal number representation

3.2.4  Hexa-Decimal Number System

 The computer uses binary numbers and it is difficult for human beings to 
read them. Hence, the hexadecimal number system is used as it is easier for humans 
to use. Normally, calculations are performed using the ten fingers of the hands. Just 
imagine you have sixteen fingers on your hands. Then you can use sixteen numbers 
to count. In the hexadecimal number system, ten digits are used from 0 to 9 and for 
the other 6 digits, A, B, C, D, E and F symbols are used. Here, A, B, C, D, E and F 
are used to represent 10, 11, 12, 13, 14 and 15. (Table 3.5)
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     Table 3.5 – Comparison of Decimal and Hex-Decimal numbers   

Decimal Number

Hexa-Decimal Digit

0 1

0 1 2 3

2 3 4

4

6

6

8

8

10

A

11

B

12

C

13

D

14

E

15

F

5

5

7

7

9

9

            

The Digits of the hexadecimal number system are given in the table below. 
(Table 3.6)       

         Table 3.6 - Digits of Hexadecimal Number System 

Number System Hexadecimal Number System
Base 16

Digits Used 0" 1" 2" 3" 4" 5" 6" 7" 8" 9" A, B, C, D, E, F

              

When F the largest number of hexadecimal number system, is expressed 
in binary form, it can be indicated with 4 Bits. Thus, instead of using a binary 
number with 4 Bits, a single number in hexadecimal number system can be used. 
For example, Hexadecimal numbers are used to represent memory addresses of the 
computer.

You can see code “# 871F78” related to the dark purple colour shown in 
Figure 3.4. Here the value of the colour is started with “#” symbol. The colour 
value is indicated in the computer in hexa decimal numbers. Thus, the code for dark 
purple in the above example is “# 871F78”.  R,G,B values of this can be indicated 
from 0 to 255 in decimal numbers. If “#’ or “&H” (ampersand) symbol is used in 
front of the value of any value, it is a hexa decimal number. Given below in Table 
3.7 are the hexa decimal values and RGB values of dark purple colour. 

   Table 3.7 – Hexadecimal Value of Dark Purple Colour

Name of 
Colour

Colour Hexadecimal 
Value

R G B

Dark 
Purple

#  871F78
&H 871F78

135 31 120

For instance, let us consider 15E16

  1 5 E16 - H exa-decimal number                         
 

162 161 160 - Weighting factor                                

162 161 160

15E 16
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Here, 160, 161, 162, 163….. values are called Hexadecimal Weighting Factors. 
This number can be represented on a sixteen base counting frame as below. (Figure 
3.9)

   Figure 3.9 – Sixteen base number representation 

Relationship among Decimal, Binary, Octal and Hexadecimal 

Ones

  1
160

Sixteens

16
161

two hundred 
fifty six

        256
          162

Four 
thousand 
ninety 
sixs
4096
    163

Figure 3'8 - Relationship among Decimal, Binary, Octal and Hexadecimal 
  Decimal Binary Octal   Hexadecimal 

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

0
1

10
11

100
101
110
111

1000
1001
1010
1011
1100
1101
1110
1111

10000
10001
10010
10011
10100
10101
10110
10111
11000

0
1
2
3
4
5
6
7
10
11
12
13
14
15
16
17
20
21
22
23
24
25
26
27
30

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F
10
11
12
13
14
15
16
17
18

80, 160

81

161

20

21

23

24
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3.3   Most and Least Significant Positional Value of a 
        Number

 
   There are two separate methods to find the most and least significant values 
of decimal numbers and whole numbers. When a whole number is read from left 
to right, the number in the right most end is the least significant positional value 
and the number in the left most end which is not 0 is the most significant positional 
value. (Figure 3.10) 

                        

        Figure 3.10 - Most and Least Significant Positional Values

In decimal numbers, the value in the right extreme after the decimal point 
which is not 0 becomes the least significant positional value and the number in 
the left extreme of the decimal point which is not 0 becomes the most significant 
positional value. 

3.3.1  Most Significant Digit (MSD) and Least Significant Digit (LSD)

Given below in Table 3.9 are the most and least significant digits of a round 
figure or a decimal number.

                Table 3.9 – The Most and Least Significant Positional Value of a number

Number MSD LSD
329 3 9
1237.0 1 7
58.32 5 2
0.0975 9 5
0.4 4 4

You can use the same method used for the decimal number system to find 
the most and least significant positional digits of binary, octal and hexadecimal 
numbers. 

Most 
Significant 
Positional 
Value

Least Significant 
Positional Value
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Find the most significant digit and the least significant digit of the 
following numbers.
(i) 5687010  (ii) 154.0110  (iii) 23.0808 (iv) AD 23916    
(v) 0.001102 

Activity

3.3.2 Most Significant Bit (MSB) and Least Significant Bit (LSB)

Only the Binary Number System is used to find the most significant bit 
(MSB) and the least significant bit (LSB). There are two ways to find this using 
decimal numbers and whole numbers. 

In a whole number, read from left to right, the value in the right extreme 
is the least significant bit and the value in the left extreme which is not 0 is the 
most significant bit. In binary decimal numbers, the value in the right extreme of 
the decimal point which is not 0 is the least significant bit and the value in the left 
extreme of the decimal point which is not 0 is the most significant bit.

Table 3.10 - The most significant bit and the least significant bit
Binary Number MSB LSB

1001 1 = (23) 1 = (20)

011.101 1 = (21) 1 = (2-3)

Find the most significant bit and the least significant bit of the 
following numbers.
(i) 10002 (ii) 0111012 (iii) 0.110012 (iv) 1.00102 

(v) 0.001102 

Activity
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3.4 Converting Decimal Numbers to Binary, Octal and 
Hexa-Decimal Numbers

3.4.1  Conversion of Decimal numbers to numbers of other bases  

All the data we input to the computer is taken by it as digits of binary 
number system; 0 and 1. Hence, the knowledge to convert a base ten number to 
another base is important. Here in this chapter, conversion of a decimal number to 
a binary number, octal number and a hexadecimal number is discussed. 

3.4.2 Conversion of Decimal Numbers to Binary Numbers

When a decimal number is converted to a binary number, the decimal 
number can be divided by two until the remainder is 0 and the remainder of the 
division can be written on the right side. After that, write all the remainders from 
the bottom to top to build the number.  

Example

Converting number 1210 to a binary number.
 ¾ First, divide this number by 2 writing the remainders.

  2 12
  2 6

  2 3
  2 1

0

0

0
1
1

Quotient

Remainder

 ¾ Secondly, write down all the remainders from bottom to top.  

12
10
 = 11002  
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Example
Converting 4610 to a binary number.

0

0

1
1
1

1

  2 46
  2 23

  2 11
  2 5

0

2
1

  2
  2

4610 = 1011102

Convert the following decimal numbers to binary numbers.

(i) 15510   (ii) 47210 (iii)116310  

Activity

3.4.3  Converting Decimal Numbers to Octal Numbers  

Here, divide the given number by 8 until the remainder is 0 and write the 
remainders from bottom to top.

Example
Converting 15810 to an octal number.

 ¾ Firstly, divide this number by 8 and write down the remainder. 
  8 158

  8 19
  8 2

0

6
3
2

Quotient

Remainders

 ¾ Secondly, write down all the remainders from bottom to top.

158
10
= 236

8
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Convert the following decimal numbers to octal numbers.

(i) 15510  (ii) 47210 (iii) 116310  

Activity

3.4.4  Converting Decimal Numbers to Hexadecimal Numbers  

Here, divide the number by 16 until the remainder is 0 and write down the 
remainders from bottom to top.
Example
Converting number 3810 to a hexadecimal number.

 ¾ Firstly, divide this number by 16 and write down the remainders. 

           

16 38
16 2

0
6
2

Quotient

remainders

 ¾ Secondly, write down all the remainders from bottom to top.   
3810  = 2616

Example
Converting number 4710 to a hexadecimal number.

4710  = 2F16

16 47
16 2

0
15
2

F
2

Convert the following decimal numbers to hexadecimal numbers.

 (i) 25610 (ii) 47810 (iii) 196310 

Activity
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Convert the following decimal numbers to octal numbers.

(i) 15510  (ii) 47210 (iii) 116310  

Activity

3.4.4  Converting Decimal Numbers to Hexadecimal Numbers  

Here, divide the number by 16 until the remainder is 0 and write down the 
remainders from bottom to top.
Example
Converting number 3810 to a hexadecimal number.

 ¾ Firstly, divide this number by 16 and write down the remainders. 

           

16 38
16 2

0
6
2

Quotient

remainders

 ¾ Secondly, write down all the remainders from bottom to top.   
3810  = 2616

Example
Converting number 4710 to a hexadecimal number.

4710  = 2F16

16 47
16 2

0
15
2

F
2

Convert the following decimal numbers to hexadecimal numbers.

 (i) 25610 (ii) 47810 (iii) 196310 

Activity

We have converted decimal numbers (base ten) to binary, octal and 
hexadecimal numbers earlier. Now let us consider how to convert binary numbers 
to decimal numbers, octal numbers to decimal numbers and hexadecimal numbers 
to decimal numbers. (Figure 3.11)

3.5.1 Converting Binary Numbers to Decimal Numbers  
 

Example
Converting number 11012 to a decimal number.

23 22 21 20 

11012 = (1«23) ¬  (1«22) ¬ (0«21) ¬ (0«20)
 =  (1«8) ¬ (1«4)  ¬ (0«2) ¬ (1«1)
 =  8 ¬ 4  ¬ 0 ¬ 1 

11012= 1310 

 
21101  

13

821
421
020
121

3

2

1

0

=×
=×
=×
=×

 

102 131101 =  

1 1 0 1 

         Convert the following binary numbers to decimal numbers.
  (i)1012  (ii) 1110101102 (iii)10100101112 

        

Activity

Decimal 
^Base 10&

Binary 
^Base 2&

Hexadecimal 
^Base 16&

Octal
^Base 8&

Figure 3.11 – Conversion between number systems

3.5 Conversion among Binary, Octal, Hexadecimal and 
Decimal Numbers 
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3.5.2 Converting Octal Numbers to Decimal Numbers

Example
Converting number 12758 to a decimal number.

83 82 81 80

Convert the following octal numbers to decimal numbers.
(i) 2308  (ii) 7458 (iii) 20658   

Activity

3.5.3 Converting Hexadecimal Numbers to Decimal Numbers  

Example
Converting number 32916 to a decimal number.

161 160162
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Example
Converting number AB216 to a decimal number.

3.5.4 Converting Binary Numbers to Octal Numbers

From the digits used in the octal number system; 0, 1, 2, 3, 4, 5, 6, and 7, the 
largest digit is 7. We can indicate digit 7 as 1112 in binary form. Thus 7; the largest 
digit in the octal number system, can be indicated in a binary form with 3 digits. 
Likewise, all the digits in the octal number system can be indicated in the three digit 
binary form. Given below in Table 3.11 are the binary forms of the digits used in 
eight base (octal) number system. 

    Table 3.11 – Indicating octal digits in decimal and binary numbers.

Decimal Number Octal Number Binary Number
0
1
2
3
4
5
6
7

0
1
2
3
4
5 
6
7

000
001
010
011
100
101
110
111

162 161 160

Convert the following hexadecimal numbers to decimal numbers
(i) 1A16  (ii) 7EF16 (iii) A4916

Activity
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As per the above table, three bits are used when indicating an octal number 
in binary form. (8 = 23)

Let us consider how a binary number is converted to an octal number.

Example
Converting 10111012 to an octal number.

 ¾ First, divide the number into three bits from the right corner to the left corner. 
If the last cluster in the left corner does not consist of 3 bits, add 0s to complete.

 ¾ Write each octal number separately for each cluster.
 ¾ Then write these clusters in octal digits.
 ¾ Write these digits in order from the left corner to the right corner.

Convert the following binary numbers to octal numbers.

(i) 100110012  (ii) 1111001112 (iii) 101010101102  

Activity

0 0 0 0

0 0 0 0

1 1 1 1 1

111 11

Binary number

Cluster of 3

10111012 = 1358



              For free distribution 87

3.5.5  Converting Binary Numbers to Hexadecimal Numbers

From the symbols used in the hexadecimal number system, the value 
represented by “F” possesses the largest numerical value. This can be indicated 
as a four-bit binary number; 11112. Thus, all the digits in the hexadecimal number 
system can be indicated as four-bit binary numbers. Given below in Table 3.12 are 
the binary numbers for the digits used i n the hexadecimal number system.                                   

Table 3.12 – Indicating hexadecimal digits in decimal and binary numbers.  

As shown in the table above (Table 3.12), four bits are used to indicate a 
hexadecimal number in binary form. (16 = 24)

Example
Converting number 101102 to a hexadecimal number.
•  First, divide the number into four-bit clusters from the right corner to the
      left corner.
•    Write hexadecimal numbers separately for each cluster.
•    Write these numbers in order from the left corner to the right corner and write   
     down the base.

Decimal Number Binary NumberHexadecimal 
Number
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0 0 0 1 1

1

0 1

1

0

000 00 1

Example
Converting number 101110111002  to a hexadecimal number.

0 1 1 1 1 1

1 1 1 1 1 1 1

1 10

00 0

0 0 0

0

IâoYu

0

5

Binary number

Cluster of 4

Hexadecimal number

Convert the following binary numbers to hexadecimal numbers.
 
(i) 110110102  (ii) 111110011012 (iii) 100111000112
 

Activity

3.5.6  Converting Octal numbers to Binary Numbers

We have learned above that an octal number can be indicated in three digits 
when it is converted to a binary number. 

Thus, each digit in octal numbers should be written in three digits when it is 
converted to base two. 

Binary number

Cluster of 4

Hexadecimal number
1

5 D C

6

101102 = 16 16

10111011100 2     =  5DC16
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Example
Converting number 4578 to a binary number.

 y Firstly, write each digit in octal number in three bits.
 y Secondly, write down all the bits together to get the binary number for the 

octal number.

4578  = 1001011112

4
100

5
101

    7
111

Convert the following octal numbers to binary numbers.
  (i) 108  (ii) 2458 (iii) 7068 

Activity

3.5.7  Converting Octal numbers to Hexadecimal Numbers

Example
Converting number 10578 to a hexadecimal number.

•   First, write each digit in octal number in three bits.

•  Divide the binary number you get into four-bit clusters from the right corner to 
    the left corner.

•   Write the related hexadecimal number for each cluster.

7501
001  000  101   111

   

00 1 0 0 0 1 0 1111

     2        2        15
     2        2         F

 

10578  = 22F16

1 0 5 7
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Convert the following octal numbers to hexadecimal numbers

  (i) 3208  (ii) 4758 (iii) 16738 

Activity

3.5.8  Converting Hexadecimal Numbers to Binary Numbers

You have learnt earlier that any symbol in a hexadecimal number can be 
written in a four-bit binary number. Thus, when a hexadecimal number is converted 
to a binary number, each digit in that number should be indicated in a four-bit 
binary number.

Example
Converting number 7416 to a binary number. 

Converting number 2AE16 to a binary number.

Convert the following hexadecimal numbers to binary numbers.
  (i) 7816  (ii) B2C16 (iii) 4DEF16  

Activity

7416  = 11101002

7 4 
0111 0100

2 A  E
0010 1 010 1110

2AE16 = 10101011102
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3.5.9 Converting Hexadecimal Numbers to Octal Numbers

First, the hexadecimal number should be converted to a binary number and 
then it should be converted to an octal number.

Example
Converting number 23A16  to an octal number.

2 3  A
0010 0011 1010

001 0 0 0 1 1 1 010

1  7  2 0

23A16 = 10728

Convert the following hexadecimal numbers to octal numbers.

(i) 32016  (ii) A7B16 (iii) 10ED16  

Activity

1. Consider number “23y”. Here, ‘y’ is the base of the number system. 
   From the number systems you have learned, as to which number 
    system “23y” belongs.
2. Convert the decimal number 8310 to a binary number. Show steps.

 3. Convert the binary number 101101112 to an octal number. Show steps.
 4.  Convert the hexadecimal number 23D16 to a binary number.

Activity
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   5. Fill in the blanks in the table given below.
 Table 3.13 – Several colours and their RGB values and the hexadecimal values

Name of the
Colour Colour Hexadecimal 

Value

R 
 

G B

Dark purple #  871F78 135 31 120

Light pink  255 182 193

Sky blue 50 153 204

Green 0 255 0

Yellow  255 238 0

3.6   Data Storage Capacity
 A certain space is needed to store data in the computer. Data storage 
capacity is measured by units such as bits, bytes, kilobytes, Megabytes, Gigabytes, 
Terabytes and Petabytes. Let us understand how to arrange these different data 
storage capacities in order from the small unit to the big unit and to define the 
relationships between these as well.

3.6.1  Units to Measure Data Storage

Bit
 This is the smallest unit used in the computer to store data. This word is 
coined from the words                  A bit is the two binary digits; 0 and 1.

Byte
  1 byte is 8 bits.

Nibble
 A nibble is half of a byte or 4 bits. This unit is not commonly used like bits  
 and bytes. 

kilobyte

 This consists of 1024 bytes. (1024 = 210) Kilobyte is written as KB or kbyte.

B inaryDig it
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Megabyte
This consists of 1024 kilobytes (1024 = 210) or 1048576 bytes. Megabyte 

is written as MB or mbyte.

Gigabyte
One Gigabyte is made of 1024 Megabytes. (1024 MB) Gigabyte is written 

as GB or gbyte. It is wrong to write ‘Gb’ as it indicates gigabit.

Terabyte
One Terabyte is made of 1024 Gigabytes (1024 GB). This is written as TB.

Petabyte
One Petabyte is made of 1024 Terabytes (1024 TB).

In production of hard discs there are instances 1024 is considered as 1000.

Following are the relationships between units which measure 
data storage capacity.
 8 bits    =  1 byte
 4 bits    =  1 nibble

   1024  bytes  =  1 kilobyte (KB)
     1024  kilobytes =  1 Megabyte (MB)
     1024  Megabytes =  1 Gigabyte (GB)
     1024  Gigabytes =  1 Terabyte (TB)  
     1024  Terabytes =  1 Petabyte (PB) 

Observation

Consider the examples given below to get an idea about the units above.
   

  Table 3.14 – Approximate data storage capacity as text pages.

Name Abbreviation Approximate 
Bytes

Exact Bytes Approximate 
Text pages

Byte B One 1 One text
Kilobyte KB (or K) Thousand 1024 ½ page

Megabyte MB One million 1,048,576 500 pages

Gigabyte GB One billion 1,073,741,824 500,000 pages

Terabyte TB One trillion 1,099,511,627,776 500,000,000 pages
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3.6.2  Capacities of Data Storage Devices

     Different storage devices possess different storage capacities. The tasks 
fulfilled by these devices are also different. Let us study these different storage 
devices. (Figure 3.12)

   Figure 3.12 – Capacities of storage devices

When reading and writing data, the time spent to access the devices (access 
speed) is different. Consider the figure given below. (Figure 3.13)

Register Memory
1 KB
Cache memory
3 MB – 32 MB
Compact Disk (CD)
650 – 900 MB
Digital Versatile Disc
4.7 – 9 GB
Random Access Memory
01 – 64 GB
Read Only Memory (ROM)
Flash Memory
1 – 64 GB
Hard Disk
100 GB – 6 TB
Magnetic Tape
1 TB – 185 TB

Small

Large

Data 
Storage 
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       Figure 3.13 – Data access speed

3.6.4  Cost per unit Storage

For different storage devices, cost per a bit to store data is different. For 
instance, the cost is more for Register Memory and Cache Memory. The comparison 
is shown in the figure given below. (Figure 3.14)   

       

  

Figure 3.14 – Cost per unit storage

3.6.3  Data Access Speed

Register Memory
Cache Memory
Random Access Memory
Read Only Memory 
Flash Memory
Hard Disk
Digital Versatile Disc – DVD
Compact Disc (CD)
Magnetic Tape

Slow

Fast

Data 
access 
speed

 Register Memory
Cache Memory
Random Access Memory
Read Only Memory 
Magnetic Tape
Flash Memory
Hard Disk
Digital Versatile Disc – DVD

 

Low

High
Cost

 per Unit 
Storage
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3.7   Coding Systems 
      

Figure 3.15 – Data you enter to the computer and computer data representation

According to the above figure (Figure 3.15), when you enter a data to the 
computer, it converts the data to different patterns made of 0 and 1. Thus, binary 
codes are used when storing numeric, alphabetic, special character, images and 
sounds in internal storage devices of computers.

In the beginning of the lesson, when you type ‘A’ on the keyboard, the 
code you get for ‘A’ is the bits pattern 1000001 (the binary code of letter ‘A’). 
The number of bits used is 7. Thus, a combination made of a bit pattern is used 
to represent each data and the bits used for each code is different. Following are 
different coding systems used.
    
1. BCD  Binary Coded Decimal
2. ASCII  American Standards Code for Information Interchange
3. EBCDIC  Extended Binary Coded Decimal Interchange Code
4. Unicode

3.7.1  BCD - Binary Coded Decimal

This coding system was used in the early stages of computing. In this system 
one digit is represented by 4 bits. This is used only to represent decimal numbers. 
Sixteen symbols (24 = 16) can be represented in this system. The table 3.15 shows 
the BCD codes for the 10 digits from 0 to 9. 
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 Table 3.15 – Decimal Numbers and BCD Values

Decimal Value BCD Value
0

1

2

3

4

5

6

7

8

9

0000

0001

0010

0011

0100

0101

0110

0111

1000

1001

Example
Indicating number 3710 in BCD codes.

 3  7
10

0011 0111

37
10 =  00110111 

Write the BCD values for the decimal values given below.
  
  (i) 302  (ii) 2136 (iii) 17295

Activity

3.7.2 ASCII – American Standard Code for Information 
         Interchange

  
Initially ASCII coding system used 7-bit binary digit. 128 characters can be 

represented using this coding system. ASCII is used to represent text. (Appendix - 
Table 3.17)

ASCII system is designed and approved by ANSI (American National 
Standard Institute). 
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Example
• Text 

When the word ‘School’ is entered into the computer through the keyboard, 
write down how it is understood by the computer. (Use Appendix Table 3.7)

 �  First, write the decimal numbers for the symbols. 

       S   -   83 c  -  99      h -  104     o -  111      l   -  108
 �  Write binary numbers for each value.

S  - 1010011  c – 1100011  h  -  1101000   o -  1101111 
            l - 1101100

 � Write the associated code
               S c h o o l
          101001111000111101000110111111011111101100    

Write down the ASCII code of “ICT” in binary numbers.

Activity

3.7.3  EBCDIC – Extended Binary Coded Decimal Interchange 
 Code

We can write only 128 characters using ASCII system, but the EBCDIC 
code system allows the use of  256 characters. Here, one symbol can be written with 
a binary number which consists of 8 bits. Hence, 256 characters can be represented 
using this system. This system was used in IBM main frame computers. The table 
below shows that there are different EBCDIC codes for the 26 different capital 
letters and 26 different EBCDIC codes for the 26 simple letters in this system.

Table 3.16 – EBCDIC values for English capital and simple letters
Uppercase Lowercase

A

B

C

D

Character In Binary
EBCDIC

1100 0001

1100 0010

1100 0100

1100 0101

In Hexa 
Decimal

In Hexa 
Decimal

C1

C2

C4

C3

Character

a

b

c

d

EBCDIC
In Binary

1000 0001

1000 0010

1000 0011

1000 0100

81

82

83

84
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3.7.4  Unicode System

Though 128 characters can be used in the ASCII system and 256 
characters can be used in the EBCDIC system for data representation. For 
example, these systems cannot be used for Sinhala, Japanese, Chinese and Tamil 
languages as there are more than 256 characters. Hence Unicode system was 
designed according to a standard to represent 65536 different symbols of 16 bits 
(216 = 65536). 

As per the figure given below (Figure 3.16), shows the Unicode system 
can be used to represent Sinhala and Tamil letters, and special symbols and picture 
symbols.

                                            

    Figure 3.16 – Occasions Unicode are used 

Unicode system uses unique number for each number, text or symbol in any 
or Operating System.

Unicodes
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Example
 y Picture and Graphic Data 

Given below (Figure 3.17) is a close up or a highly enlarged image of  
photograph. A photograph consists of pixels (dots) made of different colours in big 
grid. Computer graphic data such as pictures, frames of a movie or frames of an 
animation consist of various colours. The picture given below consists of a number 
of different colours.

  Figure 3.17 – Colours in a picture and their binary values. 

• Sound
As shown in the figure below (Figure 3.17) is the sound emitted from a 

speaker is normally represented as analog waves. However, all data in computer 
are digital data and those are made of bytes. Hence, sound which comes as a analog 
data is converted to a digital data. Thus, a sound is also represented in a bits pattern 
made of 0s and 1s in a computer.  

        

Figure 3.18 – Conversion of analog data of a sound to digital data

3 Sec1 Sec

1

0

(3, 1)
=
0011 0001
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By this coding system, codes are classified to represent characters of all the 
international languages. The institution which initiated is the International Standard 
Institution and Unicode Consortium. Unicode is largely used in designing websites 
and newspapers. (Appendix - Table 3.18)

Activity

1. If ‘A’ character is represented as 1000001 in ASCII system,    
     what is the ASCII code for letter ‘F’?
            
2. What is the largest number presented in BCD (Binary Coded  
 Decimal)?
       
3.   What is the minimum number of bits required to present a 

              hexadecimal number?

4'  If 10000102 represents “B” in ASCII code, what is the ASCII 
            code for l etter “L”?

   5. What are the coding systems used in computers? Explain the    
          need to use such coding systems.

Number systems used for data representation

Number Systems

Binary
Octal
Decimal
Hexadecimal

Number Systems Base Digits
2

8

16

10

0, 1
0, 1, 2, 3, 4, 5, 6, 7
0, 1, 2, 3, 4, 5, 6, 7, 8, 9
0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, 
C, D, E, F

 

 

Summary
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       Appendix

ASCII and EBCDIC codes for characters and related decimal, octal and 
hexadecimal numbers

Table 3.17 -  ASCII and EBCDIC codes for characters and related decimal, octal and hexadecimal 
numbers

Decimal Hex Octal EBCDIC 
Character

ASCII
Character

Decimal Hex Octal EBCDIC 
Character

ASCII 
Character

00 00 000 NUL NUL 128 80 200
001 01 001 SOH SOH 129 81 201 a
002 02 002 STX STX 130 82 202 b
003 03 003 ETX ETX 131 83 203 c
004 04 004 PF EOT 132 84 204 d
005 05 005 HT ENQ 133 85 205 e
006 06 006 LC ACK 134 86 206 f
007 07 007 DEL BEL 135 87 207 g
008 08 010 BS 136 88 210 h
009 09 011 HT 137 89 211 i
010 0A 012 SMM LF 138 8A 212
011 0B 013 VT VT 139 8B 213
012 0C 014 FF FF 140 8C 214
013 0D 015 CR CR 141 8D 215
014 0E 016 SO SO 142 8E 216
015 0F 017 SI SI 143 8F 217
016 10 020 DLE DLE 144 90 220
017 11 021 DC1 DCI 145 91 221 j

 

 

 � Code systems used in computers

Code System Number of Bits Used

BCD   -  Binary Coded Decimal 4

ASCII    -  American Standard Code 
for Information Interchange 
Code

7

EBCDIC- Extended Binary Coded 
Decimal Interchange Code

8

Unicode 16
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018 12 022 DC2 DC2 146 92 222 k
019 13 023 TM DC3 147 93 223 l
020 14 024 RES DC4 148 94 224 m
021 15 025 NL NAK 149 95 225 n
022 16 026 BS SYN 150 96 226 o
023 17 027 IL ETB 151 97 227 p
024 18 030 CAN CAN 152 98 230 q
025 19 031 EM EM 153 99 231 r
026 1A 032 CC SUB 154 9A 232
027 1B 033 CU1 ESC 155 9B 233
028 1C 034 IFS FS 156 9C 234
029 1D 035 IGS GS 157 9D 235
030 1E 036 IRS RS 158 9E 236
031 1F 037 IUS US 159 9F 237
032 20 040 DS Space 160 A0 240
033 21 041 SOS ! 161 A1 241
034 22 042 FS " 162 A2 242 s
035 23 043 # 163 A3 243 t
036 24 044 BYP $ 164 A4 244 u
037 25 045 LF % 165 A5 245 v
038 26 046 ETB & 166 A6 246 w
039 27 047 ESC ' 167 A7 247 x
040 28 050 ( 168 A8 250 y
041 29 051 ) 169 A9 251 z
042 2A 052 SM * 170 AA 252
043 2B 053 CU2 + 171 AB 253
044 2C 054 , 172 AC 254
045 2D 055 ENQ - 173 AD 255 [
046 2E 056 ACK . 174 AE 256
047 2F 057 BEL / 175 AF 257
048 30 060 0 176 B0 260
049 31 061 1 177 B1 261
050 32 062 SYN 2 178 B2 262
051 33 063 3 179 B3 263
052 34 064 PN 4 180 B4 264
053 35 065 RS 5 181 B5 265
054 36 066 UC 6 182 B6 266
055 37 067 EOT 7 183 B7 267
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056 38 070 8 184 B8 270
057 39 071 9 185 B9 271
058 3A 072 : 186 BA 272
059 3B 073 CU3 ; 187 BB 273
060 3C 074 DC4 < 188 BC 274
061 3D 075 NAK = 189 BD 275 ]
062 3E 076 > 190 BE 276
063 3F 077 SUB ? 191 BF 277
064 40 100 Space @ 192 CO 300 {
065 41 101 A 193 C1 301 A
066 42 102 B 194 C2 302 B
067 43 103 C 195 C3 303 C
068 44 104 D 196 C4 304 D
069 45 105 E 197 C5 305 E
070 46 106 F 198 C6 306 F
071 47 107 G 199 C7 307 G
072 48 110 H 200 C8 310 H
073 49 111 I 201 C9 311 I
074 4A 112 CENT J 202 CA 312
075 4B 113 . K 203 CB 313
076 4C 114 < L 204 CC 314
077 4D 115 ( M 205 CD 315
078 4E 116 + N 206 CE 316
079 4F 117 | O 207 CF 317
080 50 120 & P 208 D0 320 }
081 51 121 Q 209 D1 321 J
082 52 122 R 210 D2 322 K
083 53 123 S 211 D3 323 L
084 54 124 T 212 D4 324 M
085 55 125 U 213 D5 325 N

086 56 126 V 214 D6 326 O
087 57 127 W 215 D7 327 P
088 58 130 X 216 D8 330 Q
089 59 131 Y 217 D9 331 R
090 5A 132 ! Z 218 DA 332
091 5B 133 $ [ 219 DB 333
092 5C 134 * \ 220 DC 334
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093 5D 135 ) ] 221 DD 335
094 5E 136 ; ^ 222 DE 336
095 5F 137 _ 223 DF 337
096 60 140 - ` 224 E0 340
097 61 141 / a 225 E1 341
098 62 142 b 226 E2 342 S
099 63 143 c 227 E3 343 T
100 64 144 d 228 E4 344 U
101 65 145 e 229 E5 345 V
102 66 146 f 230 E6 346 W
103 67 147 g 231 E7 347 X
104 68 150 h 232 E8 350 Y
105 69 151 i 233 E9 351 Z
106 6A 152 j 234 EA 352
107 6B 153 , k 235 EB 353
108 6C 154 % l 236 EC 354
109 6D 155 _ m 237 ED 355
110 6E 156 > n 238 EE 356
111 6F 157 ? o 239 EF 357
112 70 160 p 240 F0 360 0
113 71 161 q 241 F1 361 1
114 72 162 r 242 F2 362 2
115 73 163 s 243 F3 363 3
116 74 164 t 244 F4 364 4
117 75 165 u 245 F5 365 5
118 76 166 v 246 F6 366 6
119 77 167 w 247 F7 367 7
120 78 170 x 248 F8 370 8
121 79 171 y 249 F9 371 9
122 7A 172 : z 250 FA 372
123 7B 173 # { 251 FB 373
124 7C 174 @ | 252 FC 374
125 7D 175 ` } 253 FD 375
126 7E 176 = ~ 254 FE 376
127 7F 177 " DEL 255 FF 377
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Table 3.18 – ASCII and EBCDIC values related to letters
Unicode for Sinhala and Tamil letters

Table 3.18 – Sinhala Unicode
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Table 3.19 – Tamil Unicode
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4 Logic Gates with Boolean 
Functions  

In this chapter you will learn about,

² signals used in electronic science
² basic logic gates and combinational logic gates
² representing Boolean expressions using truth tables
² creating  combinational logic gates based on basic logic gates
² drawing digital circuits for Boolean expressions
² Constructing truth tables after writing Boolean expressions for digital   

circuits
² Integrated Circuits
² practical usage of logic gates

4.1   Introduction  

Communication happens in various ways among living beings in day to 
day life. Drumming was used in the past, as a method of communication. Further, 
a railway guard in a station blows a horn waving a green flag to signal that a train 
is going to leave. A green light should be there for the train to start and if it is a red 
light, the signal is to stop.

Usually, two keys are used to open a safe and both keys are needed to open 
it. Before you start a journey in a car, all its doors should be closed properly. If at 
least one door is not closed properly, a light will be on or there will be a sound for 
the driver to signal it. When all the doors are closed, this signal will be stopped. 
Further, you should wear seat belts if you are seated in the front seats of a car. 
Otherwise there will be a signal to indicate this. Thus, as we use signals in our day 
to day life to make decisions, the computer also uses signals.
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Figure 4.1 – Circuit with Basic Logic Gates

4.2   Logic Gates

Circuits which enable building of certain logical conditions using binary 
values and which enable making certain decisions, are called Logic Circuits. The 
Computer is made of a large number of complex digital circuits. These electronic 
circuits are designed as required connecting a large number of basic logical circuits 
called logic gates. 

Central Processing Unit is made up of a collection of a large number of 
logic gates.

The following Figure 4.1 shows a circuit made up of basic. logic gates; 
AND, OR, and NOT.

The function carried out by a logic gate is giving an output considering an 
input or several inputs. 

There are numerous of technical methods to produce logic gates and its 
internal circuit consists of devices such as transistors, diodes and resistors. 

According to the way that the circuits are used, logic gates can be classified, 
into two types. 

1' Basic Logic Gates

2' Combinational Logic Gates   
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4.3   Basic Logic Gates

There are three types of basic logic gates. Those are,

1. AND  gate   

2. OR  gate

3. NOT gate

4.3.1  AND Gate

Let us consider the example given below to understand AND logic.
• If the door of your computer lab is locked with a key and padlock, both door 

key and padlock key are needed to open that door. If both keys are there, you 
can open the door. If either door key or padlock key is used, you cannot open 
the door. Further, if keys are not there, you cannot open the door. 

• Let us consider the simple series electronic circuit given below to understand 
AND operation.

Figure 4.2 – E lectronic circuit when i nput A a nd                                                   
       B value is 0.                                        

Figure 4.4 - Electronic circuit for 
AND logic gate.

Figure 4.3 – Electronic circuit when input 
A and B value is 1.

Q
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A B Q
0 0 0
0 1 0
1 0 0
1 1 1

Table 4.2 – Truth Table for AND 
Logic Gate

Here, the two switches A and B, bulb Q and two batteries are connected in series. 
Let us consider the two switches as input and the bulb as output.

When both switches A and B are closed only, the bulb will be switched on. The 
bulb will not be switched on when either switch A or B is closed. When both switches are 
open, the bulb will not be switched on. 

If Logic 1 indicates both switches are closed and the bulb is switched on (Figure 
4.2) and if Logic 0 indicates when one switch is open and the bulb is switched off (Figure 
4.3), the relationships between AND logic gate inputs and outputs are given below. (Table 
4.1)

  

 

 Here, Q=1 when both A and B input are 
in “1” state only. When either inputs are in “0” state 
Q = 0. This table is called the truth table for AND 
logic gate.

Four states (22  = 4) are shown in the table as this gate consists of two inputs.
Logic of AND gate is “A” AND“B”.  According to Boolean expressions, it 

is represented as A.B

Table 4.1 – Nature of the bulb in the circuit for AND

             A              B            Q

Open Open Switched off
Open Closed Switched off

Closed Open Switched off
Closed Closed Switched on

Observation 

 If at least one input is in "0" state, the output of AND gate is "0".

A

B
Q = A.B

Figure 4.5 - The  Boolean algebra expression and symbol for AND logic gate.
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This AND logic gate consists of a minimum of two inputs and there are 
AND logic gates with more than two inputs.  

Activity  

1. Given below is  an AND logic gate with three inputs;  A, B and C.      
 (Figure 4.6)

The above AND logic gate is equivalent to the circuit given below. (Figure 4.7)
  

        
   

»' Write down P which is the output of the AND logic gate for A and B inputs.

»»' Write down Q which is the output of AND logic gate for P and C inputs.

The value of Q is equivalent to the output of AND logic gate with three inputs 
A, B and C.
Hence, the Boolean expression for this circuit is,

  Q = A.B.C
There are 8 states in the Truth Table related to the above circuit. As there are 3 
inputs, there are 8 states in the Truth Table. (23 = 8)

2.  Fill in the table given below. Fill in column A.B column using the truth  
       table for AND logic gate with 2 inputs. (Table 4.3) Fill in A.B.C subsequently.

A
B
C

Q = A.B.C 

Figure 4.7 – Electronic circuit for AND logic gate with three inputs

A

B

C

P

Q

Figure 4.6 - AND logic gate with three inputs.
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 4.3.2  OR Gate

Let us consider the following example to understand OR logic.

² A bus passenger who is in a two door bus can get down from the front or back 
door.

²  If there are several routes to reach your home, you can use any of these routes,

 Let us consider the simple electronic circuit given below. (Figure 4.8 and 4.9)
 
 Here A and B two switches and Q bulb are connected to two batteries in  
parallel. Let us consider the two switches A and B as input and the bulb as output.

  
 The bulb of this circuit will be 'on' when either A or B switch or both A and 
B switches are closed. This can be tabulated as follows. (Table 4.4)

Figure 4.8 - Electronic circuit when one
logical state of the two inputs is 1        

Figure 4.9 – Electronic circuit when the 
logical state of the two inputs is 0.

 

     A           B           Q
Open Open  Switched  off
Open Closed Switched on
Closed Open Switched on
Closed Closed Switched on

Table 4.4 - Nature of the bulb of the electronic circuit for OR gate

     

A B C A.B   Q=A.B.C
0 0 0   0 ......
0 0 1 ......   0
0 1 0   0 ......
0 1 1 ...... ......
1 0 0   0   0
1 0 1 ...... ......
1 1 0 ......   0
1 1 1 ...... ......

Table 4.3 - Truth Table for AND logic gate with 3 inputs.
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 When either of the switches A or B is "on", it is represented as state "1" 
(Figure 4.7). The state  when both switches are open or the bulb is switched off 
(Figure 4.8) is indicated as logic “0”. This table is called the Truth Table for OR 
logic gate. (Table 4.5)

 When both input of the above OR gate is 0, output will always be 0. Further, 
when all inputs are 0 of an OR logic gate with more than 2 inputs, output will 
always be 0.
 In the above table (Table 4.5), when A=1 or B=1 or both A and B are in state 
"1", Q=1. This table is called the Truth Table related to the OR logic gate. 
 In Boolean algebra, this operation is symbolically represented as “A + B”. 
Note that this is not the addition operation you use in Mathematics to add numbers. 
Further, it is not the plus mark to indicate a plus number. Hence, it represents “A 
OR B”.
 Given below in Figure 4.9 is the Boolean algebra expression related to the 
OR gate and the circuit symbols.

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

Table 4.5 - Truth Table for OR logic gate. 

   Observation

 At least one input should be 1 for the output of OR gate to be 1. 

A

B
Q =A+B

Figure 4.10 - The Boolean algebra expression and the symbol for OR 
logic gate.
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4.3.3  NOT Gate

Following is the logical circuit for AND to get the  Q output from A, B 
and C inputs. (Figure 4.11)

   

 

 1. Write the Boolean expression for this.
 2. Construct the Truth Table to obtain the above output.

A
B
C

Q

A
B

C
Q

Figure 4.11 – OR logic gate with three inputs.

      Activity 

 (      equals)

Let us learn about the complement symbol to understand the NOT gate. The 
task of the NOT gate is to provide the complement as the output. Thus, complement 
of “0” is “1” and the complement of “1” is “0”. 

The NOT gate is the electronic circuit that provides the complement as the 
output of the input. Let us consider the circuit given below. (Figure 4.12)

When the A switch is closed, the bulb is not switched on as no electricity 
runs through. However, when the A switch is open, the bulb will be switched on. 
When the input is A here, the complement of A is the output. In Figure 4.13 is the 
Boolean algebra expression related to the NOT operation and its circuit symbols.

R

Figure 4.12 – Electronic circuit for NOT logic gate.

QA
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Following is the truth table related to the NOT gate. (Table 4.6)
  

4.4   Combinational Logic Gates
                                               

 The function of devices such as  the computer, calculator, washing machine, 
microwave oven, mobile phone, modern televisions, digital clock, air condition etc 
is based on the function of logic gates. There are circuits which are designed  with 
various logic gates to get the required output. Such combinational logic circuit can 
be designed using basic logic gates.

4.4.1  NOR Gate

 The logic gate which indicates NOT OR (i.e. complement operation of the 
OR operation) is called the NOR gate. The logic of the NOR gate is the combination 
of OR and NOT to get the output from NOT after leading the output to NOT from 
OR gate. This can be shown as follows. (Figure 4.14)

The truth table for this can be built based on basic truth tables. (Table 4.7)

A Q
0 1
1 0

Table 4.6 - Truth Table related to the  NOT logic gate.  

Figure 4.13 - Boolean algebra expression related to NOT logic gate and 
symbols.

A Q = A

A

B
 Q = BA+

Q1=A+B

  Figure 4.14 – Electronic circuit for the  NOR logic gate.
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A B   Q1 = A+B Q = A+B
0 0 0 1
0 1 1 0
1 0 1 0
1 1 1 0

Table 4.7 - Truth Table for NOR logic gate based on basic Truth Tables.  

Observation 

When the both inputs of the NOR logic gate is 0, the output is always 
"1". Further, in an NOR logic gate with more than 2 inputs, when all 
those inputs are 0, output is always 1.

Thus, the NOR gate is equivalent to the OR and NOT gates connected 
in series. Following is the Boolean expression for the  NOR gate and the circuit 
symbols.

The logic circuit and the Truth Table related to this are given below. (Table 4.8) 

Figure 4.15 - Boolean expression for NOR gate and the circuit symbols

A

B
Q = BA+

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

Table 4.8 - Truth Table for the NOR logic gate
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4.4.2  NAND Gate 

  Here, the two switches A and B, and the bulb 
Q are connected to a battery. Let us consider the two 
switches as input and the bulb as output. When both 
A and B switches are closed only the bulb is not 
switched on. On all the other occasions, the bulb will 
be switched on. 
  The  logic gate which indicates the 
complement operation of AND or NOT AND 
operation is called the NAND gate. This is equivalent 

to connecting output of AND gate to a NOT gate in series. This can be shown 
as follows. (Figure 4.18)

The logic circuit with output Q and inputs A, B and C is given below. 
(Figure 4.16)

 

 1' Write the Boolean expression for the above.
 2. Construct the truth table.

Activity

A
B

C

A
B
C

Q  = A+B+C
Q  = A+B+C

Figure 4.16 – NOR logic gate with three inputs

Figure 4.17 – Electronic 
circuit for the NAND logic 

gate 

A B

Q

Q = A.BQ1 = A.BA

B

Figure 4.18 - Electronic circuit for NAND logic gate
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Figure 4.19 – Boolean expression and the symbol for NAND logic gate.

A

B
Q = A.B

The Truth Table for this logic based on the Truth Tables related to basic 
gates. (Table 4.9)

The Boolean symbol and expression to represent NAND can be shown as 
follows. (Figure 4.19)

Truth Table for NAND logic gate is given below. (Table 4.10)

A B Q = A.B Q = A.B
0 0 0 1
0 1 0 1
1 0 0 1
1 1 1 0

Table 4.9 - The Truth Table for the NAND logic gate based on basic 
Truth Tables.

A B Q = A.B
0 0 1
0 1 1
1 0 1
1 1 0

Table 4.10  - Truth Table for the NAND logic gate 

When the both (or all) inputs of NAND logic gate are 1, the output is 
always 0.

Observation 
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4.5   Designing Logical Circuits Related to Boolean 
        Expressions

Let us design a circuit with logic gates to get Boolean expression 
Q=A.(A+B)+B.

There are two inputs in this circuit. These are A and B. The logical circuit 
for the above Boolean expression is given below. (Figure 4.21)

Figure 4.21 – The circuit for the Boolean expression Q=A.(A+B)+B 

A

B
Q = A.(A+B)+B

A
A

A+B

B

A.( A+B )

B

The following is the NAND logic circuit with three inputs A, B and C 
with output Q. (Figure 4.20)

1. Write the Boolean expression for this.
2. Construct the Truth Table to get the above output.

Q = A.B.C
Q = A.B.C

Activity

A
B
C

A

B

C

Figure 4.20 – NAND logic gate with three inputs
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 1. Draw circuits for the Boolean expressions given below and 
        construct the related truth tables.     

 (a)  A+A.B
                          (b)  A.(A+B)
               (c)  (A+B).(A.C)

   2. Write Boolean expressions for the circuits given below and  
              construct Truth Tables.     
(a).

(b).

(c).

A
B

Q

A

B
Q

C

 Activity 

A

B
Q
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(d).

(e).

(f).

A B C

Q

A
B
C

Q

A
B

Q

Use Multimedia Logic (MM Logic) software to draw all the logic circuits 
you have learnt in this chapter. Observe the function of the circuit. 
(http://www.softronix.com/logic.html) 

      Activity  
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4.6   Integrated Circuits 

Integrated Circuits (ICs) are used to construct electronic circuits. A complex 
electronic circuit consists of various circuits. For instance, a modern television 
circuit and a mobile phone consist of many circuits. An integrated circuit is a type 
of circuit designed for a certain function with devices such as transistors, resistors, 
capacitors and diodes. Now there are methods to produce circuits in small sizes 
so that one circuit can be packed in one.  Circuits produced in this way are called 
integrated circuits.

As per Figure 4.23, a micro processor is made of a large number of integrated 
circuits which use logic gates.

In these integrated circuits, there are logic gates. For instance, Figure 4.22 is 
a logic circuit which uses an AND gate. Thus, there are integrated circuits designed 
with the logic gates.

In this integrated circuit (Figure 4.22), 1, 2, 4, 5, 9, 10, 12 and 13 pins are 
inputs. 3, 6, 8 and 11 pins are outputs. Figure 4.24 is the external appearance of an 
integrated circuit which consists of 14 pins.   

Figure 4.23 – External appearance of an 
Integrated Circuit.

Figure 4.22 – Logic integrated 
circuit with  AND Logic gate   
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4.7   Practical Usage of Logic Gates

Example 1
Home Alarm System    
 The circuit given below is an alarm system which informs the house owner of 
a theft at home. This is designed using OR gates. This circuit protects two windows, 
the front and back door of the house. When any window or door is opened, an alarm 
system will be on. The logic gates which is connected to windows and doors are 
connected to sensors. Input is "1" when windows or doors are open; input is 0 when 
windows or door are closed. As shown in Figure 4.27, when all the inputs are 0, 
there will be no alarm. 

    

    

Activity
1.  Consider the Integrated Circuit given below. (Figure 4.24)

   

   

   Figure 4.24 – NOR Logic Integrated Circuit

Consider the pins 1, 2 and 3 in the above circuit. If 2 = 0 and 3 = 0, what is the value 
of pin 1?

2.  In the Integrated Circuit given below (Figure 4.34), if pins 1 = 1 and 2 = 1, what 
     is the value of 3?   

   
  
               Figure 4.25 – NAND Logic Integrated Circuit

14

1

13 12 11 10 9 8

2  3 4 5  6  7

14 13 12 11 10 9 8

2  3  4  5  6  71
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 This means all the window are closed at this moment. However, there will 
be an alarm when one input value is 1 or several input values are 1 or all input 
values are 1. This means when a thief opens one window or door or several of these, 
there will be an alarm.  For instance, Figure 4.28 shows the alarm which warns 
the house owner when the first window is opened by somebody. The moments the 
alarm is on like this are shown in Table 4.11. 

0

0

0

0

0

0
0

Figure 4.27 - No alarm when doors and windows are closed

Window 1 sensor

Window 2 sensor
Front door sensor
Back door sensor

1

0

0

0

1

0
1

Figure 4.28 – Alarm on when at least one door or window is open

Window 1 sensor

Window 2 sensor
Front door sensor
Back door sensor

Figure 4. 26 -  Home alarm system

alarm signal

Window 1 sensor

Window 2 sensor
Front door sensor
Back door sensor
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Window 1 Window 2 Front 
Door

Back Door           Occasion

0 0 0 0 0

0 0 0 1 1

0 0 1 0 1

0 0 1 1 1

0 1 0 0 1

0 1 0 1 1

0 1 1 0 1

0 1 1 1 1

1 0 0 0 1

1 0 0 1 1

1 0 1 0 1

1 0 1 1 1

1 1 0 0 1

1 1 0 1 1

1 1 1 0 1

1 1 1 1 1

Example 2

Circuits designed to control street lights.

Following Figure 4.29 is a circuit designed using logic gates to control street 
lights. This is designed using a dark / light sensor, timer and a manual switch. 

There are several occasions when the lights are on. These are,
• When only the manuals switch is closed
• When the input of the timer is 1 and when the environment is dark
• When only the manuals Switch is closed

Status 
open = 0
closed = 1
warning state = 1
no warning state = 0
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When the manual switch is closed, its input is 1. Hence, the light is on.

 When the input of the timer is 1 and when the environment is dark

If the time is in the range of two pre-arranged ranges the input is 1 and 
otherwise 0. This means, the input is 1 when time is from 6 pm and 6 am, and the 
input is 0 when from 6 am to 6 pm. Further, the light sensor will be 1 when there 
is light above pre arranged value and it will be 0 when it is dark. Here, the street 
light will be on when the timer’s input is 1 and light sensor’s value is 0. When the 
environment is gloomy with a rain cloud, the street light will not be on though the 
light sensor’s value is 0 if the time is not between 6 am and 6 pm. 

Street lamp

Figure 4.29 - The circuit to control street lights.

Manual switch

Timer

Light sensor

 Activity 
  A motor car manufacturing company has manufactured a motor car 

protecting circuit to warn if there is a movement in the car when the 
engine is not on or when there is damage to a shutter.  This has three 
sensors to detect whether the engine is on and another sensor to detect 
whether there is a damage to a shutter. Another sensor is there to detect 
whether the car is moving.

  This circuit is designed with three basic circuits. One of these is a 
NOT gate and the other two gates should be included in the empty boxes. What are 
the logic gates suitable for these?

Draw the circuit.
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................

Engine sensor
Shutter damage 

sensor

Movement sensor

alarm signal................

Logic Gate Symbol Boolean Expression Truth Table

OR Q = A+B

AND Q = A.B

NOT Q = A

NOR Q = A+B

NAND Q = A.B

A
B

Q

Q
A
B

QA

A
B

Q

Q
A
B

A B Q
0 0 0
0 1 1
1 0 1
1 1 1

A B Q
0 0 0
0 1 0
1 0 0
1 1 1

A Q
0 1
1 0

A B Q
0 0 1
0 1 0
1 0 0
1 1 0

A B  Q
0 0 1
0 1 1
1 0 1
1 1 0

Summary
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5 Operating Systems

By completing this lesson you will learn,

²   the necessity of an operating system
²   the function of an operating system
²   user interfaces of operating systems
²   services of an operating system
²   types of operating systems
²   advantages of operating systems
²   utility Programmes of operating system
²   drives, folder and files.

 5.1    Introduction to Operating Systems
A Computer consists of hardware, firmware and software. 
Any physical component of a computer system with a definite shape is 

called a hardware. Examples of hardware include: mouse, keyboard, display unit, 
hard disk, speaker, printer etc. 

The booting instructions stored in the ROM (Read Only Memory) are called 
firmware. The initial text information displayed on the screen are displayed by 
firmware.
How the initial operations of a computer are performed
² When the user powers up the computer the CPU (Central Processing Unit) 

activates the BIOS (Basic Input Output System).
 ² The first program activated is POST (Power On Self-Test). Using the CMOS 

(Complementary Metal Oxide Semiconductor) memory this checks all the 
hardware and confirms that all are functioning properly.

 ² After that it reads the MBR (Master Boot Record) in boot drive in accordance 
with the firmware ‘bootstrap loader’ which is provided by the computer 
manufacturer.

² Then the computer loads in the Operating System in boot drive to the RAM 
(Random Access Memory)
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 ² Once this is performed the Operating System takes over the control of the 
computer and displays a user interface to the user.

This whole process is called booting which means that an Operating System 
is loaded into the RAM (main memory).

Software is a set of instructions given to the computer to perform some 
activity using a computer. There are many types of software. They can be broadly 
classified as follows:

Figure -5.1 - Types of Software

Software

System Software
 

Application Software

a) Operating System

b) Utility Software

c) Language Translators

Assembler
Compiler
Interprter

Eg - 
      Word Processing
         Spread Sheets
      Database
      Computer Games
         Web Browsers

5.1.1 System Software

1& System Software - System software are generally divided into three types. They
    are:
  a. Operating System – The Operating System provides for the user 
  to utilize the functions of a computer by managing the hardware 
  and software in it. The image 5.2 below depicts how the system 
  software and application software interact with the hardware.  
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Figure 5.2 – Hardware, System Software, Application Software

Application Software

System Software

Hardware

Mouse
Keyboard

Word Processing Database 

Computer 
Games

Web 
Browsers 

Spreadsheets 

Operating 
System

Utility 
Software

Projector

b. Utility Software – These are used to manage and analyze the software 
in the computer. The utility software differ from the application software 
in their complexity and operational activities. Utility software helps 
in managing the resources of the computer. However, the application 
software function in different to the utility software. There are many 
utility software which dedicated to perform certain functions. Some of 
them are mentioned below:

i. Anti -Virus Software – to protect the computer from   
virus infections

ii. Disk Formatting – to prepare the storage device in    
order to save the files and folders

c'  Language Translators - A computer program (software) is made  up 
by using a set of instruction codes. These instructions are written in 
high level languages which are very close to the human languages. 
These high level languages are translated into machine language (i.e 0’s 
and 1’s) which are understood by the computer by language translators. 
assembler, compiler and interpreter are examples for language 
translators.
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5.1.2  Application Software

The application software which runs on the Operating System is used to carry 
out computer based activities of the user such as creating documents, mathematical 
functions, data entry and, computer games.

 Ex: Word processing, spread sheets, database, computer games,    
    Web browsers

5.1.3  Importance of Operating System

The software which facilitate the interaction between human user and 
hardware is the Operating System. The Operating System provides instructions for 
installation and management of various application software. Not only that the 
Operating System manages all the input, output and computer memory too, which 
means that Operating System is the sole software which manages the whole 
computer system. 

Human User

Hardware

Operating System 

 Application Software

Other System Software

Figure 5.3 -  Interaction between the user and the computer
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5.1.4  Introduction to several Operating Systems  

1. Microsoft Windows Operating System 
This Operating System which was introduced by Microsoft is proprietary 

software which means users have to pay for software license. Nevertheless this 
Operating System very popular around the world and is available in many different 
editions such as: 

Windows Xp, Windows vista, Windows 7, Windows 8 
In addition to the above versions there is a Windows Mobile version which 

is meant to be used in smart phones, tablets etc. There is a server edition called MS 
Windows Server as well.  

2. Apple Mac Operating System 
The Mac Operating System which was developed by Apple Incorporation 

is called Apple Macintosh. This Operating System is also a proprietary software 
which requires payment for license. However, this Operating System can only be 
installed on Apple computers which are manufactured by Apple Incorporation.

3. Ubuntu Operating System
Ubuntu has been developed based on Linux Operating System, This 

Operating System is available free of charge. Hence it is called a Free and Open 
Source Software. We can download Ubuntu free from the URL:  http//www.ubuntu.
com

4. Android Operating System
Android operating system is developed by Google. This is mainly used for 

the mobile devices. This is also a Free and Open Source Software. 

5. Hanthana Linux 
This operating system is developed based on Linux operating system and 

can be downloaded free of charge at www.hanthana.org 
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5.1.5  Types of Operating Systems

The main function of an Operating System is to provide an environment 
suitable for executing the commands issued by the user.  Based on the functionality 
of the Operating System it can be classified as:  

1. Single user operating system
2. Multi user operating system
3. Multi-tasking operating system
4. Real time operating system

1. Single user Operating System 
The Operating System which provides service to one person at a time is 

called a Single User Operating System. 

Example - MS Dos Operating System 

2. Multi-User Operating System
The Operating System which allows multiple users to use a system is 

simultaneously called a multi-user operating system. This type of Operating 
System is commonly used in Mainframe or Server computer where several users 
are connected to a computer system simultaneously. 

Example - Linux, Windows server 

3. Multi-tasking Operating System

The operating system which allows to run multiple process at the same time 
is called a multi-tasking operating system. A single user can run multiple operations 
(tasks) at the same time on this type of operating system.

Example - Windows 7, Windows 8, Ubuntu, Mac Operating System

4. Real Time Operating System 
These are the Operating Systems which gives the output in real time without 

any observable delays. Real Time Operating Systems are mostly utilized in ATM 
end points. Also these kind of Operating Systems are installed in scientific devices 
and small gadgets. These Operating Systems are specifically designed for particular 
devices.

Example - ATM machines, Calculators
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5.1.6  Services of an Operating System

The Operating System is a software which manages the hardware and other 
software in a computer system. It provides services to other software. There are two 
main services performed by an operating system. They are: 

1.  Managing the hardware of a computer
2.  Providing user interface

1)  Managing the Hardware of a computer

Hardware of a computer are managed by using the following processes;
i. Process Management
ii. Memory Management
iii. Device Management
iv. File Management
v. Security Management
vi. Network Management

Figure 5.4 shows the inter connection between resource management within 
computer.

Figure 5.4 - Resource Management

Let us now consider the above mentioned management tasks;
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i. Process Management 
A user can perform tasks using a computer. Consider the example of printing 

a letter. Eventhough we see the printing of a letter as a single process, it is infact 
performed by dividing the whole process into small tasks within the computer. We 
call this small task as a process.

 

Figure  5.5 -  Processes Management

We can call a running computer program or part of the program as a process. 
All the activities in a computer run as either a single process or a multiple processes.

Resource management activities such as allocation of CPU time, allocation 
of memory, and allocation of input output devices of each process are managed 
under the resource management of Operating System.

Odering of the processes (according to a sequence) is also performed under 
management. For example consider keying in some data using the keyboard while 
a document is being printed. The processor has to prioritize which action has to be 
performed first. For an observer it appears that both these actions are performed 
once. Infact, they run as two different processes. Also observe the situation where 
we make some changes to the document which is in print. Do these changes appear 
in that document which is being printed? The answer is "No" because these changes 
which was made after giving the print command do not appear in the printout. This 
proves that the processes within the computer are performed in certain order.
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ii. Memory Management
Memory (We specifically talk about RAM – Random Access Memory) 

plays a major role during the functioning of the computer. The input data are 
stored in the RAM before being transferred to the CPU and the processed data i.e. 
information are also stored in the RAM before being sent to the Output devices. 
Hence systematic management of the memory is vital for the proper functioning 
of a computer. Memory management process makes sure that enough memory is 
allocated for each process and it also makes sure that the memory is freed once a 
particular process ends. 

Figure  5.6 - Memory Management

The Operating System employs various techniques to memory management. 
We must keep in mind that the Operating System utilizes both the Primary Memory 
(RAM) and the Secondary Memory efficiently in order to manage the memory for 
various processes. 

Again consider the example where we type some changes to a word 
document is being printed. Do changes we incorporate to the document are printed? 
No, it does not. Once the command for print is sent the data are sent to the RAM. 
Only those data which is in the RAM would be printed. Those changes we add after 
the ‘print command’ are not printed.

 ² Explain how to find the capacity of Random Access Memory (RAM)
 ² Write down the capasity you use.

  Activity
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iii. Device Management
There are several peripheral devices connected to a computer system. The 

operating system is responsible for the management of those devices. Device 
controllers are used to control the peripheral devices whereas device drivers are 
used to control software components.

Figure  5.7 - Device Management 

For example if you want your newly bought printer to work properly you 
need to install the relevant device driver on the Operating System. If you do not 
install the driver you may not be able to get the full features of the Printer (such as 
printing on both sides of the paper, etc).

Today there are devices which work once they are connected (plug and 
play). The relevant device drivers are installed automatically once the device is 
connected to the computer for the first time. Therefore nowadays the process of 
installation of the device driver has become easy.

When you connect a printer to a computer, the Operating System 
installs the relevant device driver automatically. When it does not 
install automatically we need to manually install it. Find out and write 
down the steps on how a device driver is installed in your Operating 
System.

 Activity Activity
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iv. File Management
We can save data in files and we keep the files within the folders in order to 

manage methodically. The Operating System to manage the files and folders.

      Figure 5.8 - File Management 

Some of the services performed by the Operating System in file management 
are listed below:

•   Making new files and saving them at suitable places
•   Deleting the unnecessary files
•   Arranging the folders in order and deleting the unnecessary folders
•   Renaming the files and folders
•   Changing the storage location of files and folders
•   Creating backups of the files and folders as needed

Figure  5.9 - File Management

File and folder management includes handling file properties, file operations, 
file access and file systems.
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1. There are many properties of a file/folder. Write down how you can 
find the properties of a file/folder and write down the properties.

2.   Write down the names of the Operating System which uses the
   following file types;

• FAT16 
• FAT32
• NTFS
• ext4
• ReiserFS

3.   Explain the following two methods used for accessing the files using the
        Figure 5.10:

• Sequential Access
• Random Access

  Activity

Figure 5.10 - Sequential Access and Random Access

v. Security Management

There are many security threats to a computer. For instance, Malicious 
Software (Malware) such as a virus could harm the smooth functioning of a 
computer. There could be other threats such as deletion or destruction of data/
information by unauthorized access to the system. 

Protecting the computer from these kind of attacks also managed by the 
Operating System up to some extend. Various kinds of techniques are used by the 
Operating System to perform function.
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 1. List out and explain each of the methods used by Operating System 
to prevent and control unauthorized access.

2. As Operating System cannot control or mitigate all the threats 
brought in by external malicious software. An Operating System gets 
the support of external (third party) software for this purpose. List 
out all the threats which are difficult to be controlled by Operating 
System alone and write down the names of different software which 
can be used against each of those threats.

  Activity

vi. Network Management
Operating Systems support different types of network connectivities. They 

support wired and wireless connectivity for hardware devices in the system such as 
computers, printers, scanners that exist in the network. 

The Operating System also helps in accessing one computer from a remote 
computer. A computer network facilitates from simple text communication to a 
multimedia data communication. Today data communication is utilized at a greater 
scale in networks. This concept is well demonstrated by Cloud Computing. 

 
Figure 5.11 - Computer Network Management

2. Providing user friendly interface

We need an interface to interact with the computer. An Operating System 
provides a user interface to input commands and instructions in a user friendly 
manner. Using this interface, we can perform tasks without using complex 
instructions.

There are two types of user interfaces provided by the Operating Systems. 
They are:
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1. Command Line Interface-CLI
2. Graphical User Interface-GUI

The following section discusses in detail about each of the above interfaces.

1. Command Line Interface (CLI)
This kind of interface was used by all the Operating System systems of the 

early days. This interface had a ‘prompt’ where the commands are keyed in using a 
keyboard. In using command line interface, the correct syntax has to be used. 

command

Output

Cursor
Command
Prompt

Figure  5.12 - Command Line Interface

1.  Explain how you can obtain the CLI of the Operating System you use.
2.  List out a few commands used in CLI and the function performed 
     by these commands.

    Activity 

2. Graphical User Interface (GUI)
Almost all the present day Operating Systems use graphics on their 

interfaces. This GUI provides the ability to use the mouse or finger tips to navigate 
the commands. Therefore it has become much easier to interact with the computers 
today. 

These Operating System with GUI uses four components in order to make 
a friendly environment. These components are abbreviated as WIMP. WIMP stand 
for;

1. Windows
2. Icons
3. Menus 
4. Pointer



              For free distribution 143

Menus Pointer

icons

Windows

  

   

Figure 5.13 – Graphical User Interface 

  
1. Write down all the components of two different windows in the 

Operating System that you use.
2. Name all the icons in your desktop
3. Explain how you use the options in two menus of two applications 

that you use. 
  4. There are different shapes (styles) for the mouse pointer. List few 

shapes of the mouse pointer. Explain how you can change the shape 
of the mouse pointer.

  5. Write down the advantages and disadvantages of using the finger 
point against the mouse pointer of an Operating System.

  Activity

The utility programs in an Operating System
Several processes are performed by the Operating System for the functioning 

of the computer. Many utility programs are available in the Operating System for 
the functioning of the machine as well as to protect from security threats. In the past 
we had to buy different utility programs and install whereas nowadays most of the 
required utilities come with the Operating System.
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There can be many types of utility programs in an Operating System:
• Backup Software - To copy files and take back up of hard drives
• Disk scanner - To check the errors in hard drive
• Disk defragmentation - Organizing the hard disk by rearranging clusters of small 

spaces together and creating a larger free space. This increases the efficiency of 
the hard disk.

• File/data compression - Compression of larger files into smaller files 
• Task Manager - to display information regarding the processes and programmes 

in a computer and the general status of the computer
• System diagnosis tools - to monitor errors in hardware and software of a 

computer or network of computers and diagnosis of system errors.  
• Anti-Virus Software - Protecting the computer by identifying and eliminating 

malicious software
• Clipboard - temporary storage of data/files for cut/copy and paste operations
• Data synchronization software - to establish consistency among data from a 

source to a target data storage and vice versa
• Disk partitioning software - can divide an individual drive into multiple logical 

drives
• Screensavers - for blanking the screen or filling it with moving images or 

patterns when the computer is not in use. 
• System profilers - to provide detailed information about the software installed 

and hardware attached to the computer.
• Network utilities - to analyze the computer's network connectivity, configure 

network settings, check data transfer or log events.

In the following section details of some of the utilities in an operating 
system are given:

• Disk Partitioning
• Disk Formatting
• Defragmentation

Disk Partitioning
What is a Partition?

By default there will be only one physical drive in a hard drive.  But this 
drive is normally divided into many logical partitions. This process of dividing an 
individual drive into multiple logical drives is called disk partitioning.

Normally partitioning is performed at the time when a hard disk is configured 
for the first time. Partitioning could also be performed when a new hard disk is to 
be added or when an existing hard disk is replaced with a new hard disk.
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We may need to change the existing partition. When an already partitioned 
hard disk is partitioned again, all the data in that hard disk would be deleted. 
Therefore, it is necessary to keep it a point to keep a backup copy of the existing 
data before partitioning again.

The following image depicts how a hard disk would look before and after 
partitioning.

          Figure 5.14 - Hard Disk – before and after partitioning

Why do we need partitioning?

There could be many reasons for undertaking partitioning. Below are some 
of the reasons for partitioning.

• When we need to save different items in different places. (Ex: Software in one 
drive and all other data in another drive).

• When we need to have more than one Operating System in the same machine. 
(Ex: When we need to install both Windows and Ubuntu Operating System)

• To meet the requirement of the Operating System (Ex: Sometimes it becomes 
mandatory that a separate partition is allocated for the Operating System) 

We can see each of the divided partition as separate drives. In Windows 
environment, it is a customary to name the first drive as C: drive and go on. This 
means that the First partition becomes the first drive and would be named as C: 
drive and the second drive would be named as D: drive and so on.

Note: In windows environment, Multimedia drives (DVD, CD), flash drives etc. 
which are connected to the computer would be identified as ‘Drives’ and they 
would be named using an English letter after C (after partitioning the hard disk).
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However, in Linux environment all the partitions, multimedia drives, 
flash drives etc. would be identified as individual folders (in Linux they are 
called Directories). Therefore it cannot be seen drives named C: D: etc in Linux 
environment.

Disk Formatting

A hard disk cannot be used once partitioning is completed. We need to 
format each of the drives individually. 

Formatting is the process of preparing a data storage device such as a hard 
disk drive, solid-state drive, floppy disk or USB flash drive for storing data. This is 
done using a file format in the Operating System. 

The USB Flash Drives come pre-formatted so that they can be put into use 
directly. 

We can format hard disk drive, solid-state drive, floppy disk or USB flash 
drive whenever need arises. Every time we perform formatting the data in the drive 
would be deleted. Therefore it is necessary to keep back up copies of the data before 
formatting.

Once a hard disk is partitioned and formatted we can start saving data on it.
Usually a hard disk is partitioned and formatted before installing an 

Operating System for the first time. After the first time the need for partitioning or 
formatting could arise very rarely. 

You can see in the image below how a hard disk would look like after 
partitioning and formatting.

    

  
Figure 5.15 – Har Disk – before and after partitioning and formatting

Before partitioning After partitioning After formatting



              For free distribution 147

Defragmentation
The following shows the defragment in Windows. Sometimes a file (which 

is larger in size) may not be stored as a single track in the hard disk. This process 
where a single file is broken into different pieces and stored in different parts of the 
disk is called fragmentation. 

    Figure 5.16 - How a file is stored in different places of a disk

The Operating System splits a file into several portions and saves them 
in different places in the disk especially when a saved file becomes larger due to 
multiple editing. Further, the empty spaces that are created in the disk due to the 
deletion of files is used to save new files which causes fragmentation. 

It takes longer time to read a file when a file is defragmented and saved in 
different places in the disk. It affects the efficiency of the computer. 

If you observe a slowness of the machine (there could be many reasons for 
the slowness of the computer, whereas fragmentation could be a one reason) the 
best action to take would be to start defragmentation.

Disk defragmentation is the process of rearranging the fragmented data on 
a volume (such as a hard disk or a storage device) so it will work more efficiently. 

    

Figure 5.17 - Before Defragmentation             After Defragmentation

However Linux based Operating Systems use a different method to store 
files. Linux Operating System makes sure that ample space is left between the 
saved files so that they can be saved at the same location as a single intact file even 
when the file expands due to editing. Therefore there is very little possibility for 
fragmentation to happen. It is also because Linux based Operating Systems have 
the ability even to relocate the file in a new place if the file exceeds its allocated 
memory space. Therefore there is no need for ‘defragmentation utility’ in Linux 
based Operating Systems.
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 5.2    Introduction to File Systems

Computer is a machine which allows for storage of large volumes of data 
while facilitating the quick retrieval of those saved data when we need. The data we 
save must be given a file name for the purpose of identification. There are many file 
names used in the storage media which are relevant to a partuclar Operating System
and Application Software. But all these file names consist of two components, 
namely file name and file extension. However the file extension are hidden to the 
user by the Operating System by default.

5.2.1  Finding out the File Extension 

Start  Control Panel  Folder Options View  Hide Extensions for 
known File types (See Figure 5.11)   untick it  Then click OK.  

Figure 5.18 - Details of a file
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Now double click on any folder. Then we can view file extensions of any file. 

File name Symbol that separates file 
name and extension -  

fullstop(.) 

Extension

Figure 5.19 - - Window to set up display of file extensions

Note: The Operating System identifies the file type using the file extensions. 

There are many file extensions in use. Some of them are listed below:

                 File Extension           File Type
 exe Executable
docx Word
xlsx Excel
pptx PowerPoint
accdb Access

A file name and a location are given when saving a file in the computer. The 
Operating System maintains many other information relevant to the file. 

Type of file
Size of the File
Saved Date and Time

To view these data, right click on a particular file and then click on 
‘properties’ from the list that appears.
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Figure 5.20 - Viewing details of a file 

Size of the file

Location where the file is 
saved

The date and time when 
the file was saved.

The memory allocated 
by the storage to save 
the file

Selecting a location to save a file 
A location is used in the storage space to save a file. It is called a drive. The 

previous section detailed that several drives can exist after partitioning.

Drives
By default a computer uses the hard drive to save. If the hard drive is not 

partitioned then it would be labelled as C: drive. If the hard drive is partitioned then 
the partitions could be named in order as   [C:], [D:], [E:] etc. 

If there are other storage media such as CD, DVD or Blue Ray Disk drives 
in a computer then these drives are given different letter names. For example if the 
hard disk is partitioned into four separate partitions then they would be labelled 
[C:], [D:], [E:]and [F:] drives whereas a CD, DVD or Blue Ray Disk drive would 
be named as [G:] drive.
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In the same manner when a pen drive is connected to the computer the new 
drive would be labelled as [K:] drive.  

If you want to see the number of drives in a computer, observe the following 
steps: Open the icon “Computer”. Now you can see, the externally connected drives 
such as Blue Ray Disk drives and pen drives are shown as devices with removable 
storage.  

Figure 5.21 - - Viewing the drives

Even though we use the drives to store the files, in general they are not 
directly stored to the drive. Usually we create a folder in a drive and then store the 
file it in. We should give a name to the folder in order to identify the folders too. 
Creating a Folder 

1. Select the drive where the folder to be created.
2. Now select 'Folder' under 'New' in 'File Menu' or 'New folder' under   
   'Tools'.
3. Provide a suitable folder name

Managing files and folders
We have to perform many activities using the files and folders in a drive. 

1. Copy and paste of files/folders
2. Select the file/folder to be copied
3. Select copy (Edit → Copy or Ctrl +C)
4. Select the destination drive or folder
5. Select  paste (Edit → Paste or Ctrl + V)
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Cut and Paste of files/folders
1. Select the file/folder to be cut
2. Select  to cut (Edit → cut or Ctrl +X)
3. Select the destination drive or folder
4. Select paste (Edit → Paste or Ctrl + V)

Renaming a file/folder
1. Select the file/folder to be renamed
2. Select to rename under File menu
3. Key the new name and Enter

Deleting a file/folder
1. Select the file/folder to be deleted
2. Select to delete under File menu or use Delete key on the Keyboard
3. Click ‘Yes’ in the dialog box that appears.

Then the deleted file/folder would be placed in Recycle Bin temporarily.

Figure 5.22 - Delete Dialog box

Restore a Deleted file/folder

1.Open Recycle bin
2.Select the file/folder to be restored
3.Click Restore under File menu

 ²  Operating System is essential for Operating a Computer.
 ² All the Application Software in the computer runs on the Operating System.
 ² The User Interface functions as the facilitator between the computer and the 

user.
 ² The GUI is convenient to the user than the CLI.
 ² The types of Operating System are: Single User, Multi User, Multi-tasking 

and Real Time User.
 ² The Operating System which provides service to one person at a time is 

called a Single User Operating System.
 ² The Operating System which allows multiple users to use a system is called 

a Multi User Operating System.
 ² The Operating System which allows to run multiple process at the same 

time is called a Multi-Tasking Operating System.
 ² The Operating System helps in managing all the resources of a computer.

The hard disk is partitioned and formatted before installing an Operating 
System.

 ² A file consists of a File Name and Extension
 ² Folders are used to save files
 ² In order to save the files the user creates folders inside the drive.

  Summary
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Cut and Paste of files/folders
1. Select the file/folder to be cut
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1. Select the file/folder to be deleted
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Restore a Deleted file/folder

1.Open Recycle bin
2.Select the file/folder to be restored
3.Click Restore under File menu

 ²  Operating System is essential for Operating a Computer.
 ² All the Application Software in the computer runs on the Operating System.
 ² The User Interface functions as the facilitator between the computer and the 

user.
 ² The GUI is convenient to the user than the CLI.
 ² The types of Operating System are: Single User, Multi User, Multi-tasking 

and Real Time User.
 ² The Operating System which provides service to one person at a time is 

called a Single User Operating System.
 ² The Operating System which allows multiple users to use a system is called 

a Multi User Operating System.
 ² The Operating System which allows to run multiple process at the same 

time is called a Multi-Tasking Operating System.
 ² The Operating System helps in managing all the resources of a computer.

The hard disk is partitioned and formatted before installing an Operating 
System.

 ² A file consists of a File Name and Extension
 ² Folders are used to save files
 ² In order to save the files the user creates folders inside the drive.

  Summary
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6 Word Processing

 6.1 Word Processing 
 

Your school principal has informed you that this year’s Art Festival is going 
to be celebrated. The assigned task of your team is preparing necessary documents 
for the arts festival.

Accordingly you have to;    
letters

Reports

invitations

certificates

 ² Design invitations
 ² Prepare letters to the parents
 ² Design certificates

These documents should be well prepared and printed. After drafting 
the above documents, you now want to find out the best method of document 
preparation.

 “We will prepare hand written invitations”, was one of the suggestions.

This chapter covers the following; 

² word processing 
² benefits of a word processing software
² creating a document
² formatting of document
² adding clip arts and charts to a document
² opening and closing files
² mail merge
² printing a document
² shortcut keys 
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“Good idea, but it’s difficult to write in a similar size and a similar way. So we’ll 
use the type writer in the library”, was another suggestion.

“We should find attractive types of letters and  add pictures. A border will give 
a good finish. A typewriter won’t provide such facilities, will it?” Everybody is 
confused. You need to find a solution for this problem.

We often use different types of documents in our day-to-day activities and 
preparing these documents in different styles is called word processing. In order 
to avoid the shortcomings of preparation of pen or pencil in based documents, 
typewrites were used in the early days. Even though such typed documents were 
better than the hand written documents, manual typewriters do not allow functions 
such as formatting, saving, printing in required sizes. 

The computer is the best machine for such an activity. A word processing 
software can provide the following faclities;
 ² Creation and editing
 ² Insert objects such as images
 ² Saving and retrieving
 ² Print preview and printing
 ² Spell checking and grammar
 ² Find and replace 
 ² Mail merge

6.1.1  Word Processing Software

Several popular word processing software are available. Some need to be 
purchased and some are Free and Open Source Software (FOSS). 

Given below are some of the word processing softwares. You can find more 
information about those softwares from their websites.
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         Name of the software            Producer
AbiWord Source Gear Corporation
FrameMaker Adobe Systems Incorporated
iWork Pages Apple
Kingsoft Office Writer King soft
Libre Office Writer Open Office Writer
Microsoft Office Word Microsoft Corporation
Open Office Writer Apache Software foundation 

(Open Source  Software)
Word Perfect Corel

The user can create documents using internet as well if the computer does 
not have a Word Processing software. For this the user can use cloud computing. 
There are many advantages of using cloud computing such as;
² The user does not have to install a word processing software on the computer
² The user does not have to allocate space to install software in the hard disk
² To save the document, internet itself provides facilities for space.
² The user can open or edit the document from any computer which has internet 

facility
  Example - Google Docs, Windows 365

In addition, smart phones and tablet PC’s are used for Word Processing 
today and word processing software is available for this purpose. 
Eg: Documents To Go, Google Docs, Kingsoft Office, Polaris Office etc.

Now we will learn how to use a word processing software to prepare 
documents. 

This chapter explains two word processing software which are commonly 
used today. Further,  some topics and tools which are common to other software are 
also discussed.



              For free distribution 157

6.1.2  Running a Word Processing Software

These lessons are presented based on Microsoft.   

   Microsoft Office Word  2010
       Start → All Programs → Microsoft Office → Microsoft Office Word 2010 
                  (This could be different depending on the operating System)

The graphical user interface of a Microsoft Word 2010 software is shown 
in figure 6.1 

Figure  6'1 - Microsoft Office Word  2010

1' Title Bar  - (Figure 6.2) The top most bar on a Microsoft Office 2010 window 
is the Title Bar. The name of the opened document will appear here. A new 
document is shown as Document X and ‘X’ is the document number. Window 
Minimize button, Minimize/Restore button and the Close buttons are located in 
the top right hand side.

in figure 6.1 

7' Zoom Control

5' Status Bar

Veiw Ruler Buttons

Browse Buttons

View Buttons

 2' Ribbon{

4' Dialogue Box Launcher

1' Title Bar

    Tabs

6' Scroll Bar

3' Quick Access Tool Bar

the top right hand side.

Figure 6.2 – Title Bar
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2' Ribbon – Ribbon is a special feature of Word 2010 windows. Features of this 
(File, Home, Insert etc) are called Tabs. The special feature of the ribbon is that 
the items are shown as Icons, so their functions are clear. Facilities are there 
for the users to adjust these tabs according to their wishes. Moreover, ribbon is 
divided into several classes. (Clipboard, Font, Paragraph, Styles, Editing, etc.)

Some features of the Home Ribbon (Figure 6.3):

1.  Bold  
2.  Italic   
3.  Underline 
4.  Subscript  
5.  Superscript 
6.  Font color  
7.  Alignments  
8.  Line spacing
9.  Shading  

3' Quick Access Tool Bar (Figure 6.4)  - This is always placed above the Ribbon 
and can be placed below the Ribbon. Quick Access Tool Bar contains quick 
commands such as opening a new document, saving or opening a document, 
Zooming, Undo, Redo, etc and this can be adjusted according to the user’s 
requirements.   

Figure 6.3 – Home Ribbon
1 2 3 4 5 6 7 8 9 10

17
16 15 1314 12 1118

10.  Border  
11.  Sort  
12.  Indentation 
13.  Numbering 
14.  Bullets  
15.  Change case 
16.  Grow font  
17.  Font Size   
18.  Font Name  

Figure 6.4 - Quick Access Tool Bar

Save

   Zoom

Redo
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4' Dialogue Box launcher Figure 6.5 - Dialogue Box launcher shows additional 
tools. Dialogue boxes can be opened by clicking the arrow at the right hand side 
of the group name. Apart from the tools which appear in the Ribbon, Dialogue 
boxes provide several other useful tools in document preparation.   

5' Status Bar (Figure 6.6) - This is at left bottom of Microsoft Word window.  
This shows the number of pages and words of the document, language used, 
view buttons, etc. Further, status bar can be used to add slight changes to the 
document.

6' Scroll Bar - used to go up and down of the document.            

7' Zoom (Figure 6.7)  - Zoom can adjust the size of the pictures on the screen. 
This does not affect the original document and zooming is performed as per the 
wish of the user.  Zooming is used to check the quality of the document while 
editing.

To learn the tools which are not explained here, position the mouse pointer 
on tool to see the Tool Tip.

 Font type Dialogue box: This 
is opened by clicking the Dialogue box 
launcher of the Font group. (Figure 6.5)

  Figure 6.5 – Font type dialogue box       

 Figure 6.6 – Status Bar 

 Figure 6.7 – Zooming
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 LibreOffice Writer 4.1
Start → All Programs → LibreOffice Writer (This could be different depending on 
the operating system.)
Figure 6.8 shows the graphical user interface of LibreOffice Writer software.

   

1' Title Bar (Figure 6.9) - This is top most bar of Libre Office Writer window. 
This shows the name of the opened document. A new document is shown as 
Untitled X and ‘X’ is the document number.   

2' Menu Bar - This is positioned below the Title Bar. The features available here 
are respectively File, Edit, View, Insert, Format, Tables, Tools, Window, and 
Help. When one function is selected, the relevant submenu for that will be 
opened and the available features of the submenu can be selected as per your 
wish. 

   Figure 6.10 – Menu Bar

² If ‘File’ menu is selected, the submenu will show options such as opening a new 
document, opening or saving a document, closing a document, etc.

² By opening ‘…’ of the submenu, dialogue boxes can be selected. Figure 6.11 
² By using right hand side arrows of the submenu, another submenu can be 

opened. Figure 6.11  

 Figure 6.8 – Libre office Writer

2' Menu Bar

4' Formatting Tool Bar
3' Standard Tool Bar

5' Status Bar

6' Scroll Bar

7' Zoom Control

1' Title Bar

         Figure 6.9 – Title Bar
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   Figure 6.11 - Submenu

Three dots

Righ hand side arrow

Tool bars - The bars positioned below Menu Bar of LibreOffice Writer window 
are tool bars. The Standard Tool Bar and Formatting Tool Bar will appear when 
the Writer window is opened and the opening or closing of the other tool bars 
can be done as per user requirements. For this, open ‘View’ menu, and then 
‘Toolbars’ of submenu. The user can close the toolbars appear on the submenu.

3' Standard Tool Bar (Figure 6.12) – This contains commands in the form of 
Icons.

 Figure 6.12 – Standard Tool Bar
1 2 53 4 6 7

14 13 12 11 10 9 8

1'  New   

2'  Save
3'  Page Preview
4'  Copy
5'  Redo

11' Cut
12' Spelling and grammar
13' Print
14' Open

6'  -Table
7'  Help
8'  Gallery
9'  Undo
10' Paste
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4' Formatting Tool Bar (Figure 6.13) - This contains a several letter formatting 
methods which can be used in documents. The commands appear in the form of 
Icons.

1'  Apply style  
2'  Font
3'  Font size
4'  Bold

 

5' Status Bar - This is positioned at the left bottom of the Writer window and 
displayed the number of pages, words, the language used, zooming, etc. 

6' Scroll Button and Scroll Bar - used to go up and down of the document.

7' Zoom - This allows to change the scale of the pictures that is displayed on 
the screen. Zoom does not affect the physical document and the scales can be 
adjusted by the user. Zooming is also used in editing to check the finishing 
quality of the document. 

To learn the tools which are not explained here, position the mouse pointer 
on the tool see the Tool Tip.

    Figure 6.13 – Formatting Tool Bar

1 2 53 4 6 7

12 11 10

98

7'  Numbering
8'  Indentation 
9'  Background color
10' Font color
11' Bullets
12' Italics

5'  Underline
6'  Alignment
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 6.2   Let us discuss some important things in preparing  
  a new document.  

Step 1 - 
      

 

    
    

Step 2

 Saving the Document  
It is essential to save the document in a 
proper place with a proper name.  This 
enables the user to find the saved document 
easily.

It is essential to save the document in a 
proper place with a proper name.  This 
enables the user to find the saved document 

Step 3

Saving the file by another name                                     
Once the user save the document by giving 
a name, it is called  ‘File’. The user can 
save the file by another name in another 
place. Then the user will get two files by 
the existing name and the new name. Since 
files are saved with a file extension, it is 
easy t o fi nd t hos e a gain.                                                                                                              

 (file extension)
   MS Word 2007$ 2010  -  .docx
   MS Word 97-2003     -  .doc
   LibreOffice Writer      -  .odt

Select File  → Save as

 ² Select a Saving Location from ‘Save  in’
 ² Type a proper name for the document in 

‘File name’ 
 ² Click Save button

For this…

Opening a new page
  Even though there is a new page when Word software is open, the user   
   has to get a new page for another document. 

For LibreOffice Writer ...

 File→New (Ctrl+N)→Text Document  

For Microsoft Word ... 
 

   File → New → (Ctrl + N) → Blank  
   Document   

Select File → Save (Ctrl + S)
 ² select a saving location using 

‘Save in’  
type a proper name for the 
document in ‘File name’

  ² click ‘save’ button
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Step 4

Closing the document

It is wise to close the document till it is 
used again. Unwanted, opened files will be 
a disturbance for the computer. Select  ‘File  → Close’

For this...

Step 5

  Opening the document

The user may need to open a file saved in 
the computer or in a different medium.

• Select ‘File  → Open’ (Ctrl+O)
• Select the saved file in the ‘Look 

in’ location in the open dialog 
box.

• Select the document from the 
window

• Click ‘Open’ button.

For this...

Step 6
Saving a document using a password

Saving a file with password provides security. Hence other cannot 
open the document. For this;        
             

If it is Microsoft Word;

•  Select ‘File → Save’
•  Select a suitable saving location from 

‘Save in’
•  Type a suitable name for the document
•  Select ‘tools’
•  Select ‘General Options’
•  Type a password in the ‘password to    

 open’ box in order to open the word file.
•  Click ‘Ok’
•  Type the same password in the ‘Re-enter  

 Password to open’ box
•  Click ‘save’ button.

If it is LibreOffice Writer;

• Select ‘File → Save’
• Select a suitable saving location from 

‘Save in’
• Type a suitable name for the document
• Click on the box ‘Save with a 

Password’
• Click ‘save’ button
• Type the password to open the file in 

‘Set Password’ dialog box
• Type the same password in the second 

box and click 'Ok' button.
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figure 1: Activity

     Activity

Open the word processing software. Perform the following;

      1. Type the paragraph in activity figure 1. Save the document  
               as “Assign1” in your folder. Close the document.

            2.   Open “Assign1” file. Save it in your folder as ‘Assign2’ in. Now      
                    close the document.

Word Processor
A word processor, or word processing progrm, does exactly what the name 
implies. It processes words. It also processes processes paragraphs, and entire 
papers. Some examples of word processing programs include Microsoft Word, 
Word perfect (Windows only), Apple Works (Mac only), and Open Office.org.

 6.3      Preparing a Document

6.3.1  Page Setup
The first step in document preparation is to use page setup.  

  

  

 

  

  

  

There are common Page Setup tools available in Word Processing software. 
You can select paper size and format as per international standards. (A4, A5, B4, 
Letter) These sizes can be adjusted according to the user’s requirements. User can 
adjust ‘Orientation’ and  ‘Margins’.
There are two types of Orientation Portrait       and Landscape 

For Microsoft Word…                                   
  

Use ‘Page Layout  →  Page Setup’                      

For Libre Office Clac…

Use ‘Format → Page’ and ‘Page’ 
Dialogue Box
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6.3.2  Formatting

Formatting can be performed after or before typing a letter or document. 
This adds clarity and attractiveness to the document.

6.3.3  Methods of Selection

A document contains different features such as letters, words, shapes, 
images, tables, etc. User may make changes to these. User have to select the item 
before modification. Following are some of the methods.

A letter or letters Drag the Mouse across the letter(s)
A word Double click the mouse on that word 
A few words Select the first word you need to change, keep the 

mouse pointer there and drag till the last word
A sentence Click on the first word of the sentence and drag till the 

last word
A row Drag the mouse till you see a right arrow which is 

white. Click it once.
A paragraph • Click the mouse thrice on the paragraph

• Or click the first word of the paragraph and drag till 
the last word

A document • Press Ctrl + A on the key board
• Drag the mouse pointer till you see a right arrow 

which is white. Then click it thrice

6.3.4  Text Formatting 

User is able to perform the following;
1. Change Font Size.
2. Change Font Style - Make letters 

Bold or Italic.
3. Underline letters. 
4. Use different types of fonts in  

different languages.
5.   Change font colour.

Figure 6.14 – Formatting
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   F or Microsoft Word…                        
  
• Select your letters or paragraphs          
• Click on the required tools of              

Home → Font. Or                                
• Open Font Dialogue Box                    

Further, mind that you can make use of 
several tools at the same time.                         

For LibreOffice Writer…
 
• Select your letters or paragraphs
• Use Formatting Tool Bar
• Click on the necessary formatting 

tools or 
• Open ‘Format → Character’ Dialogue 

Box

Further, mind that you can make use of 
several tools at the same time.

Open the Word Processing software and perform the following.

 1' Prepare your page as follows.

Size – A4 Orientation 
Landscape

Margins – 2’ from left and 
right
1.5’ from top and bottom

Use ‘Page Setup’ Dialogue Box.

Type paragraphs on Activity 2. Save that document in your folder as ‘Assign2’. 
Close the document.

2'  Open ‘Assign 2’ file. Format the document  as in  activity 3.  Then save it in     
     the folder as ‘Assign3’. Close the document.

     Activity

Activity 2

What is a computer?

A computer is an electronic device that manipulates information 
or data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.
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6.3.5 Paragraph Formatting

Alignment (Figure 6.16) 

      

6' Left Align    

7'  Center Align   

8'   Right Align  

9'  Justify   

 Figure 6.15

Activity 3

What is a computer?
A computer is an electronic device that manipulates information or 
data. It has the ability to store, retrieve and process data.

You can use a computer to type documents, send email and browse 
the Web. You can also use it to handle spreadsheets, accounting,  
database management, presentations, games and more.
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● Indentation (Figure 6.16 and 6.17)

10.  Left Indentation    

11.  Right Indentation        

12.  First Line Indentation

13.  Hanging Indentation

14.  Line spacing

15.  Paragraph spacing 

Figure 6.16 – Indentation

 
Figure 6.17 – Indentation

 

10

12

  Computer is an electronic device 
  which accepts data, processes
  and produces desired
  information.

The computer memory refers to the 
storage area of a computer where all 
the data and instructions are stored. 

 The storage capacity of the computer 

memory is expressed in terms of bits and bytes. The more 

memory a computer has, the more memory it can store.

 Computer hardware is the collection of physical lements 
 that constitutes a computer system. 
 Computer hardware refers to the physical 
 parts or components of a computer such as 
 the monitor, mouse, keyboard,

 13
 

11
 

Computer hardware is the collection of 
physical elements that constitutes a computer 
system. Computer hardware refers to the 
physical parts or components of a computer 
such as the monitor, mouse, keyboard, 
computer data storage, hard drive disk (HDD) 
etc...

Software is any set of machine-readable 
instructions that directs a computer's 
processor to perform specific operations. A 
combination of hardware and software forms a               

 

 

14

15

For Microsoft Word...         
                    

Select your words or paragraphs                      

• Click on the formatting tools you need 
on ‘Home → Paragraph’   

 Or 
• Open ‘Paragraph’ Dialogue Box 
• Select the tools you need there 
• Click ‘Ok’                                               

For LibreOffice Writer...

Select your words or paragraphs

• Click on the formatting tools you need 
on Formatting Tool Bar 

 Or
• Open ‘Format →  Paragraph’ Dialogue 

Box  
• Select the tools you need there
• Click ‘Ok’
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Open the Word Processing software and perform the following.
1.  Open ‘Assign3’ file. Format its paragraphs as shown in 
       activity 4. Then save it in your folder as ‘Assign4’. Close the 
           document.

 2.  Open ‘Assign3’ file again. Format it again as shown in 
         activity 5. Then save it in your folder as ‘Assign5’ and close the  
        document.

     Activity

 What is a computer?

 A computer is an electronic device that 
manipulates information or data. It has the 
ability to store, retrieve, and process data.

You can use a computer to type
document, send email, and browse the
web.

You can also use it to handle spreadsheets, 
accounting database, management, 
presentations, games, and more.

What is a computer?

A computer is an electronic device that

  manipulates information or

  data. It has the ability

  to store, retrieve,

  and process data.

You can use a computer to type documents
send email and brows the Web.

Activity 4

Activity 5
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6.3.6  Bullets and Numbering and other formatting methods

16' Bullet List
17' Number List
18' Multilevel List
19' Shading$ Background Color
20' Border

N.B. For the selected sentences, you can use 'Bullets and Numbering' from 
'Paragraph' section. 

1. Press Tab on the key board

2. Press Shift + Tab at the end of the Multilevel list to combine it to the main list    
    again

There are two types of Memory. They are,
1. Primary Memory
 1.1.    ROM
 1.2.    RAM

2. Secondary Memory
 a)    Hard Disk
 b)    Floppy Diskette
 c)    Pen drive
 d)    CD / DVD  

 

Storage
 Capacity 

 Bit
 Nibble
    Byte
    Megabyte
 Gigabyte19

17

16

18

20
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21. Shading / Adding background colours and borders

  For LibreOffice Writer...

For colours to the paragraph:
• Format  → Character  → 

Background Select a necessary 
colour from the tabs    

For Borders; 
• Select ‘Format  →Paragraph  → 

Border’ 

For colours to the document:
       Select the necessary colour from
       'Format → Page → Background' 
                          
For Borders:
• select the necessary border and 

colour from 'Format → Page → 
Border'

        After selecting, click 'Ok'.

For Microsoft Word...
 
• Select the paragraph / document           
• Select ‘Page Borders’ from ‘Page   Layout’ 

→ Page Background                          
• Use Borders/ Page Border/ Shading for this 

on B orders a nd Shading Dialogue Box.                     
• Click Ok                                           

 Open the Word Processing software 
and perform the following.

1. Open a new page. Make a list of 
bullets as shown in Activity figure 
6. Save the document in your 
folder as 'Assign6'. Then close the 
document.

2. Open 'Assign6' file you have saved. 
Add a border to the page. Save the 
changed file as 'Assign7' on Save 
as Type – Word 97 – 2003. Close 
the document.

  Activity
Different type of software

 Antivirus
           AVG
           Semantic
           Kaspersky
 E-mail
  Outlook
  Yahoo mail
  Gmail
 Games
  Worlds of Warcraft
  Car race
 Internet browser
  Firefox
  Explore 
  Google
 Operating system
  Windows xp
  Windows 7
  Linux

Activity 6
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 6.4    Formatting the Document

Some tools provides clarity and attractiveness to the document are shown 
below;
(Figure 6.20)  

 1'  Shapes $ Objects
 2'  Pictures$ Images$ ClipArt 
 3'  Symbols
 4'  Tables
 5'  Header and Footer
 6'  Page Numbers
 7'  Columns
 8'  WordArt$ Fontwork

  Apart from the tools 
mentioned above, you can add other 
appropriate tools as well. 

     

6.4.1  Shapes and Images

Shapes and images are added to provides clarity and attractiveness to the 
document. For this, keep the cursor in the place you wish to add the shape or image.

For Microsoft Word...                         

Use 'Insert' tab and its Ribbon.   
• If it is a shape  
Select Insert → Shape                                  
• Click a shape on it and drag it to the 

page clicking the Mouse           
• If it is an image, select 'Picture/ 

ClipArt' on 'Insert' tab.                              
• Open any image you like                             

For LibreOffice Writer…

 Use Insert tab on Menu Bar 
• If it is a shape Select 'Insert Object 

→ OLE Object' Or Select a shape 
from Drawing tool, click it and 
drag it to the page using Mouse. 

• If it is an image, select 'Insert → Picture 
       From File' 
• Open any image you like

5 4

7

4

6
3

1

2

5

8

Figure 6.20 
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6.4.2  Formatting the shape or image

User can format the shape or image inserted in the document. For instance, 
user can change its size, colour, add borders, change its position, etc. (figure 6.21)

First, select the shape or image by clicking on it. Then make use of the Tool 
Bar to perform the required changes. 

To rotate the shape/
image.

To change the 
position of the shape 
/image (to move 
here and there)

To change the size of 
the shape/image.

  Figure 6.21 – Preparing the shape or image   

The Tool Bar used in Microsoft Word to prepare the shape / image.
picture tool

 The Tool Bar used in LibreOffice Writer to prepare the shape / image. 
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6.4.3  Symbols

User may use different symbols in document preparation. However, there is 
a limited number of symbols on the keyboard. Additional symbols are available for 
use.

For Microsoft Word…           

Open the Dialogue Box by clicking                 
'Insert → Symbols'. Then click 'Insert' 
to add the necessary symbols to the 
Document.

For LibreOffice Writer…

Open the Dialogue Box by clicking 
'Insert → Special Character'. Then click 
'Ok' on the symbols you need to include 
to the document.

6.4.4  Header Footer and Page Numbers

It is essential to add Header and Footer and the page numbers in a document 
For this purpose;

'Insert → Header and Footer' and 'Page Numbers'

6.4.5  Column

This feature is often used in newspapers and magazines. Columns can be 
made before or after typing.

For this, select the paragraph.

 For Microsoft Word...           

'Page Layout' → 'Columns' → select the             
number of columns you need.                           

For LibreOffice Writer...

'Formatting' → 'Columns' → select the 
number of columns you need.

For Microsoft Word…

Header and Footer tool
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     Activity
1'  Open the Word Processing software and perform the following.
2. Open a new page. Type the paragraphs given in Activity 7. 
   Then format the paragraphs as given below. Save the document  
    as Assign10 with the password ‘WordPass’ password. Close the  
    document.

Activity  7

Electronic waste (e-waste): what is it 
and how do we get rid of it ?
This term applies to consumer and 

business electronic equipment that is near or 
at the end of its useful life There is no clear 
definition for electronic waste (e-waste) at 
this time, but if you can plug it in an electrical

outlet or it contains circuit boards or 
chips, it is most likely e-waste. These 
products can contain heavy metals like 
cadmium, lead, copper, and chromium 
that can contaminate the environment Do 
NOT dispose of these items in the trash or 
your recycling bins.

Examples of electronic waste include, but not limited to :
 � TVs, computer monitors, Printers, Scanners, Keyboards, mice, cables, circuit boards, 

lamps, clocks, flashlight, calculators, phones, answering machines, digital / video 
cameras, radios, VCRs, DVD players, MP3 and CD players.

 � Kitchen equipment (toasters, coffee makers, microwave evens)
 � Laboratory equipment (hot plates, microscopes, calorimeters)
 � Broken computer monitors, television tubes (CRTs)

Student E - waste Recycling Options

Any laboratory equipment that has the 
possibility of being contaminated with 
chemical, biological, or radioactive 
substances must be cleared through EH&S 
and Departmental Facilities Office before 
disposal. 

If you live on - campus you can dispose of 
your electronic waste easity and conveniently 
by creating a Fix It Ticket or contacting your 
college maintenance office.
If you live off - campus, learn more about the 
Sants Cruz County electronic waste disposal 
program:

Additional information on disposal / recycling of e-waste and other 
regulated items can be found in all college mailrooms, Graduate 
Student Housing Mailroom and the Village Laundry Community room. 
Multibins are blue cabinets built to collect batteries, small electronics, 
printer cartideges, and CDs. They are located in every college mailroom.
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6.4.6  Tables

User may need to tabulate data in documents. For this purpose, you need 
to prepare a standard table. Word Processing software provides facilities to prepare 
tables. Some of them are;
•     Insert or draw the required rows and columns.
• Delete unnecessary rows / columns.
• Merge cells. 
• Split cells. 
• Colour the table.
• Change text direction.
• Text Direction.

Merge 
Cells

    Figure 6.12 – Table

Time Monday     Tuesday  Wednesday Thursday  Friday
                 TIME TABLE

A
B

C

Split 
Cells

Interval

Text Direction

X
ZY

²  To insert the Table

For Microsoft Word...                     

• Insert → Table                               
• Select the necessary rows and columns                     
• Insert the necessary rows and columns 

in 'Insert Table'
• Click 'Ok'

For LibreOffice Writer…

• Table →Insert→Table 
• Insert the necessary rows and columns 

in 'Insert →Table'
• Click 'Insert'

²   Select Table, rows, columns, cells before you create the table.
²  To move from cell to cell, use arrow keys on the key board, Tab key or click 
      mouse.
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Format tables;

For Microsoft Word…

After creating a table, Table Tools Ribbon will be opened when you select that created table. You 
can select the adjustments you need to add for the table/ rows/ columns/ cells from 'Design' and 
'Layout' ribbons.

E.g.: Merging

1. Select the rows/ columns/ cells you wish to merge.
2. Click 'Layout' ribbon on 'Table Tools'. Click on 'Merge Cells'.    2. Click 'Layout' ribbon on 'Table Tools'. Click on 'Merge Cells'.    

Table Tools

For LibreOffice…
After creating a table, select the table. Click on the 'Table' tab on Menu Bar.
Make use of tools such as Delete, Select, Insert, Split, Merge on the Menu Bar.
Also make use of the Dialogue Box opened by selecting Table → Table Properties  →  Table 
Format.



              For free distribution 179

1.  Open a new page. Create a table as shown in activity 8.
2.  Save that document in your folder as 'Assign11'.

     Activity

            Activity 8

 6.5     Proof reading

6.5.1 Correcting Spelling and Grammar

Spelling and Grammar errors will be indicated automatically, and also the 
possible words will be shown. Spelling errors are underlined in red colour and 
grammar errors are underlined in green colour. 

Step 1      Drag the cursor to the opening of the document.

For M icrosoft Word……….                                 

• Use 'Review → Spelling and 
Grammar'            

For LibreOffice Writer……….. 

• Use 'Tools →  Spelling and Grammar' 
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Step 2  Click 'Change' after selecting the correct word for the red or green 
underlined wrong word. Click 'Ignore' for the words which are not 
there in English Dictionary. (names of people, villages, countries)

6.5.2  Thesaurus

Thesaurus can be used to find synonyms for the words in documents. For 
this purpose, 
•   Select the word you have typed.

6.5.3  Find and Replace Words

Suppose that the user has to delete a word in the document. If the document 
contains many pages, finding the word would not be easy. You can use 'Find' facility 
for this. 
•  Get the cursor to the beginning of the document.

For Microsoft Word...  

Review  → Thesaurus 

For LibreOffice Writer...

• Tools → Language → Thesaurus 

For Microsoft Word…

• Click ‘Find’ in Home → Editing

 
 
• As shown above, type the word you need to find in Search Document on Tool Bar.  

For LibreOffice Writer...

Click Edit → Find

Type the word you need to find in 'Find' place in the Tool Bar as shown above.  Then 
click 'Find Next'.

 Find Next 
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•  To replace a word in the document with another word, replace facility is used.
      For this, 

For Microsoft Word…                            

• Click 'Replace' in 'Home → Editing'     

For LibreOffice writer…

• Click 'Replace' in Edit Menu

•  In the Window you get, type the word you need to find in 'Find What' or 'Search
     for'. Then click Replace / Replace All. Figure 6.22     for'. Then click Replace / Replace All. Figure 6.22

Figure 6.22 – Find and Replace

 

Open the Word Processing software and perform the following.
1. Type the paragraphs given in Activity 9. Save that document  
   in the folder as 'Assign12'.

Activity figure 9

  in the folder as 'Assign12'.

     Activity
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 6.6    Print 

6.6.1  Print Preview  

Print Preview is useful to check the document before printing. User can 
check whether the document is prepared as needed such as indentation, borders, 
etc. 

6.6.2  Print

This tool is used to print the document. 

Get the 'Print' dialogue box by selecting 'File  →  Print'. The following are 
images of Microsoft Office Print (Figure 6.23) and LibreOffice Print (Figure 6.24)

                                                         

2.  Change letters of the following words as.

 •  Businesses – Businasses
 •  Computing – camputing
 •  Network – natwork
 •  Promises – prommises
 •  Resource – resourses

3.  Then correct those words using Spelling and Grammar facility.

4.  Find the following words using 'Find' facility.
 Webmail, information, storage

5.  Replace the following words using Replace facility.

 •  Business – trade
 •  Expensive – luxurious
 •  Connection – relation

6.  After replacing words, save your document in your folder as 'Assign13'.
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Print dialogue box opened in the word processing software allows to;

• Select the printer
• Print the current page, a few pages or the whole document. (current page, Pages 

or All)
• Specify the number of copies.

N.B.: Since it is difficult to print documents for each student in the school laboratory, 
you can save the document with ‘pdf’ format and. For this purpose,

• File → Print → Microsoft XPC Document
   or
•     Writer Adobe PDF → Print → Give a names for the file → Save 

Figure 6.23 - Microsoft Office Print Figure 6.24 - LibreOffice Print
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 6.7    Mail Merge

Mail Merge is used to send a invitations, letters or to print certificates to 
several people. For this process, you can use the data etc saved in address box saved 
using Mail Merge. User can create address for labels print.

In this lesson you can learn,

²  How to create and save the Data Source / Address List.
²   How to create letters, labels and post cards using the Data Source.
²   How to format a document before printing.

Use Mail Merge:

²  Type the document first.

.......
  Data Source Master Document

Mail merge process: Letters, Address Label

....... .......
....... ....... .......
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For Microsoft Word...

• Step 1.  Select Mailing Tab.
• Step 2.  Select ‘Start Mail Merge → Letter’
•   To create or select Data Source…
• Step 3.  Select ‘Select Recipient → Type New List’.

 ∗N.B.: To retrieve saved data, select ‘Use Existing list’.
• Step 4.  By clicking ‘Customize’, change the fields in New address list window.  

  Those are,
a.   Add (for a new field)

 b.   Delete (to delete a field)
 c.   Rename (to change field name)
•      Step 5.  After changing, click Ok.
•      Step 6.  Type the necessary data. For this, use

 a.   New Entry (for a new address)
 b.   Delete Entry (to delete an address)
 c.   Find (to find an address which is saved) 

• Step 7.  After changing, click Ok and save.
•   To create Address Block, use

 a.   More
 b.   Match Field

• Step 8.  Click 'Next' or 'Ok' after changes.
• Step 9.  Use this tool to add Greeting Line.
• Step 10.  After necessary changes click 'Next' or 'Ok'.
•   You can use additional fields by using 'Insert Merge Field'. For this, keep  

  the cursor at the necessary place. Then,
• Step 11.  Add necessary fields to the document by clicking 'Insert Merge Field'.
•   To get letters separately;
• Step 12.  Select 'Finish & Merge edit Individual documents'.
• Step 13.  Save the prepared documents and print.
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For LibreOffice Writer…

• Step 1.  Select Tool  → Mailing Wizard.
• Step 2.  Select ‘Select Starting document  → Use the current document  → Next’.
• Step 3.  Select the document type  → Letter  → Next
•   To create or select the Address List,
• Step 4.  Select ‘Insert Address Block  → Select Address List  → Create’

 ∗N.B.: To retrieve data which is saved, select ‘Add’.
• Step 5.  Change the fields as required for the document by clicking ‘Customize’ in 

  'New address List' window. For this, use
 a.   Add (for a new field)
 b.   Delete (to delete an unnecessary field)
 c.   Rename (to change the name of the field)
• Step 6.           After changes, click Ok.
• Step 7.           Type the necessary data. For this,
 a.   New (for a new address)
 b.   Delete (to delete an address)
 c.   Find (to find an address which is saved)
• Step 8.  After changes click Ok. Then save it in a proper place with a proper name.
• Step 9.  Click Ok again.
• Step 10.  Follow step 2, 3, 4 respectively which are in 'Insert address block' window.
 a.   To decide Address Block. This can be used for
 b.   More
 c.   Match Field
• Step 11.  After necessary changes click Next.
• Step 12.  Use this window to create a salutation. Do necessary changes.
• Step 13.  Click Next.
• Step 14.  To place your address, use ‘Adjust layout of address block and salutation’  

  window. Click Next.
• Step 15.  Use Preview and edit the document window to select the people who get 

  letters and to get a preview of the document. 
• Step 16.  Personalize document allows you to find addresses and to make one 

  document.
• Step 17.  Connect to Mail Merge Menu by clicking Return to Mail Merge Wizard.  

  Go ahead while clicking Next.
• Step 18.  Use ‘Save, Print or send document window’ for various savings and  

  printing.
 a.   Save starting document – to save the initial letter
 b.   Save merged document – to save the merged letter
 c.   Print merged document – to print the merged letter
 d.   Send merged document as E-mail – to email the merged letter
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Open the Word Processing software and perform the following.
1. Type the letter shown in Activity 10. However, do not type 
   the words and symbols which appear in between <...>. Keep one  
     space. Then save the document in your folder as ‘Assign10’.

 

2. Use Mail Merge. For Data source / Address List, enter data of 10 people as 
     shown in the table below.  

Computer Resouce Centre
Senkadagala
28. 04.2014
‹Title› ‹First Name› ‹Last Name›
‹Address Line 1›
‹Address Line 2›

Teacher Parent Interact day

Please take this opportunity to discuss the progress of your child 
‹child’s Name› by meeting the class teacher on ‹Date› at ‹Time› 
at the classroom.

Principal

Activity 10

Title Firts Name

Chaminda Sampath
Chandrabose

Pelawaththa Battaramulla
Colombo

Yawaha 26.06.2014
26.06.2014
26.06.2014

Derwin
SharmilaDehiwala

Mattakkuliya
Hills StreetAmith

9.00 am
9.30 am
10.00 am

Pushparani
Mohamed

Child-
NameLast Name Address 1 Address 2 Date Time

Mr.

Mr.
Mrs.

     Activity
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   1. Open the Word Processing software and prepare the 
          following.

	 	 	 •   Certificates
	 	 	 •   Invitation cards
	 	 	 •   Forms
	 	 	 •   Letters
	 	 	 •   Announcements
	 	 	 •   A banner

   2.  Save the document you have prepared. Creat a PDF file.

     Activity

6.7.1   Shortcut Keys

Shortcut keys are used for the efficient use of the application. The following 
are some of the shortcut keys. User can save time using the shortcut keys. 

Shortcut Key Function
Ctrl + N Get a new document
Ctrl + S Name the document and to save
Ctrl + O Open a document
Ctrl + A Select the document
Ctrl + C Copy letters / objects
Ctrl + X Cut letters / objects
Ctrl + V Paste letters / objects
Ctrl + H Replace words

Ctrl + HOME Get the cursor to the opening of the 
document

Ctrl + END Get the cursor to the end of the 
document
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What is Word Processing, benefits of using a Word Processing software
²   Types of software (Commercial and Free and Open Source)
²   Graphical User Interface of a Word Processing software

Important things in preparing a new document
²   Preparing a new document
²   Methods of saving
²   Opening a file which is saved

Preparing a document’
²   Page Setup
²   Methods of selecting
² Formatting – text formatting, paragraph formatting, using bullets and 
     numbers, shading, adding borders

Formatting the document
²   Adding and changing shapes and images
²   Using symbols
²   Adding Header and Footer, Page Numbers
²   Creating columns
²   Inserting and changing tables

Proof reading and Printing
²   Finding and correcting spelling and grammar errors
²   Using Thesaurus
²   Finding and replacing words
²   Printing documents

Mail Merge
²   Preparing Data Source
²   Adding fields to the Mail Merge
²   Printing.

 SummarySummary
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7 Electronic Spreadsheet

In this chapter you will learn

 ² fundamental functions and operations of spreadsheets
 ² identifying the components of a worksheet
 ² entering and editing data in a worksheet
 ² simple mathematical operators and building a formula using values
 ² use of function and cell address for writing formulae
 ² formatting a worksheet
 ² use of relative and absolute cell addresses,
 ² creating charts.

 7.1      Introduction
Perhaps in our day-to-day life or at work we need to perform calculations. 

We use various methods to perform such calculations. Depending on the nature 
of calculations we use our fingers or mental calculations to perform simple 
calculations while we use calculators or paper based systems to compute complex 
calculations. In order to do calculations easily and accurately let us learn how 
electronic spreadsheets can be used. 

We usually use a square ruled book to perform systematic calculations.  
Every page in this book consists of pages with rows and columns. Electronic 
Spreadsheets which consist of multiples of rows and columns based on this model 
of square ruled books.
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Using Electronic Spreadsheets we can accurately and efficiently perform 
the following activities:

• Simple and complex calculations
• Presentation of data in charts
• Show data in ascending and descending order
• Segregate only the required data
• Check the validity of data
• Protection of data using passwords
• Saving for future use

7.1.1  Electronic Spreadsheet Application Software 

The table 7.1 below illustrates some of the Electronic Spreadsheet 
Application Software developed by different companies.
  

     Table 7.1 - Some Spreadsheet Applications and the and organizations

             Software                         Company
                    Excel           Microsoft Corporation
                    Numbers           Apple Inc
                    Libreoffice Calc           The Document Foundation
                    Openoffice Calc           Apache Foundation

    

 7.1.2  Using Spreadsheet Software

Out of the many spreadsheet software, we discuss only about Microsoft 
Office Excel 2010 and LibreOffice Calc in this unit. Please note that the method of 
starting an spreadsheet software may vary according to the operating system and its 
versions.  

For Microsoft Office Excel 2010 

Start → Programs→ Microsoft 
Office→ Microsoft Office Excel 2010

For LibreOffice Calc

   Start → Programs → LibreOffice     
   LibreOffice Calc →
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7.1.3 The user interface and the components of Microsoft Excel 2010

10' kdu fldgqj

    Name Box
10' kdu fldgqj

    Name Box
10' kdu fldgqj

6' Insert    
Function  

 7' Tabs
8' Formula 

Bar 9' Column Headings

1' Quick Access Tool Bar 2' Title Bar
  3' Ribbon

4' Help

 5' Control buttons

12' Active Cell 

13' Row 
Headings

14' Sheet 
Tab

11' Vertical Scroll Bar

15' Horizontal Scroll Bar

19' Zoom Control18' View Buttons17' Status Bar16' Worksheet   
Navigation

10' Name Box

Figure 7.1-  The user interface of Microsoft Excel 2010

 

 

         

   Table 7.2 - Components of Microsoft Excel 2010

           Component                   Funtion
1'  Quick Access Tool Bar Contains commonly used commands such as 

Save , Print Preview, Undo , New etc
2' Title Bar Shows the name of the Application Software
3' Ribbon Contains a toolbar with, Home, Insert, Page 

layout 
4'  Help Provides help functions
5'  Control Buttons To minimize, open or to expand the worksheet 

window
6'  Insert Functions Opens dialog box to create formulae.
7'  Tabs Changes ribbon
8'  Formulae Bar Views the formula and displays the contents of 

a cell. 
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9'  Column Heading Shows column name
10' Name Box Shows active cell address
11' Vertical Scroll Bar Scrolls the worksheet vertically
12' Active Cell Displays the cell in which data is entered
13' Row Heading Shows row number
14' Sheet Tabs Represents the worksheet
15' Horizontal Scroll Bar Scrolls the worksheet horizontally
16' Sheet Tab Scroll Button Changes the worksheet
17' Status Bar Displays the status of the worksheet
18' View Button Enables to change the view of the worksheet
19' Zoom Control Zooms in or zooms out the view of a 

worksheets
          

7.1.4 The user interface and the components LibreOffice Calc 

3' Standard Tool Bar 2' Menu Bar1' Title Bar

5' Name 
  Box

9' Active Cell 
6' Insert  
Function

7' Formula 
Bar

11' Vertical Scroll Bar

13' Horizontal Scroll Bar

16' Status Bar
15' Worksheet Navigation

12' Row 
Heading 

17' Zoom Control

4' Control Buttons

8' Formating Tool bar

14' Sheet Tab

10' Column 
Heading

Figure 7.2 - User interface of LibreOffice Calc 4.1 
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           Component                          Funtion
1' Title Bar Shows the name of the application software
2' Menu bar Helps to select commands
3' Standard tool bar Useful to select standard tools
4' Control buttons Minimizes, opens or to maximize the worksheet 

window
5' Name box Shows the address of the active cell 
6' Insert Functions Opens dialog box to make formulae.
7' Formulae bar To view formula and display the contents of a 

cell. 
8'  Formatting tool bar Helps to format worksheet
9'  Active cell Displays cell in which data is entered
10' Column heading Shows column name
11' Vertical scroll bar Scrolls worksheet vertically
12' Row heading Shows row number
13' Horizontal scroll bar Scrolls worksheet horizontally
14' Sheet tabs Represents worksheet.
15' Tab scroll button Changes worksheet.
16' Status Bar Displays the status of worksheet.
17' Zoom Control Zooms in or zooms out view of a worksheet

7.1.5  Worksheet

A worksheet is made up of a multitude of cells made by columns and rows 
on a two dimensional plane. Each worksheet is denoted by a sheet tab.

7.1.6  Naming the columns in a worksheet

Each column of a worksheet is assigned an English letter or a combination 
of letters as shown below: See  Figure 7.3

A,B,C,D,'''''''''''''''''''''''upto Z 
AA,AB,AC.AD,AE,.................upto AZ 

BA,BB,BC,BD,BF.................upto BZ

Table 7.3 - Components of LibreOffice Calc 4.1  
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7.1.7  Naming the rows in a worksheet
 

Each row of a worksheet is assigned a row number as 1,2,3,4,5... etc as 
shown below: See  Figure 7.3

Usually the number of rows and columns of a worksheet is a power of two.

Worksheet application     Number of rows  Number of columns 

Microsoft Excel 2003      65536    ^216&    256    ^28&

Microsoft Excel 2007$2010     1048576  ^220&   16384  ^214&

LibreOffice Calc  4'1      1048576  ^220&   1024   ^210&

7.1.8  Active Cell

It is needed to select the cell before entering data in it. A currently selected 
cell is called an active cell. B3 is the active cell in the worksheet below. An active 
cell always has a thick border. See Figure  7.4

Figure 7.4 - Active cell in a worksheet

Rows  Column

Figure 7.3 - Positions of rows and coumns in a worksheet

B

3
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 7.2   Scrolling in a worksheet

In order to enter data the cell, it should be selected. Active cell in a worksheet 
can be moved and selected by the keys or a combination of keys.

Key/combination of keys   Result

Arrow keys     Move a single cell in any direction (left, right, up, down)
Ctrl  + Arrow Keys     Moves the cell to the end of the data range in a particular   
      direction
Home     Moves to column A along the row where the active   
      cell is
Ctrl + Home   Moves the cell to A1 position

Ctrl + End  Moves to bottom right cell of the data range

Page Up    Moves the worksheet one screen up
Page Down    Moves the worksheet one screen down

7.2.1  Cell Address

A cell address is denoted first by the column letter and secondly by the row 
number. The address of the active cell is displayed in the name box.

Ex: A cell at D column and 3rd row would be named D3. See Figure  7.5 

  Name Box
 Active Cell 

Figure 7.5 - Cell address of a worksheet

     Activity 
 The cell address KD74 is situated in row number ……. and column letter 

…….

3

D
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7.2.2  Range of Cells
 

A block of adjacent cells in a worksheet which is highlighted or selected is 
called a range of cells. Observe the worksheets below. 

Figure 7.6 - A range of cells in a column   
(B2:B5)

 This range of cells consists of the 
cells  namely B2, B3, B4, B5. The range 
of cells starts in B2 and ending in B5. 
Column letter is constant in a cell range 
along a column. The cell range in figure 
7.6 is represented by B2:B5.

Figure 7.7 - A range of cell in a row

This range of cells is represented 
as A3:C3. The range in Figure 7.7 consists 
of the cells A3, B3, C3. This range of cells 
is represented as A3:C3. Row number is 
constant in a cell range along a row. 

For this cell range in Figure 7.8, 
cells; B2, B3, B4, C2, C3, and C4 are 
included. 

The cell range in figure 7.8 is 
represented by B2: C4 The column letter 
and the row number vary in a range of cells 
spanning several rows and columns.

Figure 7.8 - A range of cells in a worksheet 
spanning several rows and columns 

Note: The control key is used to select more than one ‘range of cells’ in a worksheet. 
The control key is marked ‘Ctrl’ on the key board. 

B

2
3

3

4
5

B CA

B C

3
4

2
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     Activity 

Answer the questions based on the worksheet shown on Figure  7.9  

^1&   What is the address of the first cell represented by R1cell range?
^2&  What is the address of the last cell represented by R1cell range?
^3&  Write the cell range represented by R1.
^4&  Write the cell range represented by R2.
^5&  What is the name of the cell range along a row?
^6&  What is the name of the cell range along a column?
^7&  Write the cell range represented by R3.
^8&  Give the number of cells in the cell range represented by R3.

R1
R2R3

Figure 7.9 - Range of cells in a worksheet

7.2.3  Entering Data
 

 Before entering data in a worksheet, we need to select the required cell. We 
can enter the data once it is selected. The contents of a cell would be either a label, 
value or formula.

1. Label 
 A combination of letters, numbers, special symbols or the text entered using 
a keyboard are called labels. By default the labels are left aligned.   
Figure 7.10 below shows how labels are left aligned.

Note: The telephone numbers would not be displayed in the same way as shown 
below. (The first letter ‘0’ is not displayed). You need to specify the range of cells 
where the telephone numbers to be entered as ‘Text’. Formatting cells would be 
discussed in a later lesson.

1
2

4
5
6
7

HB C D E F

3
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  Figure 7.10 - labels in a worksheet are left aligned

Piumi Kaushalya Piumi@gmail.com03512232438Kegalle Sabaragamuwa
A.Mallikadevi maldevi@yahoo.com08350632867Kandy Central
Dilisha Gamhewa Dilesha@hotmal.com01278643563Colombo Western
Hakeem Anver anwerhac@live.com01369589596Matara Southern

 

2. Values 
The data with numerical figure are called values. By default value is right 

aligned. Figure 7.11 shows various ways how data are represented as values. 

Figure 7.11 - values are right aligned

Note: When entering fraction numbers a space needs to be entered after the 
whole number.

3. Formulae
The expressions beginning with an equals ‘=’ mark using values, cell 

address and functions are called a formula. When a formula is entered in a cell in 
a worksheet the value of the equation is displayed in the cell and the formula is 
shown in the formula bar.
Example: Getting the total value of cells A1 and B1 into cell C1 (See Figure 7.12)

value obtained from the formula

Formula bar

Formula entered in cell C1

Figure 7.12 - showing values and formula

B

C
1

Name District Province Telephone Number E - mail
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 7.3 Mathematical operators used in formulae

 

	 Operator  Meaning
  ¬  addition
  -  subtraction
  *  multiplication
  /  division
  ^  exponentiation (power)

Note: The order of evaluation can be changed by using brackets. (The expressions 
within the brackets are evaluated first).

Operator precedence: 

 First  ^ &

 Second  ^
 Third  * " $
 Fourth  ¬ " -        reduce top to bottom.

7. 3.1  Simple calculations using values and operators

Table 7.4 below shows a few formulae written using values and operators
   

Table 7.4 - Writing simple formul

      Operator            Formula          Result

Addition                 ^¬&            = 2¬4              6

Subtraction             ^-&            = 5-2              3

Multiplication        (*)            = 4*5             20

Division                 (/)            = 12$6              2

Exponentiation      (^)            = 2^4             16
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There can be more than one operator in a formula. Let us learn how to 
evaluate the operators in order. See the tables 7.5 and 7.6 

    

Table 7.5 - Use of brackets in simple equations

          Formula    Evaluation method          Result
= 2¬4*3       = 2¬12 = 14
= ^2¬4&*3       = 6*3 = 18
= 4*3^2       = 4*9 = 36
= (4*3)^2       = 12^2 = 144

Table 7.6 - Methods of evaluation of equations

Examples = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5
Steps of evaluation = 5¬2*3^2$6-3 = 5¬2*3^2$^6-3& = 8$2*3-2^3¬5

= 5¬2*9$6-3 = 5¬2*3^2$3 = 8/2*3-8¬5
= 5¬18$6-3 = 5¬2*9$3 = 4*3-8¬5
= 5¬3 - 3 = 5¬18$3 = 12-8¬5
= 8-3 = 5¬6 = 4¬5

Answer = 5 = 11 = 9

Note: When brackets are not used operators in the same level such as multiplication 
(*) and subtraction (-) and addition (+) and subtraction (-) are executed from left 
to right.

     Activity 

   Evaluate the following equations.  
  ^1& = 6-4$2 ^6& = 4¬5*2^3    ^11& = 5$2¬1^3*4
  ^2& = 5*4¬3 ^7& = 8$4*2    ^12& = 3-4*3$2
  ^3& = 3¬4*5 ^8& = -4$2¬2    ^13& = 6$3*2^1-3
  ^4& = 2^5¬3 ^9& = 1¬2^2*3    ^14& = 3*^2¬4&$9¬1
  ^5& = 3¬5^2 ^10& = 3*4$2    ^15& = 2^3$^5-1^3&*5
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7.3.2  Formulas with cell addresses and operators
 

 The main advantage of entering formulae using cell addresses and operators 
is when the values of the cells concerned change, the results obtained by the 
formulae also get updated accordingly. 

Example 1
In order to calculate the perimeter and area of a rectangle, let us enter the length 
and breadth of the rectangle in cells A2 and B2 respectively. The formulae to derive 
the perimeter are entered in cells C2,C3,C4 and the formula to derive the area is 
entered in cell D2. See Figure 7.13

     Figure 7.13 - The perimeter and area of a rectangle

     Activity 

Create a worksheet in your spreadsheet application based on the image 
7.13. Observe the changes in values obtained from the formulae in 
column C and D when you enter different values in cells A2 and B2.

Important: In cell D2 if you write the formula D2=A2*B2 it would be taken as a 
label and hence calculations do not happen. Therefore it is important to remember 
that nothing should be written on the left side of the equal sign (‘=’). (See image 
7.15).

Figure 7.14 - The incorrect way of writing 
the formula

Figure 7.15 - The correct way of writing the 
formula
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Example 2 
See the formulae in the worksheet given in Figure 7.16 when the price of  each 
pencil and  book are given.pencil and  book are given.

Figure 7.16 - Price calculation

     Activity 
Prepare the worksheet shown in Figure 7.16 using a Spreadsheet 
application. Change the values in cells B1 and B2. Observe the results 
obtained from the formulae in cells B3, B4, B5 and B6.    

Example 3
Calculating the area and volume of a cube when the length of one side is given. 
(See Figure 7.17)

Figure 7.17 - Finding the area and volume of a cube

     Activity 

 Create a the worksheet shown in Figure 7.17 using a Spreadsheet 
application. Change the values in the cell B1 and observe the results 
obtained from the formulae in the cells B2, B3 and B4.
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Note: The results obtained from a formula (based on cell addresses) always get 
updated when the values of these cells mentioned in the formula change.

     Activity 
Study the worksheet (Figure 7.18) and the table 7.7 containing 
formulae. Now calculate the result of each formula shown in table 7.7 
in accordance with the Precedence of Operators and write the results 
under the ‘results’ column. 

Formula Result

=A1+B1 12
=C1+C2+C3 17
=B2+C3+B3 7
=A2*C1 12
=C2/A2*D1 6
=B3^A2+D1 10

Formula

=A1+B1
=C1+C2+C3
=B2+C3+B3
=A2*C1
=C2/A2*D1Figure 7.18 - Worksheet with data 

Table 7.7
Formula                  Result

=A1*B1-D2
=D1-C2/A2
=B3^C3-A3
=A1*C1/C3
=D2*C4*E1
=A3/B3+A2*D1
=A1+(B2*C2)-B3+C2/B2
=B2-B3+B1*(D1+D2^B1)
=A2^B3-C2+A3*(B3+C1)
=A3/C3*(D2*D1)
=D3/C3/B3*A3+B2
=(D3/(A1+B2))^C2
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 7.4      Use of functions to do calculations
 

When there is a large quantity of data it becomes a difficult and complex 
task to write formulae using only the cell addresses. In this kind of situation 
functions are used. The spreadsheet applications contain different functions to meet 
the requirements of different fields. Let us learn some of basic functions which are 
commonly used. (See table 7.8)

Table 7.8

Name 
of function

 Syntax             Use

SUM =SUM(Number1,Number2......) Adds the values contained in a 
range of cells.

AVERAGE =AVERAGE(Number1,Number2.......) Finds out the average of the 
values contained in a range of 
cells.

 MAX =MAX(Number1,Number2.......) Finds out the largest value 
contained in a range of cells.

 MIN =MIN(Number1,Number2......) Finds out the smallest value 
contained in a range of cells.

COUNT =COUNT(Number1,Number2.....) Counts the number of cells 
within a range of cells.

 

  

For example, look at the methods 1 and 2 given below. In order to find out the 
sum of the values of cells A1 to A10, method 1 uses cell addresses whereas method 
2 uses a function. The same results are obtained from both methods. However, 
when there is a large range of cells, the formula shown by method 2 is simple and 
easy compared to both the methods.
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=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10     1

=SUM(A1:A10)       2

=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10

          =SUM( A1: A10)

    

Only the starting cell address and the last cell address in a function need to 
be included.
Create a function based formulae based on the worksheet given in 7.19.

  

Figure 7.19 - Worksheet 
 

Let us identify the various ways in which a function can be used. 

SUM function (See table 7.9)

Table 7.9

           Formula  Details      Result
= SUM(A1,B1,C1) The sum of cells A1,B1 and C1         12

= SUM(A1:C1) The sum of cells in the range of cells 
from A1 to C1 

        12

= SUM(A1:C1,B2) The sum of cells in the range of cells 
from A1 to C1 and B2 

        15

= SUM(B1:C2) The sum of cells in the range of cells 
from B1 to C2

        20

= SUM(A1:A3,C1:C3) The sum of cells in the range of cells 
from A1 to A3 and C1 to C3 

            35
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AVERAGE function (See table 7.10)

Table 7.10

           Formula          Details     Result
= AVERAGE(A1,B1,C1) The average of cells A1, B1 and C2      4'00

= AVERAGE(A1:C1) The average of cells in the range of cells 
from A1 to C1 

     4'00

= AVERAGE(A1:C1,B2) The average of cells in the range of cells 
from A1 to C1 and B2 

     3'75

= AVERAGE(B1:C2) The average of cells in the range of cells 
from B1 to C2

     5'00

= AVERAGE(A1:A3,C1:C3) The average of cells in the range of cells 
from A1 to A3 and C1to C3

        5.83

           Formula          Details     Result

Note: When the average is calculated a decimal number with several decimal places 
may be used. You need  the required decimal places in the relevant cell range.

MAX function (See table 7.11)
Table 7.11

         Formula              Details Result
= MAX(A1,B2,C1) Finds out the largest value among cells 

A1,B2 and C1
   4

= MAX(A2:C2,B3) Finds out the largest value among the 
range of cells from A2 to C2 and the cell 
B3

   9

= MAX(A1:C1) Finds out the largest value among the 
range of cells from A1 to C1

   6

= MAX(A1,B1:C2) Finds out the largest value among the 
range of cells from A1 to B1 and the cell 
C2

   7
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MIN function (See Table 7.12)

Table 7.12

       Formula                         Details  Result
= MIN(A1,B2,C1) Finds out the smallest value among cells A1, B2 

and C1
    2

= MIN(A2:C2,B3) Finds out the smallest value among the range of 
cells from A2 to C2 and the cell B3

    3

= MIN(A1:C1) Finds out the smallest value among the range of 
cells from A1 to C1

    2

= MIN(A1,B1:C2) Finds out the smallest value among the range of 
cells from B1 to C2 and the cell A1

    2

COUNT function (See Table 7.13)

Table 7.13  

        Formula          Details Result
= COUNT(A1,B1) Counts the number of cells that contain numbers 

among cells A1, B1
    2

= COUNT(A1:C1) Counts the number of cells that contain numbers in 
the range of cells from A1 to C1

    3

= COUNT(A1:A4) Counts the number of cells that contain numbers in 
the range of cells from A1 to A4

    3

= COUNT(A1:C1,B2) Counts the number of cells that contain numbers in 
the range of cells from A1 to C1 and B2

    4

= COUNT(B1:C3) Counts the number of cells that contain numbers in 
the range of cells from B1 to C3

    6

=COUNT(A1:A3,C1:C3) Counts the number of cells that contain numbers in 
the range of cells from A1 to A3 and the range of 
cells from C1 to C3

    6
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     Activity
The Figure 7.20 shows marks obtarned in different terms by ICT students 
of grade 6.  

  

Provide answers using functions.
 
1) What is the formula to be inserted in E2 to find the total marks   

scored by K. Bhanu Somarathne?
2) What is the formula to be inserted in E3 to find the average marks scored by 

Wasantham Jayaraj?
3) What is the formula to be inserted in cell B8 to find the highest score   

made in 1st Term.
4) What is the formula to be inserted in cell C8 to find the  total number of  

students who appeared for the Term 2?
5) What is the formula to be inserted in cell D8 to find the lowest score   

make in the 3rd Term. 

Figure 7.20 - Marks scored by grade 6 students for ICT 
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 7.5      Formatting the worksheet

In order to format the labels and value in a worksheet formatting tool bar or 
cell formatting window can be used. 

7.5.1  Ribbon with formatting tools in Microsoft Excel 2010 

Table 7.14
 No        Tool             Details

      1 Font Apply different font types in a worksheet
      2 Font Size Apply different font sizes in a worksheet
      3 Vertical Top Alignment Align text to the top of a cell
      4 Vertical Middle Alignment Align text to the middle of a cell
      5 Vertical Bottom Alignment Align text to the bottom of a cell
      6 Orientation Rotate the text to diagonal angle or vertical 

orientation
      7 Number Format Choose how the values in a cell are 

displayed
      8 Bold Make the selected text bold
      9 Italic Italicize the selected text
     10 Underline Underline the selected text
     11 Left Alignment Align text in a cell to the left 
     12 Center Alignment Align text in a cell to the center
     13 Right Alignment Align text in a cell to the right
     14 Increase decimal places Show more precise value by showing more 

decimal places
     15 Decreased  decimal places Show less precise decimal places

21 3

1310 11 151412

5 6

9

7

8

4

Figure 7.21 - Formatting tools in Microsoft Excel 2010
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7.5.2  Formatting tool bar in LibreOffice Calc

8

3 4 5 61 2

7 9 10

Figure 7.22 - Formatting tool bar in Libre Office Calc 4.1 

          Table 7-15

     No                Tool                        Details
1 Font Apply different font types on a worksheet
2 Font Size Apply different font sizes on a worksheet
3 Bold Make the selected text bold
4 Italic Italicize the selected text
5 Underline Underline the selected text
6 Left Alignment Align text in a cell to the left 
7 Center Alignment Align text in a cell to the center
8 Right Alignment Align text in a cell to the right
9 Increase decimal places Show more precise value by showing 

more decimal places
10 Decreased  decimal 

places
Show less precise decimal places
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7.5.3  Use of dialog boxes to format values

The Formal Cells dialog box in the tool bar can be used to find more about 
formatting a cell or range of cell.

Figure 7.23 - 'Format Cells' dialog box  Figure 7.24 - 'Format Cells' dialog box

In Microsoft Office Excel  2010  
Home Tab  → Number Group In LibreOffice Calc

Format→Cells

7.5.4  Formatting a range of cells with decimal places

When division of numbers are performed, different numbers of decimal 
places are made. In such instances it is necessary to format the number to a fixed 
number of decimal places.

Figure 7.25 - Formatted to two decimal places

Follow the steps below in order to follow a cell to the required number of 
decimal places.
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In Microsoft Office Excel  2010
1. Select the range of cells
2. Open the ‘format Cells dialog’ box
3. Click the ‘Number’ tab
4. Select the ‘Number’ 
5. Change the decimal places as required
6. Click ‘OK’ 

In LibreOffice Calc
1. Select the range of cells. 
2. Open the ‘Format Cells dialog’ box
3. Click the ‘Number’ tab
4. Select the ‘Number’
5. Change the decimal places as required
6. Click ‘OK’ 

7.5.5  Formatting a range of cells to be seen as labels.
 

A telephone number consists of 10 digits. But in spreadsheets the zero 
(‘0’) inserted as the first digit will not be displayed. This is because the telephone 
number is stored as a numeric value. Therefore, there is need to format the whole 
range of cells where the phone numbers are to be inserted as ‘text’. See figure 7.26 
and column D of figure 7.10

Figure 7.26 - Formatting a range of cells as   
 Text

Follow the steps below in order to format a range of cells as text.

In Microsoft Office Excel  2010 

1. Select the range of cells.
2. Open the ‘Format Cells’ dialog box
3. Click the 'Number' tab
4. Select 'Text'
5. Click ‘OK’ 
6. Enter numbers

In LibreOffice Clac

1. Select the range of cells 
2. Open the ‘Format Cells’ dialog 

box
3. Click the 'Number' tab
4. Select 'Text' 
5. Click ‘OK’ 
6. Enter numbers



For free distribution214

7.5.6 Formatting a range of cells as percentage

When a number is divided, a quotient can be represented as percentage by 
formatting. The monthly profit earned by a school book shop in the first term is 
given below in table 7.27

Table 7.27 - Formatting of a range of cell  percentage

Follow the steps below in order to format a range of cells as a percentage

In Microsoft Office Excel 2010 
1. Select the cell range.
2. Open the ‘Format Cells' dialog box
3. Click the ‘Number’ tab
4. Change the decimal places required
5. Click ‘OK’ 

In LibreOffice Calc 

1. Select the range cells.
2. Open the ‘Format Cells' dialog box
3. Click the ‘Number’ tab
4. Select the percentage category
5. Click the ‘Ok’

7.5.7 Formatting a range of cells as scientific notations
   

Spredsheets can be used to calculate very small to very large numbers. 
Sometimes it is somewhat difficult to understand or express these numbers. But 
when these numbers are converted into scientific format, all numbers can be 
represented by common format which is easy to understand.

Figure 7.28 - Scientific Format
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Follow the steps below in order to format a range of cells as a percentage.

In Libre Office Celc
1. Select the range of cells
2. Open the 'Format Cells' dialog box
3. Click the ‘Number’ tab
4. Select ‘Scientific’ 
5. Change the decimal places as needed
6. Cilick ‘OK’

In Microsoft Office Excel 2010
1.    Select the cell range.
2.    Open the ‘Format Cells' dialog 

box
3.    Click the ‘Number’ tab
4.  Select ‘Scientific’ 
5.    Change the decimal places as 

needed
6.   Click ‘OK’

7.5.8 Formatting of a cell range as scientific  

In a computer (Date) 5/12/2014 means that it is 12th date of May 2014. This 
is the American Format; (mm/dd/yyyy) (mm-month, dd-date, yyyy-year). Date can 
be displayed in many different formats in a spreadsheet. See figure 7.29

Figure 7.29 - various date formats

Follow the below steps in order to format a cell range.

In Microsoft Office Excel 2010 
1. Select the range of cells. 
2. Open the ‘Format Cells' dialog box
3. Click the ‘Number’ tab
4. Select the ‘Date’ 
5. Select the date format
6. Click ‘OK’ 

           In LibreOffice Calc

1. Select the range of cells. 
2. Open the ‘Format Cells dialog’  

box
3. Click the ‘Number’ tab
4. Select the ‘Date’ category
5. Select the date format
6. Click ‘OK’ 
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7.5.9 Formatting a range of cells to display times.

Time is indicated in a computer as 10;35;53 AM. The common format of this 
is hh;mm;ss AM/PM. See Figure 7.30. Here, hh means hours, mm means minutes 
and ss means second.

Figure 7.30 - Various time formats cell range

Follow the below steps in order to format a range of cells to display time.

In Microsoft Office Excel 2010
1. Select the cell range.
2. Open the ‘Format’ Cells' dialog box
3. Click the ‘Number’ tab
4. Select the ‘Time’
5. Select category time should be            

displayed
6. Click ‘Ok’

            In Libre Office Calc
1. Select the cell range
2. Open the ‘Format Cells' dialog  

box
3. Click the ‘Number’ tab
4. Select the ‘Time’ category
5. Select category Time should be  

displayed
6. Click ‘Ok’

 

7.5.10 Formatting a cell range to display currency

When a number denotes a monetary value the currency form such as; Dollar, 
Rupees should be displayed in front of the number. See column B of figure 7.28

In Microsoft Office Excel 2010
1. Select the cell range.
2. Open the ‘Format Cell' dialog box
3. Click the ‘Number’ tab
4. Select the ‘Currency’ 
5. Click ‘Ok’ 

             In Libre Office Calc
1. Select the cell range.
2. Open the ‘Format Cells' dialog  

 box
3. Click the ‘Number’ tab
4. Select the ‘Currency’
5. Click ‘Ok’
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7.5.11  Formatting alignment of a cell range
 The labels and values can be aligned to the left, center or right of a cell 
range.

 

 Left Alignment   Center Alignment   Right Alignment
 

Follow the steps below in order to format a range of cells for alignment.

In Microsoft Office Excel 2010
1. Select the cell range 
2. Open the ‘Format Cells' dialog box
3. Click the ‘Alignment’ tab
4. Select left, right or center
5. Click ‘Ok’

            In Libre Office Calc
1. Select the range of cells
2. Open the ‘Format Cells' dialog box 
3. Click the  ‘Alignment’ tab
4. Select left, right or center
5. Click ‘Ok’ 

     Activity

Create the worksheet shown in figure 7.31 using formatting tools and 
formulae.

Figure 7.31 - Worksheet with various formats
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1. Center align column A and row 2.
2. Make row 2 Bold.
3. Underline the heading in row. Make the font size 16.
4. Italicize cells A3, A4, A5.
5. Use function SUM and write a formula in B7 to calculate the total for the month 

of January.
6. Use function AVERAGE and write a formula in B7 to calculate the average for 

the month of January.
7. Copy the formulae in B6 and B7 and use them to calculate the total and average 

for other remaining months.
8. Use SUM function to get total of Arts Section in the cell E3.
9. Use AVERAGE function to get average of Arts section in the cell F3.
10. Copy the formulae in E3 and F3 and use them to calculate the total and average 

for other remaining departments.

 7.6      Relative and absolute cell reference

7.6.1 Copying a formula
 

A class teacher to calculates the total and average of each student after the 
examinations of a term. However, using an electronic spreadsheet would make this 
task efficient. This is because one can copy the formulae once apply it to many 
other instances. Hence let us look at the steps on how to copy formulae along rows 
and columns. 

7.6.2  Fill handle of a cell

The small black square in the bottom – right corner of the selected cell or 
range is called a fill handle. See figure 7.32

Figure 7. 32 - fill handle

Fill handle
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7.6.3  Use of fill handle for copying formulae

Follow the steps below to copy formulae using the fill handle.
1. Select the cell which contains the formula.
2. Click the small black square in the bottom-right corner of the selected cell. 
3. Drag the fill handle up to the required cell.

7.6.4  Use of copy and paste commands for copying formulae
 

Follow the following steps to copy formulae using the copy – paste 
commands which contains the formula.

(1) Select the cell.
(2) Copy the contents of the selected cell (Ctrl+C).
(3) Select the cell to which the formula is to be pasted.
(4) Paste the contents on the selected cell (Ctrl+V).

7.6.5  Relative and absolute cell reference

A cell address (reference) consists of a column letter and a row number. In a 
formula such a cell address is always called as a relative reference. The dollar sign 
($) when sign is placed before a row number absolute row is obtained, when ($) 
mark is placed before a column name an absolute column is obtained, when ($) is 
placed before column name and row uumber absolute column and row absolute can 
be obtained.
Example

H2 - Relative cell reference
H$2  - Row absolute cell reference
$H2 - Column absolute cell reference
$H$2 - Row and column absolute cell reference

7.6.6  Relative cell reference

If the row number and the column letter of the adjacent cells change 
accordingly when a formula is copied, such cell addresses are called relative cell 
reference.



For free distribution220

Example
When the formula A1+B1 entered in C1 is dragged down along column C and 
dragged sideways along row 1, the cell references change accordingly as shown 
in image 7.33 below. Hence the cell references A1 and B1 could be considered 
relative cell reference.

Figure 7'33 - worksheet with reletive cell reference 

Column letters change

Row numbers 
change

7.6.7  Row absolute cell reference

If the row number of the cells remain unchanged when a formulae is dragged 
sideways along a row, it is called row absolute cell reference.
Example
When the formula= A$1+ B$1 entered in C1, and is dragged down along column C 
and dragged sideways along row 1, as shown 7.34 only the column letters change 
relatively while the row numbers remain unchanged. Hence the cell reference A$1 
and B$1 can be called row absolute cell reference.

Column letters change

Row numbers 
remain 

Figure 7.34 - Work sheet with absolute row cell reference
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Example 2
See worksheet 7.35 where the price of many pencils are derived when we know the 
price of the pencil. 

Figure 7:35 - Relative and absoute cell reference  

=A2*B2 is the formula we need to enter in C2 to calculate the price of pencils along 
the column C relative to the number of pencils. Note that we cannot calculate the 
price of pencils by copying along column C. When the formula is being copied A2 
should relatively change into A3,A4,A5 etc. But the cell B2 should always remain 
constant within the formula. Hence the correct formula to be written in cell C2 is 
= A2*B$2.

7.6.8  Column absolute cell reference

If the column letter of the cells remain unchanged when a formula is dragged 
down along a column, it is called column absolute cell reference.

Example 1 
When the formula = $A1+$B1 entered in C1 is dragged down along column C and 
dragged sideways along row 1, as shown in figure 7.36 only the row numbers change 
relatively while the column letters remain unchanged. Hence the cell reference $A1 
and $B1 can be called column absolute cell reference.

Column letters remain 

Row numbers 
change Figure 7.36 - Worsksheet with column absolute cell reference.
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Example 2
= SUM ($B2:B2) is the formula to be entered along row 3 at the end each Over, to 
calculate the total runs. This is shown in figure 7.37 below.

Figure 7.37 - Worsksheet with absolute cell reference and function column

When the formula is copied along row 3 it would appear as shown in figure 7.38 
below.

Figure 7.38 - Worsksheet with column absolute cell reference 
including formulae 

7.6.9  Row and column absolute cell reference

If the row numbers and column letters of the cells remain unchanged when 
a formula is dragged sideways along a row, such cell addresses are known as row 
and column absolute cell reference.
Example 1
When the formula =A$1+$B$1 in C1 is copied along column A and row 1, the cell 
references do not change as shown in worksheet figure 7.39

Column letters remain unchanged 

Row numbers 
remain unchanged.

Figure 7.39 - Worsksheet with row and column absolute 
cell reference 



              For free distribution 223

Hence when a formula with row and column absolute cell reference is 
copied along a row or column, the references within the cell remain unchanged.
Example 2
As per worksheet in figure 7.40, the prices of books as per quantity are to be 
calculated from D4 to 14 and prices of books as per the number of dozens are to be 
calculated from C5 to C10. Let us write all the formulas so that the relevant prices 
are displayed at once when we enter the unit price of a book in cell C1. We have 
C1 has to remain unchanged when the formula is copied along row 4 and along C. 
Hence we have to enter $C$1, within the relevant formula.

Figure 7.40 - Row and Column absolute cell reference 

    Activity

1' How would the formula appears when formulae are copied.
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 2'  Write the difference between absolute and relative cell addresses.

 7.7      Creation of charts using spreadsheets
 It is not easy to comprehend, compare, analyze or present data when they 
are represented as numbers. But when data are presented in the form of charts they 
become an effective tool to communicate. Let us learn how spreadsheet applications 
are used for this purpose.
Given below are the various types of charts.
    Table 7.16 - Types of charts

        Type of chart            basic form        Purpose of chart
Column Chart Comparing classes of 

data items in group.
Group comparison

Bar Chart Comparing classes of 
data items in group.
Group comparison

Line Chart Comparing classes of 
data items in group.
Group comparison

Pie Chart Comparing classes of 
data items as percentage.

XY Scatter Chart Comparing data in pairs 
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  Activity

Write down two examples use for the chart types in Figure 7.15.

Let us use the worksheet below to create a column chart and a pie chart.

Figure 7.41- Worksheet with chart

Follow the steps below to create charts.

In Microsoft Office Excel 2010 

1.   Select the range of data (A1:F7)
2'   Insert → Chart
3.  Select the type of chart
4'  Select the chart

In LibreOffice Calc

1'   Select the range of data (A1:F7)
2' Insert → Chart
3'   Select the type of chart
4.   Select the chart
5.   Click finish.

Follow the steps below to give a title to the chart. 

In Microsoft Office Excel 2010
  1. Select the type of chart
 2.  Layout→ Chart Title→ Above     
       chart
 3. Type a title

In LibreOffice Calc
1. Select the type of chart
2. Insert → Title
3. Type a title
4. Click OK
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Follow the steps below to name the axis of the graph.

In Microsoft Office Excel 2010

1. Select the type of chart
2' Layout→ Axis Title
3. Name Axis Type (Vertical or Horizontal)

In LibreOffice Calc

 1. Select the type of chart
 2' Insert → Title
 3.  Name Axis 
  4' Cilck OK

Let us display the marks of the students in a pie chart

In Microsoft Office Excel 2010

1.Select the data ranges A1:A7 and       
   G1:G7
2' Insert→ Chart →  Pie chart
 

In LibreOffice Calc

1.Select the data ranges A1:A7 and       
   G1:G7
2' Insert→ Chart →  Pie chart
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Figure 7.43 - Total Marks of students

Example: Drawing Y=X2-5X-3 quadratic function chart

1 Step: Enter the values 2 to 7 in axis as shown in worksheets.
2 Step: Enter the formula below in cell B2.

 = B1 ^2-5*B1-3
3 Step: Copy the formula entered in B2 upto K2
4 Step: Mark A1:A2 a data range
5 Step: Insert  → Chat → XY Scatter

Total Marks

16.96%

20.06%

Ravidu Nadeshean Dini thi Ashwar Di lk i Jayani

18.08%

14.55%

16.64%
13.70%
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Exercise
 
1) Provide answers based on the worksheet below.

Figure 7.44

(1) Name the cell range where 2,6,10,14 are present.
(2) Name the cell range where 9,10,11,12 are present.
(3) Name the cell range where 6,7,8,10,11,12 are present.
(4) Write the formula in A5 using only cell addresses to calculate the total of the 
       values from A1 to A4.
(5) Write the formula in A3 using function to calculate the total of the values  
 from A3 to D3.
(6) Write how you would copy the formula in E3 to E4 
(7) Write the formula in A5 using function to calculate the average of the values  
 from A3 to D3.

     Activity  

Create the below worksheet using a spreadsheet. Those who were 
absent are marked 'ab'.

         Figure 7-45 - Marks List
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Use a single function and create the formulae 
(1) Enter the formula in G2 to calculate the total marks scored by Saman  

Kumara
(2) Enter the formula in H2 to calculate the average scored by Saman Kumara.               
(3) Enter the formula in B9 to find out the highest score obtained for Mathematics. 
(4) Enter the formula in B10 to find out the lowest score obtained by students in 

each subject.
(5) Enter the formula in B11 to find out the number of students present for each 

subject.
(6) Enter the formula in B12 to find out the average score of each subject

 • A worksheet is composed of vertical columns and horizontal rows in two 
diamentional plane.  

 • Columns in a worksheet are named with English letters or combination of 
English letters. 

 • Rows in a worksheet are named with numbers.
 • Cells are named firstly by column letter and secondly by row number.
 • Cell content is either a label, value or a fomulae.
 • A formulae is initiated with equals sign (=).
 • There is a presedence of operators.
 • Formulas are made with cell addresses, operators and functions.
 • Formatting tools are used to format labels and values.
 • The fill handle is used to copy formulae.
 • Dollar sign ($) is used to make absolute cell reference.
 • Several chat types are available in spreadsheet applications. 

Summary
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8 Electronic Presentations
 

Amara     :- Shyama, for this year’s ICT day, our teacher suggested that we make a  
     Presentation which portrays the history of our school and also how
        ICT is used in our school.

Shyama   :-  Amara, then what do we do for it?

Amara      :-  I think we all must get together and make a good presentation. Then we 
                                                        can show it at the auditorium during the event using the new multimedia
           projector.

Shyama  :- That’s a good idea. We can even take photographs and videos of the
     school using the teacher’s digital camera and insert them too into the 
      presentation. 

Amara     :-   Yes, Shyama. Not only that we can animate the school emblem, the flag
         etc and make beautiful slides too. 

Shyama   :-  Also we can give print outs of the presentation to the guests. Can we?

Amara       :-  Yes, Shyama.. Let’s go to the teacher right now and get his ideas on how
        to make a good presentation. 

By completing this lesson you will acquire a sound understanding of:

•   what is a presentation
•   the characteristics of a good presentation
• creating an attractive multi-media presentation using the basic tools of 
      presentations software
•   slide background, slide templates, slide layout planning 
•   inserting suitable images or pictures into slides of presentation, 
•   inserting animations into slides. 
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8.1   What is meant by ‘presentation?

People make presentation to share their views, opinions, ideas  and  
knowledge with a larger group of people. During this process they may use different 
techniques, methods, gestures and tools to impart knowledge and to justify one’s 
points to the audience. 

The Slide Projector and Overhead Projector 
(OHP) were common tools for presentation. The 
mechanism of overhead projector (See image 8.1.1) is 
different to that of a slide projector. The transparent 
sheets used in a overhead projector have to be  
pre-prepared. But notes can be written on the transparent 
sheet using a pen even when the presentation is going 
on. However the contents of the transparent sheet once 
made cannot be erased and used again. Also it cannot 
present a video or an audio. Since this was a simple 
device the presenters widely used the OHP’s to do 
effective presentations.  

 A completely different process has to be 
followed in order to make the slides required for a 
slide projector. The images taken by a camera have 
to be prepared in a lab and fixed on to the slides. 
Here too, one cannot include audio or video in the 
slides. 
 But with the advent of computer technology 
video cameras and multimedia projectors have 
become common tools of presentation today. 

The advantages of the multimedia projector is that we can display the 
presentations which are made quickly using a computer, and the ability to include 
multimedia contents such as audio and video. 
We can include multimedia contents such as 
numbers, letters, pictures, graphics, images, 
movies and videos, tables and graphs, voice and 
sound in a presentation. Since this presentation 
contains multiple types of contents, it is called a 
multimedia electronic presentation. 

The multimedia projector which was 
bulky in the early days is becoming smaller in 
size with many new features. 

Figure 8'1'1 - OHP 
(Over Head Projector)

Figure 8'1'2 - Slide Projector

Figure 8'1'3 - Multimedia Projector
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8.2   The characteristics of a good quality presentation  

We need a good quality presentation in order convey the message clearlry 
to the audience. We can improve the quality of a presentation by paying attention to 
its contents. Hence, let us look at the features to which we need to pay attention to 
improve the quality of a presentation. 

∗  Number of lines
  It is important to consider the number of lines, as same as font size. The 

most appropriate number of lines per slide are 6-9. If more than that are added, 
it may take more time to read or font size may become too small.

∗  Font-size
The distance between the screen and the audience is an important factor 

     to decide on the font size of the texts of a presentation. It is an accepted norm 
      to keep the font size at 32 points or more. It is easier for the audience to read the
      contents of such font size.  

Think of a presentation you had watched; how many of these points 
were considered there? Pay attention to these features when you watch  
presentations in the future.

∗ Correct use of grammar and language
It is a must that you double check the grammar, spellings and use of  language 

by reading the slides carefully. 

∗ Inserting images, drawings, tables or graphs
  It is not suitable to insert more than two images, drawings, tables or graphs 

in each slide. It may become confusing if we insert too many images, drawings, 
tables or graphs in one slide. 

Activity

 1.  Make a list of features how traditional presentation differ from 
    electronic presentation   and compare their pros and cons. Also point  
       out how you can use the electronic presentations in your educational  
      activities. 
2.    Make a list of all possible multimedia contents which can be included  
      in a e-presentation.

    electronic presentation   and compare their pros and cons. Also point 
       out how you can use the electronic presentations in your educational 
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∗  Use of colours
  The use of colours in a presentation is a very important factor. We can use 

dark colours, bold letters or use of different fonts to emphasize certain points. 
The use of dark red colour throughout the slide is a not a good practice since 
it may be uncomfortable for the viewers’ eyes. But you can use red for some 
words, numbers, points etc which need attention. It is important to pay attention 
to the contrast of background and foreground colours also. 

∗ Animation and videos
  It is ideal to use one animation or video in each slide. If you use more than 

one, the overlap of sounds may cause confusion to the viewer. 

∗ Pay attention on target group
  When using multimedia it is important to pay attention to meeting the 

objectives of the target audience. We have to prepare the contents of a 
presentation such that it does not divert the attention of the audience away from 
the objectives. Otherwise, the viewer may lose the attention. For example if the 
audience’s attention is attracted towards a particular animation included in the 
slide, the whole objective of the presentation might be lost. 

 Activity

 1. Make a list of all the points which are important to make an effective 
     presentation. 

 2. Make an e-presentation based on these points to educate your 
     classmates.  

 Activity

     presentation. 

8.3   Presentation Software
A software which helps to create presentations with multimedia contents is 

called a presentation software. 
Some of the popular presentation software are listed below. There are two 

categories of software,  
• free and open source software
• proprietory/commercial software 
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If MS Office software is not installed in your computer then it may not be 
easy for you to make a presentation. But today you can make your presentation 
even when there is no Office in your computer by searching the web. For example 
by using MS Office 365 Powerpoint, Google Presentation or Microsoft SkyDrive 
Powerpoint you can complete your task. Not only that you have provision to even 
save your work in the cloud in the internet.

8.4   Fundamentals of presentation software 
 

Making presentations using Power Point software of MS Office package 
and Impress software of LibreOffice Package are given below; 

     Starting Microsoft Office PowerPoint

You can start MS PowerPoint 2010 as shown below.

Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2010
(This may change depending on the type of Operating System)

Software name Name of developing 
organization

Open source 
/ Proprietory    
(Commercial)

Apple Keynote Apple Inc.     Proprietory software
Corel Presentation Corel Corporation Proprietory software

LibreOffice Impress Document Foundation Open Source software
Microsoft 

PowerPoint
Microsoft 

Corporation
Proprietory software

Open Office.org 
Impress

Apache Corp. Open Source software

Search web and find out the features available online of the other 
presentation software.
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     Figure 8'4'1 - Microsoft Office PowerPoint 2010 work space

The menus and tools of starting screen of Power Point are shown above. 
You can see that many of the tools available in MS Word software. 

1' Quick access tool bar - This is found on the left hand side of the title bar. Using 
this bar you can execute commands faster and easier. You can also add the 
frequently used commands to this bar. This can be done using the drop down 
menu found at the right hand end of the quick access tool bar. The user can 
change the quick access tool bar according to his/her needs. 

2. Title bar - This bar is found at the top of the Microsoft office window. It 
displays the name of the presentation (which is open) along with the name of 
the software. The icons on the right end of this bar are Minimize, Maximize/
Restore and Close buttons.

3. Tabs - The tool bar in this software is called a Ribbon. Each item in the tab is 
denoted by icons. (Ex: There are many groups within Home tab. Font is one 
of the groups.) There are many tools related to fonts within that (Figure 8.4.2). 
The user can change the tab according to his/her needs.

       Microsoft Office 2010

6. Workspace

1. Quick Access          
     Tool Bar

2. Title Bar 3. Tabs 4. Ribbon

7. Task Pane

5. Slide Pane

11. Zoom 
Control10. View Tab9. Status Bar

8. Notes Pane
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4'  Ribbon - The menu bar is designed to be user friendly. The menus in it are 
called tabs here. The speciality is that each item in the tab is denoted by icons 
and grouped as categories. The user can change the tab according to his/her 
needs.(Figure 8.4.3)

5'  Slide Pane - This is the vertical pane at the left side hand of the window. When 
this pane is viewed one can see the slides in small size. But when you click the 
required slide using the mouse, the slide will be displayed as a large slide in the 
middle of the window. Now you can do editing or changes to complete the slide. 

6'   Workspace - Presentation is created at this location.

7'  Task pane - This pane is useful to add some features to the presentation. For 
example, it is very useful when we import animations within the slides. 

8  Notes Pane - This pane is used to insert some notes about the slide of the 
 presentation. The notes in the Notes Pane are not visible to the audience when 
 the presentation is run.

9'  Status bar - Important information about the presentation such as the total 
number of slides in the presentation, the slide number of the selected slide, the 
selected language etc are displayed here.

10' View Tab - The type of view can be changed (how a slide is shown) using the
   icons in this tab. The icons are described below: (Figure 8.4.3)

▪ Normal View - This is the view you get in interface. You can create the 
presentation in this view. 

Figure 8'4'2 - Ribbon

Figure 8'4'3 - View Tab

Normal View 

Slide Sorter View     Slide Show 

Reading View



              For free distribution 237

▪  Slide Sorter View - All the slides of the presentation are displayed together as           
 mini slides. You can change the order of the slides at this view. You can change  
 back to Normal View when you double click on any particular mini slide.

▪  Reading View - In this view,  you can see the slide the same way as it is displayed 
 on the screen. You can read all the texts in the slide very clearly. You can use 
 Escape (Esc) button to go out of this mode.

▪  Slide Show - You can view the selected slide on the full screen. This mode is
 also used to run a presentation to the audience. Also F5 key can be used to start  
 the presentation from the first slide. 

11' Zoom control -  This tool is used to zoom in or zoom out the slide  

8.5   Starting LibreOffice
    

      You can start LibreOffice 4.1 Impress as shown below.

Start → All Programs → LibreOffice 4.1 → LibreOffice Impress → LibreOffice 
Impress 2010 (This may change depending on the type of Operating System)

Figure 8.5.1- LibreOffice 4.1Impress work space

5. Workspace

4. Slide Pane

6. Tasks Pane

1.Title Bar
2. Menu Bar

3. Standard 
Tool Bar

9. Zoom Control8. Status Bar
7. Drawing Tool 

Bar
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The menus and tools of starting screen of LibreOffice Impress are shown 
above. You can see that many of the tools in this screen are also found in LibreOffice 
word processing software too. 

1'     Title bar - This bar is found at the top of the Microsoft office window. It displays 
               the name of the presentation (which is open) along with the name of the software. 
      The icons on the right hand end of this bar are Minimized, Maximize/Restore 
       and Close buttons.

2'  Menu Bar - All the commands required to 
create the presentation are found here. 

3' Standard ToolBar - Each menu of the 
menu bar are placed here as icons for ease of 
operations.  

4. Slide Pane - This is the vertical pane an 
the left hand side of the window. When this 
pane viewed  one can see the slides in small 
size. But when you click the required slide 
using the mouse, the slide will be displayed 
as a large slide in the middle of the window. 
Now you can do editing or effect changes to 
complete the slide. 

5. Workspace - Presentation is created at this 
location.

6' Tasks Pane - Task pane is made of 5 
components. All the 5 components are NOT 
open at the start. You need to click on the 
relevant word in order to open it. (Figure 8.5.2)

• Master Pages - You can make the presentation and the style using this. There 
are a few default slide master pages available. 

• Layouts - Earlier made layouts are kept saved by the software. You can select 
one of them and improve on it or do changes to them.  

• Table Design - This gives styles for creating tables. You can change style 
according to your choice.

Figure 8.5.2 - Tasks Pane
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• Custom Animation - There are many animation features for the texts, drawings 
etc in a slide. Using this feature you can add, change or remove animation 
features. 

• Slide Transition - You can change the way how transition from one slide to 
another happens. There are many alternatives available. Editing features such 
as speed of transition, sound effects, automated transition etc can be added.

7.  Drawing Tool Bar - This provides the various tools required to make drawings
      on a slide. 

8.  Status bar - Important information about the presentation such  as the total 
    number of slides in the presentation, the slide number of the selected slide, 
      the selected language etc are displayed here.

9.  Zoom control - This tool is used to zoom in or zoom out the slide  

Figure 8.5.3 - Status bar

8.6  Microsoft Office Presentation…                                
                  
Setting Slide Size

The size of the slides of a presentation 
should be changed according to the theme. 
We can change features such as type of the 
slide, length and breadth, slide orientation 
etc.
• Design → Page Setup (See Figure 

8.6.1)8.6.1)

Figure 8.6.1 - Page setting window in MS 
Power Point

 LibreOffice Impress... 

Setting Slide Size

• Format → Page
The size of the slides of a presentation 
should be changed according to the theme. 
We can change features such as type of the 
slide, length and breadth, slide orientation 
etc.
(See Figure  8.6.2)(See Figure  8.6.2)

Figure 8.6.2 - Task Pane
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Office Theme / Slide Layouts
After finishing the required changes to the size of the slide, we can start 

selecting the OfficeThemes /Slide Layouts.There are a few differences between MS 
Office and LibreOffice.

Microsoft Office Presentation...
• Home → New Slide or Layout → 

Office Theme. See Figure 8.6.3 of 
the interface you get on the above 
execution.

• You can select one of the themes 
from the templates given. If you 
need a theme other than the given 
layouts then you can select a new 
one from ‘Slides from Outside’.

• Reuse Slides – using this feature you 
can use the theme from a finished 
presentation to make a new one. 

Figure  8.6.3 - Office Theme

LibreOffice Impress...
• Format →  Slide Layout… → Layout 

(by following this method you 
can select slide layouts also called 
themes. Click mouse on it. You can 
choose a slide templetes required for 
presentation. (See Figure 8.6.4) 

• Format → SlideLayout→ Master 
Pages (This helps us to choose an 
already avialable theme. There are 
so many elegant themes available by 
default. 

Figure  8.6.4 - Slide Layouts
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• Select the Title Slide to give a title to the theme of your presentation. Now you 
can type a Title and Sub-Title to suit your presentation.(See Figure 8.6.5)

²   Now perform following.

• Saving an presentation
▫ File → Save As → Folder Name → File Name (Enter name to the file) → Save 

(You can save your presentation in a secondary storage location so that you can 
open it whenever you need it)

Figure 8.6.5 - Title Slide

Microsoft Office Presentation  LibreOffice Impress

Let's make a presentation
     Let's give a name to it Let's make a presentation

     Let's give a name to it

Microsoft Office Presentation...

• Home → Select New Slide or Layout 
Office Theme. Enter a new theme.

• In the menu bar click Slide  Show  → From 
Beginning. The presentation is shown full 
screen. You can do this by pressing F5 too.  
Now you can view the presentation. Click 
again and go to the earlier screen. 

LibreOffice Impress...
• Format → Slide Layout… → (Select 

and enter slide layouts also called 
themes). 

• In the menu bar click View → Start 
from first Slide. The presentation is 
shown full screen. You can do this by 
pressing F5 too.  Now you can view 
the presentation. Click again and go 
to the earlier screen. 

LibreOffice Impress...

• 'File → Save As  → My Documents → 
File Folder' 

• Type the file name and click 'Save'.

Microsoft Office Presentation...

• 'File → Save As  → My Documents' 
→ Type the file name → Click 'Save'  
The presentation is saved in the hard 
disk.
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• Opening an existing presentation

• Slide Background
The software provides options for making the required Slide Background 

too. This offers user friendly ways to add colours to background, shapes/ objects 
and/ or images/ drawings. 

Microsoft Office Presentation...
• Start → All Programs → Microsoft 

Office → Microsoft Office 
PowerPoint 2010 → File → Open →

• Select the name of e-presentation 
saved and open it. 

LibreOffice Impress ...
• Start → All Programs →  LibreOffice 

4.1 → LibreOffice Impress → File → 
Open →

• Select the name of e-presentation 
saved and open it.

 Microsoft Office Presentation...

• Design → Background Styles
• Styles in Background Styles can be added 

to the background. See Figure  8.6.6
• Background → Format Background
        (Try to add different colours, shapes/objects 
        and/ or images/drawings)

 LibreOffice Impress...
• Format → Page → Background
This helps to add colours or shapes to the 
background. See Figure  8.6.7

Figure 8.6.7 - Background colours

Figure 8.6.6 - Background Styles
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LibreOffice Impress...
Adding text to slides
• The location which is denoed as 

CLICK TO ADD TITLE is called a 
Place Holder. Click at such a place 
and start typing in. You can enter the 
required texts. 

Typing at a place where there is no 
Place Holder.

View → ToolBars → Drawing → By 
this you can get a drawing Tool into the 
window. Using the Tool Tip here click 
on Text tool box and then drag at the 
relevant place on the slide. Then start 
typing in the text. 
(You can make all these font based 
changes here which you have learned 
under LibreOffice Writer)

Microsoft Office Presentation...

Adding text to slides

• The location which is denoed as CLICK 
TO ADD TITLE is called a Place Holder. 
Click at such a place and start typing in. 
You can enter the required texts. 

Typing at a place where there is no Place 
Holder.

• Insert  → TextBox (TextBox) 
  Click tools and drag at the relevant 

point. Then start typing in the text. 

(You can make all these font based changes 
here which you have learned under MS Word)

• Adding text to slides of presentation

• Inserting objects in slides
 You can insert objects before or after typing. There a few different types of 
objects that can be included are; 

▫  Shapes / Objects
▫  Clip Art
▫  Pictures

• Inserting Objects in slides

Microsoft Office Presentation...

• Insert → (Illustration) Shape →  Select 
the shape from the drop down menu by 
clicking the mouse and drag on slide. 
After that we can expand or shrink the 
size of the image by dragging the small 
handles at the 4 corners off the shape.
(See Figure  8.6.5) 

Figure  8.6.8 - change size using mouse

LibreOffice Impress...
View → Tool Bars → Drawing → (You 
can get a drawing Tool box into the 
window. Using the Tool Tip in here click 
on the shape and then drag at the relevant 
place on the slide. After that we can 
expand or shrink the size of the image 
by dragging the small handles at the 4 
corners off the shape. (See Figure  8.6.6) 

Figure 8.6.9 - change size using mouse
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Changing the colours of Shapes/Objects
We can draw various shapes inside the slides of presentation and make 

templates or type texts on it. You have to follow the following steps for this. 

• Inserting Clip Art / Gallery Theme into a slide 
We can insert images which are already available in the presentation 

software. Use the following steps for this purpose. 

Microsoft Office Presentation...

• Insert → Clip Art → then search for a 
required clip art by typing in the name.
Then click on the required clip art. After 
that you can expand or shrink the clip art 
using the small handles in it.

LibreOffice Impress...

• Drawing Tool Bar → Gallery → or  
in menu bar Tools → Gallery 

• Open the folders under New Theme 
in the 'Gallary' dialog box. Drag the 
required clip art to the slide.  After 
that you can expand or shrink the clip 
art using the small handles in it.

Inserting Pictures
You can insert pictures into presentation from the computer or from external 

sources. 

Microsoft Office Presentation...

• Right click on the shape. Then select 
'Format Shape' from the menu that 
appears.  Then change options in the 
dialog box and select suitable colours, 
images etc to the shape.  

LibreOffice Impress... 

• View  →  Tool Bars → Line and 
Filling  → You can get 'Line and 
Filling' tool box into the window. 
Select the image to colour. Then 
select 'Area Style/Filling' using the 
Tool Tip and colour.

Microsoft Office Presentation...

• Insert → Picture → Select the required 
image 

• Expand or shrink the picture using the 
small handles in it as we did earlier.

LibreOffice Impress...

• Insert  → Picture → From File … 
Select the required image from file

• Insert → Picture → Photo Album … 
Click 'Add' on the album dialog box 
then click 'Insert slides' and enter the 
pictures into the slide. 
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• Slide Transition Effects 

• Inserting Animation
We can apply animation to  texts, shapes, drawings, pictures or any other 

object in the slides. Select an object and do the following steps. 

Activity
    1.  Open the saved presentation with name ‘MyFirstPresentation’  
                             which you created before.
    2. Add a new slide and insert suitable Shape, Clip Art and 
             image.
3. Add another two slide to the presentation and insert a suitable video clip and  
    audio clip.

   
                             which you created before.
  

Microsoft Office Presentation...

• Select a style under Transition Tab 
(Transition to This Slide). Make an 
attractive slide inserting different slide 
transition to each slide.

• Transition → (Transition to This Slide)  
→ Effect Options → Experience the 
animated direction

• Transition → Sound → Insert sound 
effects for the selected slide transition. 

• Transition → Sound → Apply to All 
Slides → If you want to insert the 
same sound effects for all the slide 
transitions. 

LibreOffice Impress... 
• Format → Slide Layout… → OR 

(Tasks Pane) → Slide Transition. 
• Apply to Selected Slide (Select a 

suitable slide)
• Modify Transition → Speed  → 

(change the speed of transition.)
• Modify Transition → Sound → 

(Insert sound effects for the selected 
slide transition)

• Modify Transition → Advanced Slide  
→ On mouse Click / Automatically 
After  → (Select whether transition 
happens automatically or on mouse, 
click.)

• Modify Transition → Apply to 
All Slides  → (Whether you want 
to apply the same transition style 
throughout the e-presentation.)

Microsoft Office Presentation...

• Animation → (Animation) (try adding 
some animation effects from a group of 
animation effects.) 

• Animation → (Timing) → Start 
(Select whether transition happens 
automatically or on mouse click.)

• Animation →  (Timing) → Duration/
Delay → Start (Set transition time 
in auto transition mode (See Figure 

8.6.10)

LibreOffice Impress ...

• Format → Slide Layout …  → (Tasks Pane) 
→ go to Custom Animation

• Custom Animation → Modify effect → 
Add → (Using the Custom Animation 
window add animations to the selected 
object. There are several animation options 
such as Entrance, Emphasis, Exit, Motion 
Paths, Misc, Effects in that window. These 
options give various animation effects. See 
Figure  8.6.11)
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Figure 8.6.11 - applying 
animations

Custom Animation → Modify effect → 
Change → (Can change a previously 
selected style) Custom Animation → 
Modify effect → Remove → (Can delete 
a previously selected style

• Animation → (Advanced
• Animation) → Animation Pane →
• (Get the animation window. Using this 

you can delete or change any animations 
already applied or modify the animations 
or activate animation by a button or shape. 
Try making these changes) 

Figure 8.6.10 - Animation timing

• Inserting Sounds
We can insert a sounds file into an presentation. Follow the steps below. 

• Inserting Video 

Microsoft Office Presentation...

• Insert → Media → Audio (There are 
3 options namely: Media from File .. , 
Clip Art Audio…and Record Audio)

• Media from File .. → (insert a Media 
File from computer or from outside.)

• Record Audio → (Save sounds 
recorded using a microphone into 
computer’s memory.  Click the Record 
Audiooption. Click the button with a 
brown dot in the dialog box) 

LibreOffice Impress...
• Insert  → Movie and Sound  → (Select 

the sound clip and add animation to 
the sound clip) 

• Even sound clips recorded using a 
microphone also can be inserted into 
the e-presentation) 

Microsoft Office Presentation...

• Insert → Media → Video (There are 
3 options namely: from File .., Video 
from Web Site .. and Clip Art Video …)

• Video from File .. → (insert a video file 
from the computer or from outside) 

• Video from Web Site..   (Insert video 
file from the internet) 

• Clip Art Video… → (insert clip art 
video )

LibreOffice Impress...

•  Insert → Movie and Sound → (Open 
the video clip from the dialog box)

• Enlarge the video clip to the required 
level 

• Apply animation to that video clip.
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• Printing a presentation 
▫ File  → Print → Through this we can send a command to the printer to print the 

presentation. Perform the following actions by using the options in the dialog 
box.  

Activity

1. Open the saved presentation with name ‘MyFirstPresentation’   
        which you created before.

2.   Insert the following animations.
  • Slide Transition

 • Custom animation for the inserted objects. 

Microsoft Office Presentation...
• Printer :- (Select a printer conncted to 

the computer. see Figure 8.6.12) 

• Settings :- (Should all slides be printed? 
You have options to print only the 
selected or few slides selected by their 
slide numbers) 

    Figure 8.6.12 - Printing

• Can change the size of the print (larger 
or smaller) on paper. 

LibreOffice Impress...
General → Printer :- (Select the printer)
• Range and copies :- (Should all slides 

be printed ? You have options to 
print only the selected or a few slides 
selected by their slide number.)

• Number of copies :-  (decide the 
number copies needed.)         

• Print :- (Using the box infront of 
Document, you can get customized 
print outs. See Figure 8.6.13)

 

          

  
  
  
  
  
 Figure  8.6.13 - Printing
• Can change the size of the print 

(larger or smaller) on paper. 
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•  Presentation can be projected and printed as a handout.

•  A printed copy of the presentation can be given to the audience.

• The handouts that are obtained by ‘File → Print’ can be distributed to the 
audience. This provides facility to note down important notes besides the 
slides. (Figure 8.6.14)

 
 

    Figure 8.6.14

1.   Use the following the steps to create a new presentation. 

2.    Select a suitable layout and use topic and subtopics. 

 3.  Find out more features available in presentations which you
            believe are important, in addition to the features mentioned above.

 4.    Make a creative presentation about a lesson you have studied
      in order for other students to understand the lesson easily. Include       
    pictures,  relevant charts, animations, sound clips, video clips,  
          different background colours and slide transitions.  

Activity
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5. Select one of your favourite lessons which is difficult to explain on a black 
board. Create a presentation using multimedia and feature. 

Green computing ...

 Green computing is the study and practice of designing, manufacturing, 
using, and disposing of computers, servers, and associated subsystems — such as 
monitors, printers, storage devices, and networking and communications systems 
— efficiently and effectively with minimal or no impact on the environment.
The environmental effects of computing should be addressed Green use, green 
disposal, green design, and green manufacturing. Green computing can also 
develop solutions that offer benefits by aligning all IT processes and practices 
with the core principles of sustainability, which are to reduce, reuse, and 
recycle; and finding innovative ways to use IT in business processes to deliver 
sustainability benefits across the enterprise and beyond. 
 Modern IT systems rely upon a complicated mix of people, networks, 
and hardware; as such, a green computing initiative must cover all of these areas 
as well. A solution may also need to address end user satisfaction, management 
restructuring, regulatory compliance, and return on investment. There are also 
considerable fiscal motivations for companies to take control of their own power 
consumption.  
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Read the information on Green Computing given above and find out more books, 
magazines, and web and make a  presentation with the help of your teacher.
Also include the points below into your presentation. 

• A suitable title with animation
• Images
• A video clip 
• A sound clip 
• Menu to help the user 
• Buttons for slide transition 
• A conclusion slide on Green Computing 

² To differentiate manual presentations and electronic presentations. 

² Characteristics of good quality presentations.

² Creating an attractive presentation using the basic features of a presentation 
software.

² Creating a presentation with slide background, slide templetes, slide layouts.

² Inserting pictitres and diagrams in a presentation.

² Applying transitions to slides.

² Printing a presentation. 

Summary
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In this chapter you will learn;

²   definition of database
²   advantages of using a database
²   special characteristics of a database
²   using fields to create tables
²   identifying key fields
²   relational databases
²   relationships between tables
²   using queries to get data
²   using data forms
²   using reports to furnish information

 9.1   Database Concept

Chapter one included a description on what data and information are. This 
chapter covers saving data in an organized manner. 

Higher the amount of data it becomes difficult to keep in our memory. On 
such occasions writing these data is one method. That is called manual database. 
The other method is to maintain the data on an electronic medium. This is called an 
electronic database. Data can be retrieved efficiently when needed if it is saved on a 
database in a systematic way. Hence, the database is needed to save a large amount 
of data and to retrieve them very efficiently.

9    Database
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Examples 
It would be easy for you to remember names of your friends, but it would be difficult 
to retain all their phone numbers in your memory. You can get these details easily 
when needed if you write names and phone numbers in a book (Figure 9.1) or save 
them in a mobile phone (Figure 9.2). Thus, the phone book can be considered a 
simple database. 

Defining a Database - Collection of organized data can be defined as a database

9.1.1  Advantages of Databases

   ²     More efficient in retriving  information.
Required information can be found very quickly as data is properly 

organized in tables in a database.
 ² Easy to obtain copies.

     Electronic databases can be copied very easily.
 ² Smaller physical space to store data.

     Though  more physical space is needed to maintain a manual 
     database, a small space is sufficient to save data on an electronic medium.

 ² Data analysis can be carried out efficiently.
Only the necessary data can be selected and processed.

 ² Data can be shared.
The same database can be used in different application software.

 ² Independence of data.
     Though database and software are connected, database 
  tables can be updated without changes to the application software. 
    Therefore, data and software are independent.

Figure 9.1 – telephone numbers (manual) Figure 9.2 – telephone numbers (electronic)
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9.1.2  Features of a Database

•   Minimal data redundancy

If the same data is stored in several tables, this is called data redundancy. 

For instance, the name of a student may be recorded separately in the 
admission card and the library membership card.  When a name is changed, that 
name should be edited separately in all documents. Given below is an example 
where the name ‘Firosa Lai’ is changed as ‘Firosa Rafeeq’.

 Table 9.1 - Admission table

Student 
Number

Name Date of Birth Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne
101 Firosa Lai Rafeeq 4$2$2008 1$1$2014 K. Fais

        

               Table 9.2 - Library table

Student Name Name of the Book Borrowed Date Return Date
Firosa Lai Rafeeqa Folk Songs 2$9$2014 16$9$2014

Manoj Dayarathne Drama 3$9$2014 17$9$2014

Firosa Lai Rafeeq Basic Maths Concept 3$9$2014 17$9$2014

Manoj Dayarathne Drama 4$9$2014 18$9$2014

However, by storing related database in tables, data redundancy can be 
minimized. In the following table, a student name is recorded only in one table.  
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 Table 9.3 - Relational Database
Student 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne
101 Firosa Lai Rafeeq 4$2$2008 1$1$2014 K. Fais

Student 
Number

Book 
Number

Borrowed 
Date

Return Date

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

Book 
Number

Title Author’s Name

1111 Basic Maths 
Concept

Sivathasan 
Ramanathana

2222 Folk Songs Jayantha Bandara

3333
Drama Padmamali Menike

 ² Data consistency : By minimizing data redundancy, the same data being saved 
in various tables can be reduced or prevented. This enables to maintenance of 
data consistency.

If you consider the example above, student data, data about books and 
    usage of books are saved separately in different tables. As such data such as 
          name of a student or a book should be recorded only once. Thus, data consistency 
      is maintained. 

²  Increases efficiency : Since database tables are properly organized, saving
      and reading data can be carried out efficiently. Hence, efficiency is higher.

As per example above, let us consider the change of name from Firosa 
    Lai to Firosa Rafeeq. If the same data (Firosa Lai) are recorded in different 
    tables, more time is spent to find all these places. This leads to inefficiency. 
   However, in related databases data consistency increases speed. Hence,
      efficiency is increased. 

²       Increases accuracy  :  Since data redundancy can be minimized in a database, data
       consistency is maintained. This increases accuracy.    

Let us consider the example above where Firosa Lai is changed to Firosa 
    Rafeeq. If several places are corrected, one mistake would lead to inaccurate 
     information.       
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    However, in the above database only one table is need to be updated to 
change Firosa Lai to Firosa Rafeeq. This ensures data consistency. Therefore, 
the accuracy of data is very high.

²  Increases validity : Properties of fields can be assigned when a database 
    is planned. Validity can be checked at the data entry stage. This increases the
     validity of the database.
                    For instance, field attributes can be imposed as fees to be indicated in 
two decimals with minimum fees being 1000 which is mandatory.          

        

Figure 9.3 - Properties of  data type

²  Security : Unauthorized access can be controlled by using a password 
   and encypting the database. This increases security.

  Data encrypting is translating data in such a way that unauthorized personnel 
cannot read it.  In the following figure 9.4, data available in Employee table are 
encripted so as it cannot be understood by an unauthorized person.

Fees

Field name Data Type

Field 
properties
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9.1.3 Electronic and Manual Databases

In an electronic database, data can be saved in a very small space which 
consists of an audio or video medium. Given below is a comparison of electronic 
and manual databases. (Table 9.4)

    Table 9.4 – comparison of manual and electronic database

Manual Database         Electronic Database
Less efficient More efficient
Less accurate More accurate
Less credible More credible
Difficult to analyse data Easy to analyse data
Should present in the order of input Can change the data input order 
Difficult to delete unnecessary data Easy to delete unnecessary data
Difficult to update data Easy to update data
More space is needed to save data A very small space is needed to save data

More man power is needed Less man power is needed

Figure 9.4 - Data Encription
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9.1.4  Introduction to Relational Database

A collection of fields related to one person or object is called a record.
A collection of records is called a data table.
A collection of related tables is called a relational database.

Field 
Student 
Number

Name Date of 
Birth

Date of 
Admission

100 Manoj Dayarathne 2/9/2008 G. Dayarathne
101 Firosa Lai Rafeeqa 4/2/2008 K. Fais

Student 
Number

Book 
Number

Borrowed 
Date

Return 
Date

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

Tables

Records

Relational Database

Let us learn how a related database is built step by step. A collection of 
fields make a record, a collection of records make a table and a collection of tables 
make a relational database.

Figure 9.5

Relational database

Table 1 + Table 2 + Table 3 + Table 4 …….. (Tables)

Record 1 + Record 2 + Record 3 + Record 4 ………. (Records)

Table

Record

Field 1 + Field 2 + Field 3 + Field 4 + Field 5 ……… (Fields)
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Example 
Student record book is a very important document for every student. Biodata of a 
student and the marks obtained for each subject with the rank in all three terms in 
all grades are included. 
    Table 9.5 – Biodata form

Admission No : 1426 Admission No : 1427 Admission No : 1428
Name : Kavindu 
Prabashwara

Name : Meenadevi 
Ramanathan

Name : Mohommad 
Malikkar

Date of Birth : 2005.05.23 Date of Birth : 2005.08.12 Date of Birth : 2005.02.07
Gender : Male Gender : Female Gender : Male
Tel No : 0352287571 Tel No : 035 22 35696 Tel No : 0352815402

Five details related to each student are given above. Thus, data such as 
Kavindu Prabashwara, Meenadevi Ramanathan, Mohommad Malikkar represent 
one field. To name such a field, a ‘field name’ is used.

Let us create a table recording details under each field name. (Table 9.6)
        Table 9.6 - Student Records

Admission 
No

Name Date of 
Birth

Gender  Student  Phone 
Numbers

1426 Kavindu 
Prabashwara

2005.05.23 male  0352287571   

1427 Meenadevi 
Ramanathan

2005.08.12 female  0352235696

1428 Mohommad 
Malikkar

2005.02.07 male  0352815402 

A column of the table represents one field. Thus, the above table consists of 
five fields. They are admission number, Name, Data or Birth, Gender and Telephone 
number.
A collection of fields makes a record. Hence, the  above table has three records.
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There is the possibility of entering the same data again in the columns 
such as Name, Date of Birth, Gender and Tel No. However, a datum entered in the 
column of Admission No will not be repeated. Hence, the field Admission No is 
more suitable to uniquely identify a record. 

What are the books borrowed by Firosa Rafeeq? Let us learn how this is 
found in relevent tables.

Student 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj Dayarathne 2$9$2008 1$1$2014 G. Dayarathne
101 Firosa Rafeeq 4$2$2008 1$1$2014 K. Fais

Student 
Number

Book 
Number

Date 
Borrowed 

Date 
Returned

101 2222 2/9/2014 16/9/2014
100 3333 3/9/2014 17/9/2014
101 1111 3/9/2014 17/9/2014
100 3333 4/9/2014 18/9/2014

Book 
Number

Title Author’s Name

1111 Basic Maths 
Concept

Sivathasan 
Ramanathan

2222 Folk Songs Jayantha Bandara
3333 Drama Padmamali Menike

 Table 9.6 

Field Names

Admission 
No

Name Date of 
Birth

Gender Telephone No

1426 Kavindu Prabashwara 2005.05.23 male 0352287571

1427 Meenadevi 
Ramanathan

2005.08.12 female 0352235696

1428 Mohommad Malikkar 2005.02.07 male 0352815402

 Record

Row

Column

       Table 9.7 - Componants of Data Table
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9.1.5  Primary Key 

A column (or a combination of columns) which enables to identify a record 
uniquely is called primary key.    

Figure 9.6

For instance, study the table given below which consists of data on a few books.
Table 9.7 - Book Table

Accession 
No

Title Author’s Name Price of 
Book

Number 
of Books

2131 Let’s Access Internet Mahesh Gankanda Rs.275.00 10

2132 Computer Studies Suranimala 
Basnayaka

Rs.300.00 5

2133 Essay Writing Nimali Bogoda Rs. 225.00 12

2134 Education Psychology Dayanath 
Jayasekara

Rs.400.00 6

2135 Tamil Language Learning Raj Sudakaran Rs.225.00 8

2136 Computer Studies Mohommad Niyas Rs.150.00 4

2137 Sinhala Tamil Dictionary Raj Sudakaran Rs.325.00 6

In this table,

• Accession numbers do not have duplicates (unique)

• Both authors Suranimala Basnayaka and Mohommad Niyas have authored 
Computer Studies.

• Raj Sudakaran has authored both Tamil Language Learning and Sinhala Tamil 
Dictionary.

Example - National Identity Card Number 
              School Admission Number 

observation  

 Special attributes of a primary key
 • Should not be empty (data being there is mandatory)
 • No duplicate values (same values do not exist)
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• The price of both books Essay Writing and Tamil Language Learning is the 
same.

• Both books Education Psychology and Sinhala Tamil Dictionary have six 
copies.

According to these details, the Accession Number is the most suitable fields 
for the primary key.

Note: The Primary key of a table is underlined to identify as unique. (table 9.8)

     Table 9.8

Accession 
Number

Title Author’s 
Name

Price of the 
Book

Number of 
Copies

   

9.1.6  Composite Primary Key

The primary key which consists of two or more columns of a table uniquely  
identifies a record is called Composite Primary Key.

Look at the table given below about the captain and vice captain of a school.

Year Sport Captain Vice Captain
2013 Cricket Rashmi 

Senarathne
Mubharak Husein

2013 Football Jaliya Saranga Vinothen Raj
2013 Volleyball Ahammed Nawas Sudesh Tharanga
2014 Cricket Mubharak Husein Bhanu Dayarathne
2014 Football Jaliya Saranga Ahammed Nawas
2014 Volleyball Bhathiya Gamlath Sudesh Tharanga

 
Composite Key Both the year and sport are needed to uniquely identify 

a record.

   

Example

Table 9.9 – Sports Table 
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 Since the column data of this table containes duplicate. There is no single 
column to uniquely identify records. There should be a definite captain and a vice 
captain for a sport in a year. Hence, as far as the combination of two columns; 
year and sport is considered, identity of records exists. Hence, combination of both 
fields ‘year’ and ‘sport’ can be considered as the primary key. The composite key 
made of the combination of these two columns is suitable for the primary key in this 
table. When indicating the composite primary key, fields are separately underlined. 
(Refer Table 9.10)

          Table 9.10

Year Sport Captain Vice Captain

The composite primary key of this table = Year + Sport 

9.1.7  Foreign Key 

 If a field (or a combination of fields) of one table can be used to uniquely 
identify rows of another table, this/these field/s is/are called the foreign key.This 
key builds connection of two tables.

Table 9.11 –  Student Table 

When considering the tables 9.11 and 9.12, Registration 
Number is the primary key of 9.11 - Student Table where 
as Registration Number is the foreign key of 9.12 - Subject 
Table. Further, a separate primary key is available for subject 
table and that is candidate number.

Registration 
Number

Name Date of 
Birth

Date of 
Admission

Name of the 
Guardian

100 Manoj 
Dayarathne

2/9/2014 1/1/2014 G. Dayarathne

101 Firosa Rafeeq 4/2/2014 1/1/2014 K. Fais

Candidate 
No

Maths Science Sinhala English Registration  
No

449683 B A C C 100
449697 A B B A 101

 9.12 - Subject Table  

Primary Key

Foreign Key 
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Example
Given below in Table 9.13 are ICT subject marks of three students scored in the first 
term.  
    Table 9.13 – First term marks

Admission No Name Date of 
Birth

Marks Term Year

1426 Kavindu Prabashwara 2005'05'23 69  1 2014

1427 Meenadevi 
Ramanathan

2005'08'12 82  1 2014

1428 Mohommad Malikkar 2005'02'07 47  1 2014

When entering marks of these students scored in the second term, the fields 
such as admission number, name and date of birth should be entered again. (Refer 
Table 9.14)
           Table 9.14 – Second term marks

Admission 
No

Name Date of 
Birth

Marks Term Year

1426 Kavindu Prabashwara 2005'05'23 69 1   2014

1427 Meenadevi Ramanathan 2005'08'12 82 1 2014

1428 Mohommad Malikkar 2005'02'07 47 1 2014

1426 Kavindu Prabashwara 2005'05'23 79 2 2014

1427 Meenadevi Ramanathan 2005'08'12 68 2 2014

1428 Mohommad Malikkar 2005'02'07 66 2 2014

Recording column data repeatedly is called data duplication.
Disadvantages of data duplication
(i)   Inability to select a primary key field to maintain identity of records.
(ii)  Inability to analyse data properly.

Though the number of students who have scored above 60 marks is 5 as per 
the above table, the actual number of students in the class is 3. Hence, a 
proper data analysis cannot be done.

observation 

 Special features of a foreign key
•  Builds a connection between two tables.
• The related data of the primary key field exist in the other  

     table.
•  Foreign key of one table is the primary key of the other table.
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(iii)  Reduced efficiency
  When entering marks of several years in the above table, more time is spent 
  to enter the admission number, name and date of birth of the same student. 
  This reduces efficiency.
(iv)  Possibility to get inaccurate data is high.
  There can be errors in entering the same data repeatedly. Mohommad 
  Malikkar can be recorded as Mohommad Malakkar in another place. These 
  mismatches can lead to inaccurate data. Hence, accuracy becomes low.
(v)   Difficult to input data.
  To enter the marks of a student, his/her name and date of birth should be 
  entered repeatedly.
(vi)  Possibility to make errors in deleting data.
  As there are several records related to a student, there can be errors in 
  deleting data.
(vii)  Difficult to update data.
  As there are several records related to one student, attention should be paid to
  each record in updating it.

These difficulties are created as all data are stored in one table. Hence, to 
minimize such difficulties, a table can be divided into several tables.

Let us create two tables: Student Table and Marks Table, by removing the 
fields which cause data duplication.
Let us create Student Table (Table 9.15) which consists of Admission Number, 
Name and Date of Birth.

In the Student Table, there is the possibility of data in Name and Date of 
Birth fields being duplicated. However, data does not duplicate under Admission 
Number. Hence, Admission Number is more suitable to identify records uniquely. 
Therefore, the primary key of the Student Table is the Admission Number. 

Table 9.15 – Student Table

Admission No Name Date of Birth
1426 Kavindu Prabashwara 2005'05'23

1427 Meenadevi Ramanathan 2005'08'12

1428 Mohommad Malikkar 2005'02'07
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Let us create a Marks Table (Table 9.16) which consists of the Admission 
Number, Marks, Term and Year.

Table 9.16 – Marks Table

Admission No Marks Term Year
1426 69 1 2014

1427 82 1 2014

1428 47 1 2014

1426 79 2 2014

1427 68 2 2014

1428 66 2 2014

There is only one datum in the Student Table related to Admission Number 
of Marks Table.

Hence, the field of the Admission Number is the primary key of the Student 
Table and foreign key of the Marks Table.

9.2  Creating a Simple Database Manually

Data type : a type of data related to one field is called a data type. Let us learn about
      some commonly used data type.

 ² Numeric: used for calculations. Exists in several forms.
∗ Integer: plus or minus whole numeric figures.
   E.g.: 12, -23
∗ Real: plus or minus numbers with decimal places.
   E.g.: 8.125, -2.64, 4.00    

 ² text: composed of letters, numbers or special characters (Eg-  %, *, -). Though 
numbers are used, it is not used for calculations. 

E.g.: National identity card number –889534731V
          Telephone number –0112785123, 0112 - 985123
 ² Currency: used to indicate monetary values.

  E.g.: $12.45, Rs.35.00
 ² Date / Time: indicates dates and time

   E.g.: 12/23/2013, 7.35 a.m
 ² Boolean: there are only two Boolean (logical) values; True and False. 

The size of a field can be changed according to the data type and number of 
data input to that field. 



For free distribution266

E.g.: Field Name (Column Name)               Number of fields (Column Width)
             Subject Name                                            15
             Subject Code                                              5

Data type related to the field should be identified when the table is created.
  
  Field Name                                       Data Type
    Accession number of the book                     Text
            Title                                                  Text
              Author’s Name                                         Text
              Price of Book                                       Currency
           Number of Books                                     Number

(1) Tabulate details of 10 books in your library under the fields mentioned
       above.

(2) Create a table which is suitable to enter marks scored by the students
     in your class. Include Admission Number, Name and the Marks for
        subjects you study in this table.

Mention the most suitable data type for the fields in Table 9.17 given below.
    

          Table 9.17 

Field Data Type
Admission Number
Date of Admission
Subject Code
Doctor’s Fee
Department Name 
Number of Passengers
Is Registered?

(3)  Explain with examples the importance of selecting the most suitable data type
       for fields.

Activity 
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9.3  Converting a Manual Database to an Electronic    
       Medium 

Let us learn electronic databases with the purpose of  converting a manual 
database to an electronic medium. 

Definition
A collection of objects which facilitates planning and maintenance of the 

database to the user is called a Database Management System (DBMS). This 
consists of several objects like tables, queries, forms and reports. (Refer Figure 9.7)

  

  Figure 9.7 – Objects of a Database Management system  

9.3.1  Database Management System Software

Given below in Table 9.18 are some DBMS software manufactured by 
various companies.

   Table 9.18 – Various database management systems and manufacturing companies

Software Manufacturing Company
Access Microsoft Company
Base The Document Foundation
Oracle Oracle Corporation

  

Figure 9.7 – Objects of a Database Management system

(DBMS)Reports

Forms

Queries

Tables
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9.3.2 Using of Database Management System Software 

In this unit, only Microsoft Office Access and LibreOffice Base software 
are discussed. 
1. Starting DBMS software 

Please note that the commands used to run software can be different 
according to the operating system.

2. Planning a Data Table
Open database software and plan a table with the fields and data types as 

given in 9.8. Name the table as ‘Library’.

3. Creating the Primary Key for a Data Table 
Data should not be duplicated to uniquely identify rows of a table. Identity 

of records can be maintained by using a column or a combination of columns of a 
table as a primary key field. Convert the field of ‘Accession Number’ in the above 
figure 9.8 to the primary key field.

For Microsoft OfficeAccess''' 

Create → Table Design → Give the field 
name and data type → Design properies 
→  Save the table
 

For LibreOffice Base'''

Select 'Table' in Design View → Give 
the field name and data type → Design 
Properties → Save the table.

Figure 9.8 – Fields and data types of ‘Library’ table.

For Microsoft OfficeAccess''' 

Start→ Programs → Microsoft Office 
→ Microsoft Office Access → Blank 
Database → Select Folder and Type 
Name → Create

For LibreOffice Base'''

Start → Programs → LibreOffice →
LibreOfficeBase → Create a new 
database → Next → Finish → Select 
Folder and Type Name → Save
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4'  Entering Data to the Table
The table view should be changed to input data to a prepared table.

Enter data into the Library Table as shown in Figure 9.10

   Figure 9.10 - Records of Library Table

  Figure 9.9 - Library Table with the Primary Key

For Microsoft Office Access'''

 

Select the table from 'All  Access 
Objects' window → Select' Data Sheet 
View' → Enter data → Close the table.
  

 Enter data  Close the table.

For LibreOffice Base'''

Double click the table under Tables or 
select Open by clicking the right button 
→ Enter data → Close the table.

For Microsoft OfficeAccess'''

Give field name and data type → Select the 
row/ rows that should be made as Primary 
key → Click on Primary key →  save the 
table. 

For LibreOffice Base''''

Give field name and data type adjust 
properties → Right click on the line 
which contains the field need making 
primary key → Select Primary key → 
save the table.
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 9.4  Creating a Relational  Database
You have studied the Primary Key and Foreign Key of a table in unit 9.1. 

Rather than keeping all the data in a single table, it is easier, more efficient and 
productive to input, update and delete data if those are recorded separately in 
different tables. Hence, let us study this section well to break a data table into 
several simple tables and to build relationships between these.

When creating a relational databases, several type of relations can exist 
among tables. They are known as one-to-one, one-to-many and many-to-many.

9.4.2 One-to-one Relationship
If only a row of a table is related to a row of another table, it is called a 

one-to-one relationship.

Two tables exist as A and B.  A row in table A is related to one row in Table 
B and a row in Table B is related to one row in Table A. 

Example

Given below is Table 9.19 which includes the marks students scored of the Grade 
5 scholarship exam.

Table 9.19– Scholarship Marks

Admission No Name Date of 
Birth

Index No Marks

1426 Kavindu Prabashwara 2005'05'23 23234 151

1427 Meenadevi Ramanathan 2005'08'12 23876 186

1428 Mohommad Malikkar 2005'02'07 23758 172

1429 Rashmi Janodara 2005'06'16 23765 193

Let us tabulate data in Table 9.19 into two tables: Table 9.20 – Marks Table and 
Table 9.21 – Students Table.

Table 9.20 – Marks Table
Index No Marks Admission 

No
23234 151 1426
23876 186 1427
23758 172 1428
23765 193 1429

 

Admission 
No

Name Date of 
Birth

1426 Kavindu 
Prabashwara

2005.05.23

1427 Meenadevi 
Ramanathan

2005.08.12

1428 Mohommad 
Malikkar

2005.02.07

1429 Rashmi 
Janodara

2005.06.16

Table 9.21 – Students Table



              For free distribution 271

A record of the Marks Table is related to only one record of the Student 
Table. A record of the Student Table is related to only one record of the Marks Table 
as well.

The primary key of the Student Table is the Admission Number and it is the 
foreign key of the Marks Table. The Primary key of the Marks Table is the Index 
Number. The relationship built between these two tables through the foreign key is 
one-to-one. (Figure 9.11)

  
Admission No Name Date of Birth

Index No Marks Admission No

An arrow is drawn from the foreign key to the primary key to indicate the 
relationship. 

9.4.2  One-to-many Relationship

If each record of a table is related to several records of the other table, this 
is called a one-to-many relationship. 

If the tables are A and B, and if B is the related table, the following Table 
9.22  shows one-to-many relationship.

Student Table

Marks Table

Figure 9.11 – Indicating one-to-one relationship
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1427 Meenadevi Ramanathan 2005'08'12 23876 186
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Let us tabulate data in Table 9.19 into two tables: Table 9.20 – Marks Table and 
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Table 9.20 – Marks Table
Index No Marks Admission 

No
23234 151 1426
23876 186 1427
23758 172 1428
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Admission 
No

Name Date of 
Birth

1426 Kavindu 
Prabashwara
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1427 Meenadevi 
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Table 9.21 – Students Table
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Table A Table B (Related table)
A record in Table A can be related to 
several records in Table B.

A record in Table B can be related to 
only one record in Table A.

There can be records which are not 
related to records of Table B.

There cannot be records which are not 
related to records of Table A.

Data in the column which includes the 
primary key cannot duplicate.

Data in the column which includes the 
foreign key can duplicate.

Having a record in Table B related to a 
record in Table A is not mandatory.

It is mandatory to have at least one row 
in Table A which is related to Table B.

Example
Refer Table 9.23 given below which includes personal data of students and payments 
of service and facility fees.

Table 9.23 - Service and facility fees

Admission 
No

Name Date of 
Birth

Receipt 
Number

Payment 
Date

Fees

1426 Kavindu 
Prabashwara

2005'05'23 1000 2014'01'04 40'00

1427 Meenadevi 
Ramanathan

2005'08'12

1428 Mohommad 
Malikkar

2005'02'07 1001 2014'01'06 120'00

1426 Kavindu 
Prabashwara

2005'05'23 1002 2014'01'12 80'00

In this table, the fields 'Payment Date' and 'Fees' depend on the Field Receipt 
Number. Further, data is unique in the Receipt Number Field. The reason for this is 
that receipt numbers will not be same. Anyway, there can be incomplete records in 
the table as receipts should be issued in the order of payment. (Indicated as R in the 
table) Further, data duplication can also be seen here.

Hence, let us break this table into two tables: Table 9.24 –Student Table and 
9.25 – Fees Table.

The Receipt Number is the primary key of the Fees Table. Admission 
Number is the primary key of the Student Table and the Foreign Key of the Fees 
Table.

Table 9.22 – Features of a one-to-many relationship   

R
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Student Table

Admission No Name Date of Birth

Facility Fee Table

Facility Receipt 
No

Payment Date Fees Admission No

 

If a student can pay fees a maximum of three times, there can be 0, 1, 2 or 3 
rows in Facility Fees Table related to a record of the Student Table
• If number of records is 0, this means fee is not paid.
• If number of records is 1, this means fee is paid once only.
• If number of records is 2, this means fee is paid twice.
• If number of records is 3, this means fee is paid thrice.

Thus, there can be no or several rows in the Fees Table related to a 
row of the Student Table.  Hence, the relationship between these two tables is 
one-to-many

 Figure 9.12 - One-to-Many Relationship

Admission No Name Date of Birth
1426 Kavindu Prabashwara 2005'05'23

1427 Meenadevi Ramanathan 2005'08'12

1428 Mohommad Malikkar 2005'02'07
 
         Table 9.25 - Facility Fees  Table

Receipt 
Number

Payment 
Date

Fees Admission 
No

1000 2014'01'04 40'00 1426

1001 2014'01'06 120'00 1428

1002 2014'01'12 80'00 1426

 Table 9.24 – Student Table
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9.4.3  Many-to-many Relationship

If a record of a table is related to several records of another table and if a 
record of that related table is related to several records of the other table, there is a 
many-to-many relationship between those two tables.

Example
Students take part in sports (team) as an extra curricular activity. There are sports 
such as cricket, volleyball and football. A student can do at least one of these sports. 
Further, there should be a team for each sport.
Refer Table 9.26 given below which includes these data. According to this table,

                     Figure 9.26 – Table of students who do sports

Admission 
No

Name Date of 
Birth

Sport 
No 

Sport Team Number of 
permanent 
members 

1426 Kavindu 
Prabashwara

2005'05'23 S001 Cricket A 11

1426 Kavindu 
Prabashwara

2005'05'23 S002 Football A 16

1428 Mohommad 
Malikkar

2005'02'07 S001 Cricket B 11

1428 Mohommad 
Malikkar

2005'02'07 S002 Football A 16

1428 Mohommad 
Malikkar

2005'02'07 S003 Volleyball B 06

1429 Janith Asheka 2005'04'15 S001 Cricket A 11
1429 Janith Asheka 2005'04'15 S003 Volleyball A 06

There is data duplication in this table. To minimize data duplication, let us break 
these data into separate tables. Include Sports data into Sports Table (Table 9.27) 
and student data into Student Table (Table 9.28).

 

Admission 
No

Facility fees  
Table

Date of 
Birth

1426 Kavindu 
Prabashwara

2005'05'23

1428 Mohommad 
Malikkar

2005'02'07

1429 Janith Asheka 2005'04'15

Table 9.27 -  S tudent Table                                                

Sport 
No.

Sport Number of 
permanant 
Members

S001 Cricket 11
S002 Football 16
S003 Volleyball 6

Table 9.28 - Sports Table
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Many-to-many relationship between Student Table and Sports Table is converted 
to one-to-many relationships in related databases. For this, another table is needed 
apart from the two tables given above. (Let us name that table as Students Sports 
Table – Table 9.30) Let us include Admission Number of Student Table to represent 
students and Sport Number of Sports Table to represent sports.

The Admission Number is the Primary key of the Student Table and the 
foreign key of Students Sports Table. 

The Sport Number is the primary key of the Sports Table and the foreign 
key of Students Sports Table. 

The primary key of the Students Sports Table is Admission Number + Sport 
Number.

Refer Figure 9.13 which gives relationship when two tables like the 
Student Table and Sports Table with many-to-many relationships are converted to 
one-to-many relationships.

Admission No Name Date of Birth
1426 Kavindu 

Prabashwara
2005'05'23

1428 Mohommad 
Malikkar

2005'02'07

1429 Janith Asheka 2005'04'15

Figure 9.29 – Student Table 

Admission 
No

Sport No Team

1426 S001 A
1426 S002 A
1428 S001 B
1428 S002 A
1428 S003 B
1429 001 A
1429 S003 A

Figure 9.31 – Sports Table
Sport No Sport Number of permanent 

members
S001 Cricket 11
S002 Football 16
S003 Volleyball 6

Figure 9.30 - Students Sports Table
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Representing two tables with many-to-many relationships as two 
one-to-many relationship

Figure 9.13 - Many-to-Many Relationship
Thus,

There is a one-to-many relationship between the Student Table and the 
Students Sports Table.

There is a one-to-many relationship between Sports Table and Students 
Sports Table.

Hence, by using an extra table, many-to-many relationships can be converted 
to one-to-many relationships.

9.5   Creating a Relational Database Using Database           
        Management System Software

Let us learn how to build relationships between tables using a Database 
Management System software. For this, create the tables given below: Figure 
9.14 – Student Table (using field names and data types given) and Figure 
9.15 – Marks Table. 

Student Table

Admission No Name Date of Birth

Students Sports Table

Admission No Sport No Team

Sports Table

Sport No Sport Number of permanent members 
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9.5.1 Build up relationship between tables

Figure 9.14  – Field names and data types of Student 
Table.

Figure 9.15 – Field names and data types of marks table.

For Microsoft Office Access...

Select Database Tools → Select Relationship 
command → Select the table which should 
be related → Click 'Add' command button. 
(Indicate the number of tables required) → 
Drag the Primary Key to the foreign key of 
the table which should be related (Figure 9.16) 
→ Select 'Enforce Referential Integrity' on 
'Edit Relationship' Dialogue Box (Refer 9.17) 
→ Select 'Cascade Update Related Field' and 
'Cascade Update Related Records' → Click 
'Create' command button.  

For LibreOffice'''

Select Tools Menu → Select Relationship 
command → Select the table which should 
be related → Click Add command button. 
(Indicate the number of tables required) 
→  Drag the Primary Key to the foreign 
key of the table which should be related → 
Right click on Relationship and select Edit 
→ Select 'Update Cascade' under 'Update 
Option' on Relations Dialogue Box. Select 
'Delete Cascade' under 'Delete Option' 
(Figure 9.18) → Click 'OK' command 
button.  
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  Figure 9.16 - One-to-many relationship between two tables.

Figure 9.18 – A Relations Dialogue Box (LibreOffice Base)

Figure 9.17 – Editing Relationship Dialogue Box (Access)
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The Admission Number is the primary key of the Student Table and the 
Foreign Key of the Marks Table.

observation 

 Special Features in Related Tables

 As soon as the values of a primary key field of the Student Table are updated 
using 'Referential Integrity,' the foreign key field values of the related table are 
automatically changed.
 Further, when a record of the Student Table is deleted, the related records of 
the related table are automatically deleted.
 First, data should be entered to the student Table. After that, data can be 
entered to the Marks Table.
 After entering the marks to the Student Table, data can be entered to the 
Marks Table through it. 
 For this, click on the + mark which is in front of the Admission Number of 
the Student Table. Then data can be entered to Marks Table easily. (Refer Figure 
9.19)

Figure 9.19 – Entering data to Student Table and Marks Table.
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9.6  Creating Forms to Entering and Displaying Data

Now you have knowledge about creating a table and entering data to it. 
Forms are used to enter data to a table in Database Management Systems. Further, 
forms are used to display entered data as well. 

Here, a row of a table is displayed and entered as a record in a form. (Refer 
Figure 9.18) 

Each input record is entered to the last column of the table. Each record of 
the table can be filled one by one through the form. For this, the Record Navigation 
Bar of a form is used. (Refer Figure 9.20)

Data Table

Figure 9.18 – Table and Data Form

Name Address Telephone No Email
Anwar Athurugiriya 0773684949 anvmom@dd.uk
Nimal Galewela 07184632481 nigl@ya.com

Sudakaran Kandy 0817587484 suda@gmail.com
Saman Kegalle

Name

Name Nimal

Saman 
Galewela

Kegalle
07184637481Address

Address

Telephone No

Telephone No

Email

Email nigl@ya.com

Display data on form

Data input through form

Figure 9.20 – Checking records from a data form.

  
New (empty) 

Record

First Record
Previous Record

Existing 
Record

Total Records

Next Record
Last Record
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1'  Building a Data Form

For Microsoft Office Access '''

Create → Form Design → Add Existing Fields → Show tables → Select the required table 
→ Drag table fields to the form (Refer Figure 9.21)

Figure 9.21 –Data form to enter data to the Student

2'  Showing Table Records in Data Form

For Microsoft Office Access '''

Home Tab → View → Form View (Refer Figure 9.22)

Figure 9.22 – Showing records in the Student Table
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3'  Entering Control Wizards to a Form

Figure 9.23 – Controlling Tools

Figure 9.24 – Command Button Wizard

For Microsoft Office Access '''

Design Tab → Select 'Control Wizards' (Refer Figure 9.23) → Select the button indicated as 
XXXX → Establish the button in data form → Select Record Operation in Command Button 
Wizard (Refer Figure 9.24) → Select the Action which should be entered (E.g.: Add New 
Record) → Give a proper name to the button → Finish
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9.7   Designing Query to Get Information

Let us use a query to obtain necessary information from the data of related 
tables. Query represents data of selected fields (columns) in each table. (Refer 
Figure 9.25)

  

   
       Figure 9.25 - Obtaining data to a query

Subject Student 
No

Marks

A1 B1 67
A2 B3 89
A1 B3 50
A3 B2 75

 

 
 

 

Student No Name Email
A1 Pubudu Pu2@gmail.com
A2 Faris pari@yahoo.com
A3 Kamalan Kam_n@hotmal.

com
A4 Thanuja Thanu7@slt.lk

Subject 
No

Subject

B1 Maths
B2 Science
B3 English

When Name, Subject and Marks are taken by a query from the three table above, 

Name Subject Marks
Pubudu Maths 67

Faris English 89
Pubudu English 50
Thanuja Science 75
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Designing a Query

 

Figure 9.26 –Dialogue Box to select tables

Figure 9.27 – Window to design query

For Microsoft OfficeAccess'''

Create Tab → Query Design → Select the necessary tables (Refer Figure 9.26) → Select the 
necessary field from the tables → Run the query
Create Tab → Query Design → Select the necessary tables (Refer Figure 9.26) → Select the 
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Refer figure 9.28 given below for the information received after running the query.

Figure 9.28 – Information received after running the query

As shown in Figure 9.28, marks scored by students in 2013 and 2014 are 
shown. You can obtain marks scored by students in 2014 only (information shown 
in Figure 9.28) by naming year 2014 as Criteria. (Refer Figure 9.29)

Various calculations can be made using fields through query. Let us learn 
how total marks scored by students are calculated. 

Add a new column to the query as Total and build an expression indicating 
the calculation needed.  To get total marks of subject it should be typed as:

   

Figure 9.29 – Giving Criteria for query

Figure 9.30 – Information received after running query with 
Criteria
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     Total:[Marks]æ[Maths]¬[Marks]æ[Science]¬[Marks]æ[English]. This can be 
typed (Refer Figure 9.31.) or can be performed by building the expression, right 
click the Mouse button on the column which you expect to get the total and select 
Build command. Then use the Dialogue Box you get. (Refer Figure 9.32)

 

           

Figure 9.32 – Dialogue Box to build the expression
 

 After running the query built in the way explained above, you get information 
as given in Figure 9.33 which is given below.

Figure 9.31 – Enlarge 'Total' column in the query
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Figure 9.33 – Marks and total of students scored in 2013

9.8 Designing Reports to Present Information

Reports are used to obtain printed copies of important information received 
from the data of related tables. Both tables and queries can be used to design reports.

Let us learn how a report is designed using the query given above in Figure 9.33.

Report Wizard can be used to design reports.

Figure 9.35 - Report Wizard used to design reports 

For Microsoft Office Access...

Create Tab → Report Wizard → Select the necessary table or query (Refer Figure 9.34) → 
Select the fields needed for the report from the table or query → Design the report as you need 
clicking Next button → Finish. Then you will get a report as shown in Figure 9.35.
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Figure 9.35 – Report which displays the total marks of students in 2013

Let us learn how numerical values included in a report are calculated. 

For this, let us find the total of admission fees paid by the students. Create a 
table as explained above using Report Wizard including Admission Number, Name 
and Admission Fees. Then change from Report View to Design View. Then you 
will get a report layout as shown in Figure 9.36.

Figure 9.36 – Report plan

Select the tool given as ‘ab’ on the tool barand establish the text box under 
Report Footer. (Refer Figure 9.37)
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Figure 9.37 – Establishing the text boxFigure 9.37 – Establishing the text boxFigure 9.37 – Establishing the text box

The text box is indicated as unbound. The reason for this is there is no 
field given to it. To get the total of admission fees, get the Expression Builder 
Dialogue Box to build expressions by clicking the button with three dots in front of 
the Control Source on Property Sheet. (Refer Figure 9.39)

                                                

Figure 9'38 - Property Sheet

Figure 9.30 – Expression Builder Dialogue Box
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To get the total of admission fees, type the expression = Sum ([Student 
Table]![Admission Fees]) and type OK. Then change the view from Design View to 
Report View. After that, you will get the report which displays the total of Admission 
Fees. (Refer Figure 9.40)

Figure 9.40 – Report which displays the total of Admission Fees

Printing the Report
Change the 'Report View' to 'Print Preview'. Click on the tool shown in 

Figure 9.41. Print the number of copies you need.

Figure 9.41 – Printing toolFigure 9.41 – Printing tool

1. Explain the advantages of electronic databases.

2. Explain with examples the features that are available in electronic databases.

     3. Compare electronic and manual database.

     4. Explain what is meant by data encryption is.

     5. Explain relational databases using fields, records and tables. 

     6. Define primary key and provide three examples.

     7. Define composite key and provide three examples.

Activity
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8. Define foreign key and with three examples.

9. Write five disadvantages of data duplication.

10. a) What is a data type? Provide examples for data types .
     b) Explain the reason as to why 'integer' data type is not the best data type for
           field that stores telephone numbers. 

11. Explain the relationships; one-to-one, one-to-many and many-to-many with
      two examples for each. 

12. Explain what 'objects' are in Database Management Systems and explain
       the uses of the objects.

²   Database is defined as the collection of organized data.

²   In a table a column is known as a 'Field' 

²   A raw of a table is known as a 'Record' 

²   Advantages of electronic database 

•  Efficient in searching data.
•  Facilities to get copies.
•  Less storage capacity used for storing data.
•  Efficient analysis of data.
•  Sharing data.
•  Data independence.

²   Characteristic of a database.

•  Avoid data redundancy.
•  Consistency of data.
•  Increased efficiency
•  Increased accuracy 
•  Increased validity
•  Increase the security of data.

²    A column or collection of columns in a table when  records can be identified 
      uniquely is called primary key.

Sammary
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²  If a field (or a combination of fields) of one table can be used to uniquely  
     identify rows in another table, these fields are called the foreign keys.

²   A relationship is built up between two tables by using foreign key.

²   Data redundancy means the same data is stored in several database tables.

²   The type of  data that is relevant to a field is known as data type.

²  In a relational database a relationships such as one-to-one, one-to-many and  
     many-to-many can be exist.

²   To enter and display data, forms can be used.

²   Query is used to obtain information.

²   To present data, reports are used.


